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How to Use This Manual

This manual describes the role of the CS+ integrated development environment for developing applications and sys-
tems for RL78 family, and provides an outline of its features.

CS+ is an integrated development environment (IDE) for RL78 family, integrating the necessary tools for the develop-
ment phase of software (e.g. design, implementation, and debugging) into a single platform.

By providing an integrated environment, it is possible to perform all development using just this product, without the
need to use many different tools separately.

Readers

Purpose

Organization

How to Read This Manual

Conventions

This manual is intended for users who wish to understand the functions of the CS+ and
design software and hardware application systems.

This manual is intended to give users an understanding of the functions of the CS+ to use
for reference in developing the hardware or software of systems using these devices.

This manual can be broadly divided into the following units.
1.GENERAL

2.FUNCTIONS
A.WINDOW REFERENCE

It is assumed that the readers of this manual have general knowledge of electricity, logic
circuits, and microcontrollers.

Data significance: Higher digits on the left and lower digits on the right
Active low representation: XXX (overscore over pin or signal name)

Note: Footnote for item marked with Note in the text
Caution: Information requiring particular attention

Remarks: Supplementary information

Numeric representation: Decimal ... XXXX

Hexadecimal ... OXXXXX
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CS+Vv8.05.00 1. GENERAL

1. GENERAL

CS+ is a platform of an integrated developing environment for RH850 family, RX family, V850 family, RL78 family,
78KOR microcontrollers, 78K0 microcontrollers.

CS+ can run all the operations needed for developing the programs such as designing, cording, building, debugging,
and flash programming.

In this manual, the debugging is explained out of those operations needed for the program development.

Caution When the E2 emulator Lite (abbreviated name: E2 Lite) is used, please read references to "E1" in this
manual as also meaning "E2 Lite".
When the E2 emulator (abbreviated name: E2) is used, please read references to "E1" in this manual as
also meaning "E2".

In this chapter, an overview of debugging products that CS+ provides is explained.

1.1 Summary

You can effectively debug/simulate the program developed for the RL78 family, using the debugger which CS+ provides.

1.2 Features

The following are the features of the debugger provided by CS+.

- Connecting to the various debug tools
A pleasant debugging environment for target systems is provided by connecting to the full-spec emulator (IECUBE),
the on-chip debugging emulator (E1/E20/EZ Emulator), COM Port and Simulator.

- C source text and disassembled text are shown mixed
The C source text and the disassembled text are shown mixed on the same panel.

- Source level debugging and instruction level debugging
The source level debugging and the instruction level debugging for a C source program can be done.

- Support of flash self programming emulation (Code flash)
Flash self programming emulation can be performed with IECUBE.

- Data flash memory writing function
When the selected microcontroller incorporates the data flash memory, the contents of data flash memory can be dis-
played and modified by the same access method as an ordinary memory operation (except for Simulator).

- Real-time display update function
The contents of memory, registers and variables are automatically updated not only when the program execution is
stopped, but also in execution.

- Save/restore the debugging environment
The debugging environment such as breakpoints, event configuration information, file download information, display
condition/position of the panel, etc. can be saved.

R20UT4857EJ0100 Rev.1.00 RENESAS Page 9 of 391
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CS+Vv8.05.00 2. FUNCTIONS

2. FUNCTIONS

This chapter describes a debugging process of CS+ and main functions for debugging.

2.1 Overview

The basic debugging sequence for programs using CS+ is as follows:

(1) StartCS+
Launch CS+ from the [Start] menu of Windows.

Remark For details on how to start CS+, see "CS+ Integrated Development Environment User's Manual:
Project Operation”.

(2) Seta project
Create a new project, or load an existing one.

Remark For details on "Set a project”, see "CS+ Integrated Development Environment User's Manual: Proj-
ect Operation".

(3) Create aload module
Create a load module by running a build after setting of the active project and the build tool to be used.

Remark For details on "Create a load module" with CC-RL, see "CS+ Integrated Development Environment
User's Manual: Project Operation”.

(4) Confirm the connection to a host machine
Connect the debug tool to be used to a host machine.

(5) Select the debug tool to use
Select the debug tool to be used in a project.

(6) Configure operating environment of the debug tool
Configure the operating environment of the debug tool selected in steps (5).

- [[IECUBE]

- [E1]

- [E20]

- [EZ Emulator]
- [COM Port]

- [Simulator]

(7) Connect to the debug tool
Connect the debug tool to CS+ to start communication.

(8) Execute downloading
Download the load module created in steps (3) to the debug tool.

(9) Display source files
Display the contents of the downloaded load module (source files) on the Editor panel or Disassemble panel.

(10) Execute programs
Execute the program by using the operation method corresponding to a purpose.
If you wish to stop the program at the arbitrary position, set a breakpoint/break eventN°€ before executing the pro-
gram (see "2.8.3 Stop the program at the arbitrary position (breakpoint)”, "2.8.4 Stop the program at the arbitrary
position (break event)", or "2.8.5 Stop the program with the access to variables/SFRs").

Note These functions are implemented by setting events to the debug tool used.
See "2.15.7 Notes for setting events”, when you use events.

(11) Stop the program manually
Stop the program currently being executed.
Note that if a breakpoint or a break event has been set in steps (10), the program execution will be stopped auto-
matically when the set break condition is met.

(12) Check the result of the program execution
Check the following information that the debug tool acquired by the program execution.

R20UT4857EJ0100 Rev.1.00 RENESAS Page 10 of 391
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CS+Vv8.05.00 2. FUNCTIONS

- Display/Change the Memory, Register and Variable
- Display Information on Function Call from Stack

- Collect Execution History of ProgramsNote

- Measure Execution Time of ProgramsNote
- Measure Coverage [IECUBE][Simulator]
Note These functions are implemented by setting events to the debug tool used.
See "2.15.7 Notes for setting events”, when you use events.
Debug the program, repeating steps (9) to (12) as required.
Note that if the program is modified during debugging, steps (3) and (8) also should be repeated.

Remark 1. Other than the above, you can also check the result of the program execution by using the following
functions.

- Set an Action into Programs

- Use Hook Function

- Use the Simulator GUI [Simulator]
Remark 2. The acquired information can be saved to a file.

- Save the disassembled text contents

- Save the memory contents

- Save the CPU register contents

- Save the SFR contents

- Save the contents of local variables

- Save the contents of watch-expressions

- Save the contents of call stack information

- Save the contents of execution history

(13) Execute uploading
Save the program (the memory contents) to a file in the arbitrary format (e.g. Intel HEX file, Motorola S-record file,
binary file, and etc), as required.

(14) Disconnect from the debug tool
Disconnect the debug tool from CS+ to terminate communication.

(15) Save the project file
Save the setting information of the project to the project file.
Remark For details on "Save the project file", see "CS+ Integrated Development Environment User's Man-

ual: Project Operation".
R20UT4857EJ0100 Rev.1.00 .IENESAS Page 11 of 391
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CS+Vv8.05.00 2. FUNCTIONS

2.2 Preparation before Debugging

This section describes the preparation to start debugging the created program.

2.2.1 Confirm the connection to a host machine

Connection examples for each debug tool are shown.

2.2.1.1 [IECUBE]
2.2.1.2 [E1]

2.2.1.3 [E20]

2.2.1.4 [EZ Emulator]
2.2.1.5 [COM Port]
2.2.1.6 [Simulator]

2.2.1.1 [IECUBE]

Connect a host machine and IECUBE. If required, connect a target board, too.
See IECUBE User's Manual for details on the connection method.

Figure 2.1  Connection Example [IECUBE]

o — PO

Dedicated adapter "-.,__.. - : USB interface cable
I Dedicated probe e Host machine "-._,-"
’ IECUBE CS+
Target board

2.2.1.2 [E1]

Connect a host machine and E1. If required, connect a target board, too.
See E1 User's Manual for details on the connection method.

Figure 2.2  Connection Example [E1]

Dedicated probe USB interface cable L
1 ._,-‘7“'; Host machine .
E1l CS+
Tal

rget board

Caution Only serial communications are supported as the communication method with the target board (JTAG
communications is not available).

2.2.1.3 [E20]

Connect a host machine and E20. If required, connect a target board, too.
See E20 User's Manual for details on the connection method.

R20UT4857EJ0100 Rev.1.00 RENESAS Page 12 of 391
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2. FUNCTIONS

Figure 2.3  Connection Example [E20]

arget board

oh =i o .
Dedicated probe . j"’ USB interface cable
’ E20 Host machine .-
T

CS+

Caution Only serial communications are supported as the communication method with the target board (JTAG

communications is not available).

2.2.1.4 [EZ Emulator]

Connect a host machine and an evaluation kit
See EZ Emulator User's Manual for details on the connection method.

Figure 2.4  Connection Example [EZ Emulator]

o —

USB |nterface cable

Evaluation kit Host machlne

CS+

2.2.1.5 [COM Port]

Connect the host machine to the target board via a commercially available USB serial converter.

2.2.1.6 [Simulator]

A host machine is only needed for debugging (emulators are not needed).

Figure 2.5  Connection Example [Simulator]

@

CS+

Host machine
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2.3 Configuration of Operating Environment of the Debug Tool

This section describes the configuration of the operating environment for each debug tool.

2.3.1 Select the debug tool to use

You can configure the operating environment in the Property panel corresponding to the debug tool to use.

Therefore, first, select the debug tool to be used in a project (the debug tool to be used can be specified in the individual
main projects/subprojects).

To select or switch the debug tool, use the context menu shown by right clicking on the [RL78 Debug tool nhame (Debug
Tool)] node on the Project Tree panel.

Figure 2.6  Select/Switch Debug Tool to Use

Project Teee | % |
- e - W
2% Sarnple [Project)

E RSFIM0LE {Microcantraller)

AL CC-RL (Bustd Teaed)
J PLTE Simulator (Debun Too

o (Y | UsngDebugTeel |
B Property

L7B [ECLEE

R

RLTE £ Lie
RL7E Ed[Serial)
[

R

LTE E2D(S=nal)
LTE EL Ermualator

[»] ra7e simulate

If the Property panel is already open, click the [RL78 Debug tool name (Debug Tool)] node again. The view switches to
the Property panel of the selected debug tool.

If the Property panel is not open, double-click the above mentioned node to open the corresponding Property panel.
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2.3.2 [IECUBE]

Configure the operating environment on the Property panel below when using IECUBE.

Figure 2.7  Example of Property Panel [IECUBE]

Property E3
S5 FL7E IEGUBE Property 2| =)+
4 {Internal ROM/RAM
Size of mternsl ROMEBwies] Bl
Size of mternal Ra[Eyvtes] 4095
Size of DataFlash memory [KByte=s] L]
d Clock
Man clock sowrce Cignerate by emulator
blain chck frequercy [FEE] 400
Sub clock source Generate by amulator
Sub clock freguency[kHz] 22768
4 Gonnectionwith Tareet Boand
Caormectng with target board o
Internal ROMARAM
\iConnec.... | Debug T.. [ FlashSel. | DataFlas..  Downloa.. [Hook Tra.. /=

Follow the steps below by selecting the corresponding tab on the Property panel.

[Connect Settings] tab

[Debug Tool Settings] tab

[Flash Self Emulation Settings] tab [[ECUBE]
[DataFlash Emulation Settings] tab [IECUBE]
[Download File Settings] tab

[Hook Transaction Settings] tab
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2.3.3 [E1]

Configure the operating environment on the Property panel below when using E1.

Figure 2.8  Example of Property Panel [E1]

Property
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Size of internal RAM[Brtes]
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Possar tarmet from the smulator DM 200ma)
w  Flazh

Security 10

Fermit flagh programening

e wide vollage mode

Erzse Tlash ROM when sterling
»  Hot Plug=m

Internal ROM/RAM

Ell'l-'h

4

Usme miemal chck
Lzing miemal clck
Swetem

o

noonnma0DoannNa00n0n
ez

e

Ma

Follow the steps below by selecting the corresponding tab on the Property panel.

[Connect Settings] tab

[Debug Tool Settings] tab
[Download File Settings] tab
[Hook Transaction Settings] tab
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2.3.4 [E20]

Configure the operating environment on the Property panel below when using E20.

Figure 2.9  Example of Property Panel [E20]

FOMT+ |
cul RLTE E20(Serial) 7 OMT 4 8 -+
v {Intemal ROM/HAM

ize of mbernal FOMIEEvies] 156

Size of intarnal RAK[Byiez] JnLan

Size of DataFlach me mory[KBytes) ]
w  Glock

Pelair chack frequency [MHz] Lzng miemal chick

Sub clok frequencykHz] Iking mtermal chck

Manitar clock Swstem

w  Connecton with Emulsbor
Ermulator serial Mo

 Flash
Secwrilty 1D [heE] DO@0DOSO00G000@00 K00
Fermt tlash programming Tes
Uze wide vollage mode ez
Erzze flash ROM wiben starling Ia
» Hot Plug=n
Internal ROMARAM

Follow the steps below by selecting the corresponding tab on the Property panel.

[Connect Settings] tab

[Debug Tool Settings] tab
[Download File Settings] tab
[Hook Transaction Settings] tab
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2.3.5 [EZ Emulator]

Configure the operating environment on the Property panel below when using EZ Emulator.

Figure 2.10 Example of Property Panel [EZ Emulator]

Property E
S5 RLTE EZ Emulator Property B -
s {Tnternal ROM/RAM
Size of inlerna F'.'TI-':'_.“'E:}'::*:.'] 4
Sipe of internal BAMIEyt=z] LOgE
Size of DataFlash mamory[EBybes] ¥
a Glock
Main clock frequency [MHz] sire miternal clack
Sub chck frequencyllHz] lzing mtemal chck
Mionitor clock Systam

2 Conneclion with Tanget Board
Paveer tareet from the amulsior (MSH 200m&) Mo

4 Flash
Sacurity [0 [FE=] 00000000000000000000
Permil {lash pragramming hCH
Llze wide wolisze mods ez
Eraze flagh ROM when starting i
Internal ROM/RAM

\Connect Setti... ! Debug Tool Set . ¢ Download Ale 5. 4 Hook Tranzacti_. / =

Follow the steps below by selecting the corresponding tab on the Property panel.

[Connect Settings] tab

[Debug Tool Settings] tab
[Download File Settings] tab
[Hook Transaction Settings] tab
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2.3.6 [COM Port]

Configure the operating environment on the Property panel below when using COM Port.

Figure 2.11 Example of Property Panel [COM Port]

&3 RLT3COM Port Property
~ | Inlernal ROMRAM

findermal ROM[HEyvies]

. T
& of indermal FLAM[Eyies]

L
0w

lock
Main clock frequency |MHz]
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Commumnicabion port
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w Flash
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Permat fiash programming
Lisa wide voliage mode
Erase flash ROM when starting
Lising the flash self programming

Internal ROMFAM

& of DiataFlash memory[KByies]

13
oo

B354

Uaing intemal clock
Uang inemal clock
Syaiem

DTR

Tea

FF5F

| | Connect Settings. | Debug Tool Settings | Download File Settings I,J'r Hock Transaction Settings /| ~

Follow the steps below by selecting the corresponding tab on the Property panel.

[Connect Settings] tab

[Debug Tool Settings] tab
[Download File Settings] tab
[Hook Transaction Settings] tab
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2.3.7 [Simulator]

Configure the operating environment on the Property panel below when using Simulator.

Figure 2.12 Example of Property Panel [Simulator]

Property ]
il RL78 Simulator Property 2| [=][+]
4 {Internal ROM/RAM

Size of mternal FOKKEyies) hid
Size of intarnal BAM[Bytes] 4005
4 Clock
Plain clack frequarcy [MHz] Lno
Sub clock frequencykHz] 2270
Select Timer/ Trace chok frequeancy CPU clock frequency
il af Times# Trace clack frequency MHz

Timerd Trace clock frequency
4 Configuration
Uee simulator configusation Tile o

Internal ROM/RAM

/ Download Flle 5./ Hook Transactl. . | =

Follow the steps below by selecting the corresponding tab on the Property panel.

[Connect Settings] tab

[Debug Tool Settings] tab
[Download File Settings] tab
[Hook Transaction Settings] tab

Caution The following cautions apply to the instruction simulator for RL78:
- The data flash is not supported.
- The Pipeline is not supported.
- The CPU operation clock operates by the specification of RL78/G13.

- When using Multiplier and Divider/Multiply-Accumulator by division mode, the division processing will
be finished in by 1 clock.

- When using Multiplier and Divider/Multiply-Accumulator by division mode, the interrupt for the end of
division operation is not occurred. But DIVST bit of Multiplication/Division Control Register "MDUC" is
changed (DIVST bit displays division operation status).

Remark When Simulator to be used corresponds to peripheral function simulations, you can use the Simulator
GUI. See "2.18 Use the Simulator GUI [Simulator]" for details on the Simulator GUI.
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2.4 Connect to/Disconnect from the Debug Tool

This section describes how to connect to/disconnect from the debug tool.

2.4.1 Connect to the debug tool

By selecting [Connect to Debug Tool] from the [Debug] menu, CS+ starts communicating with the debug tool selected in
the active project.

After succeeding in the connection to the debug tool, the Statusbar of the Main window changes as follows:
For details on each item displayed on the Statusbar, see the section of the "Main window".

Figure 2.13 Statusbar Indicating Successful Connection to Debug Tool

| =% DISCONNECT ]

v

® | EREAK [ (x00lbe | @®RL7E Simulator (7 Mot measured [Ny [F3] 3 |

I
The information of the debug tool appears at this area.

Caution If the version of compiler being used is not supported by CS+, [Connect to Debug Tool] will be disabled.

Remark 1. When the button on the Debug toolbar is clicked, the specified file is downloaded automatically after
connecting to the debug tool (see "2.5.1 Execute downloading").

When the button on this toolbar is clicked, the project is built automatically, and then the built file is
downloaded after connecting to the debug tool.

Remark 2. [Simulator]
When a microcontroller whose Simulator supports peripheral function simulations is selected, the Simu-

lator GUI window is automatically opened after connecting to the debug tool (default).
2.4.2 Disconnect from the debug tool

By clicking the button on the Debug toolbar, CS+ cuts off the communication with the connected debug tool.
After disconnecting from the debug tool, the Statusbar of the Main window changes as follows:

Figure 2.14 Statusbar Indicating Disconnection from Debug Tool

| m| BREAK [ Ox00lbe | @®RL7E Simulator (7 Not measured [¥y] [[3] (23 |

| =% DISCONNECT ]

I —

This area is left blank. "DISCONNECT" is displayed.
Caution The debug tool cannot be disconnected from CS+ while the program is running.
Remark Disconnecting the debug tool will close all the panels and dialog boxes that can be displayed only during

the connection.

2.4.3 Connect to the debug tool using hot plug-in [E1][E20]

With hot plug-in function, you can connect the debug tool to the target board during execution of a program (without
having to turn off the system) and debug the program while it is in execution.
Follow the steps below to establish hot plug-in connection.

Caution 1.  The hot plug-in connection is enabled only when the selected microcontroller incorporates the hot plug-in
function.
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Caution 2. When a hot plug-in connection is made, the settings of the following properties are ignored (i.e. the pro-

gram operates as if the specification for them is [No]). The settings of them become valid again after
reconnection with CS+.

- [Mask TARGET RESET signal]

- [Mask INTERNAL RESET signal]

- [Power target from the emulator (MAX 200mA)]

- [Erase flash ROM when starting]

Caution 3. When a hot plug-in connection is made, events currently being set in the project are ignored.

@)

(@)

(b)

@

®)

(4)

®)

(6)

They become valid again after reconnection with CS+.

Set the number of times and interval to retry

Set the interval and number of times to retry connection when the emulator fails to communicate with the micro-
controller on the target board.

You can configure this settings in [Hot Plug-in] category on the [Connect Settings] tab of the Property panel.

Figure 2.15 [Hot Plug-in] Category

4 Hot Plug-in
Retrying mitervallms] 1000
Mumber of times af relrving 3

[Retrying interval[ms]]
Specify an interval in 1 ms unit to retry the connection.
Directly enter the decimal number between 0 and 60000 (default: [1000]).

[Number of times of retrying]
Specify the number of times to retry the connection.
Directly enter the decimal number between 0 and 3 (default: [3]).

Execute the program
Execute the program which has been downloaded onto the microcontroller on the target board without connecting
to the emulator.

Select the debug tool
In the active project, select the debug tool which supports hot plug-in connection (E1/ E20).

Connect the debug tool to CS+ using hot plug-in
Select [Hot Plug-in] from [Debug] menu to initiate the preparation for hot plug-in connection.

Connect to the target board

Following message will appear once you are ready to start hot plug-in connection. Connect the emulator to the
target system and click [OK]. This will start the communication with the debug tool which is selected in the cur-
rently active project.

Figure 2.16 Message Indicating that Hot Plug-in Connection Is Ready to Be Started

[ Question(Q0204001) |

L~ Hot Plug+n is prepaned.
e Lonnect the debug tanget to a PLand cick OF.

ok || Coneet || Hel

Hot plug-in connection completed
Once the connection to the debug tool is successfully completed, the Statusbar on the Main window will change as
shown below. For details on each item displayed on the statusbar, see the section of the "Main window".
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Figure 2.17 Statusbar Indicating Successful Hot plug-in Connection to Debug Tool
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v
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“RUN" indicates that the program is running.

This area shows information on the currently active debug tool.
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2.5 Download/Upload Programs

This section describes how to download programs (such as load module files) to debug to CS+ and how to upload the
memory contents being debugged from CS+ to files.

2.5.1 Execute downloading

Download the load module file to be debugged to the debug tool that is currently connected.
Follow the steps below on the [Download File Settings] tab in the Property panel for the downloading, and then execute
the downloading.

Caution By default, CPU reset automatically occurs after downloading the file, and then the program is executed
to the specified symbol position. If this operation above is not needed, specify [No] with both of the [CPU
Reset after download] and [Execute to the specified symbol after CPU Reset] property.

(1) [Download] category setting

Figure 2.18 [Download] Category

4 Downdoad
4 Dawnload files [
a [0] DatsuHBurldvbast shs
File DeiautBuilditest ahs
File type Load module file
Devenlozd phject feg
Dornloed symbol infarmatian Yes
Generate the infarmation for input completion  Yes
CPU Fezet after download ‘fag
Davnlead Mode Spesd proariy
Eraze tlazh HOM before download L]
fuiomatic change mathod of event satting pozition Suspend avant
Check rezarved area overeriting ag
Caution Properties displayed in this category differ depending on the debug tool used in the project.

(&) [Download files]
The names of files to be downloaded and download conditions are displayed (the number enclosed with "[]"
indicates the number of files to be download).
Files that are specified as build target files in the main project or subprojects will automatically be selected as
the files to be downloadedN°te.
However, you can manually change the download files and the condition. In this case, see "2.5.2 Advanced

downloading".

Note To download the load module files created by an external build tool (e.g., compilers and assem-
blers other than the build tools supplied with CS+), a debug-dedicated project needs to be cre-
ated.

If you use a debug-dedicated project as the subject to debug, add your a download file to Down-
load files node on project tree. The file to be downloaded will be reflected in this property.

See "CS+ Integrated Development Environment User's Manual: Project Operation” for details on
the using an external build tool and a debug-dedicated project.

(b) [CPU Reset after download]
Specify whether to reset the CPU after downloading.
Select [Yes] to reset the CPU (default).
Note, however, that this property does not appear if the selected microcontroller always resets the CPU after
downloading.

(c) [Download Mode] (except [Simulator])
Specify the download mode for downloading to the flash ROM.
Select one of the options from the following drop-down list.

Speed priority Fills free space between the first data and the final data with FFH (the previous value in
free space before the first data and after the final data is retained).
Download speed will be faster because the writing data is reduced (default).
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(d)

(e)

(f)

@)

(@)

(b)

Data priority Retains the previous value in free space.
Download speed will be very slow because data in free space are read once.

[Erase flash ROM before download] (except [Simulator])

This property is valid only when the [Download Mode] (except [Simulator]) property is set to [Speed priority]
(default).

Specify whether to erase the flash ROM before downloading.

Select [Yes] to erase the flash ROM (default: [No]).

Note that the erase operation differs depending on the emulator when [Yes] is selected.

- [IECUBE]
The internal ROM area will be always erased. For the other area, an erase will be performed in the area
where the downloaded data exists.

- [E1][E20][EZ Emulator][COM Port]
For all flash area, an erase will be performed in the area where the downloaded data exists.

Caution Flash ROM is erased by writing FFH so the flash ROM will not be blank.

[Automatic change method of event setting position]

If the file is downloaded again during debugging then the location (address) set for the currently configured
event may change to midway in the instruction.

Specify with this property how to handle the target event in this circumstance.

Select one of the options from the following drop-down list.

Move to the head of instruction | Resets the subject event at the beginning address of the instruction.

Suspend event Leaves the subject event pending (default).

Note, however, that this property setting only applies to the location setting of events without debugging infor-
mation. The location setting of events with debug information is always moved to the beginning of the source
text line.

[Check reserved area overwriting when downloading] [E1][E20][EZ Emulator][COM Port]

Specify whether to output a message when overwriting to an area reserved for use by the emulator is attempted
at the time of downloading.

Select [Yes] to output a message (default).

[Debug Information] category setting

Figure 2.19 [Debug information] Category

4 Debug Information
Execule fo the specified symbal after GPL Fased i
Specified symbol _Hain
The upper limit size of the memary uszee [Mbvtes] 500

[Execute to the specified symbol after CPU Reset]

Specify from the drop-down list whether to execute the program to the specified symbol position after CPU reset
or downloading (for only when the [CPU Reset after download] property is set to [Yes]).

Select [Yes] to execute the program to the specified symbol position after CPU reset (default).

Remark When the [CPU Reset after download] property is set to [Yes], the operation after downloading is
as follows:
If [Yes] is selected for this property, the Editor panel will open automatically with displaying
source text of the position specified with the [Specified symbol] property after downloading.
If [No] is selected for this property, the Editor panel will open with displaying source text of the
reset address (when if the source text has not been allocated to the reset address, the contents
of the reset address is displayed in the Disassemble panel).

[Specified symbol]

This property appears only when the [Execute to the specified symbol after CPU Reset] property is set to [Yes].
Specify the position at which the program is stop after CPU reset.

Directly enter an address expression between 0 and "last address in address space” (default: [_main]).

Note, however, that the program will not be executed if the specified address expression cannot be converted
into an address.
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Remark Normally, specify the following.
For assembler source: Start label corresponding to main function
For C source: Symbol assigned to the start of the main function name

(c) [The upper limit size of the memory usage [Mbytes]]
Specify the upper limit on the amount of memory to be used in reading the debug information.
When the amount of memory being used exceeds the upper limit specified here, memory is made available by
discarding debug information that has been read until the amount of memory in use is reduced to half of this
upper limit (lowering the upper limit might improve the situation when shortages of memory are arising).
Directly enter a decimal number between 100 and 1000 (unit: Mbyte) (default: [500]).

Caution In some cases, lowering the upper limit may lead to poorer responsiveness since it leads to more
frequent discarding and re-reading of debug information.

(3) Execute download
Click the button on the Debug toolbar.
If this operation is performed while disconnecting from the debug tool, the application automatically connects to
the debug tool, and then performs the download.

Remark When a program that has been modified during debugging is re-downloaded, you can easily build
and download it by selecting [Build & Download] from the [Debug] menu on the Main window.

(4) Canceling a download
To cancel a download, click the [Cancel] button on the Progress Status dialog box, which displays the progress of
downloading, or press the [Esc] key.

If the load module file is successfully downloaded, the Editor panel opens automatically, and the contents of the down-
loaded file's source text are displayed.

Remark You can automatically overwrite the value of SFR/CPU register with the specified values before and after
performing the download (see "2.16 Use Hook Function" for details).

2.5.2 Advanced downloading

You can change the download files and the condition to download.
With CS+, the following file types can be downloaded.

Table 2.1 Downloadable File Formats

Downloadable File Extension File Format
Load module file .abs Load module format
Intel Hex file .hex Intel Hex file format
Motorola S-record file .mot Motorola S-record file format

- (S0, S1, S9 - 16 bit-address)
- (S0, S2, S8 - 24 bit-address)
- (S0, S3, S7 - 32 bit-address)

Binary file .bin Binary format

You can change the download files or download conditions in the following Download Files dialog box.

The Download Files dialog box is opened by clicking the [...] button that appears at the right edge in the column of the
[Download files] property when you select it in the [Download] category on the [Download File Settings] tab of the Property
panel.
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Figure 2.20 Opening Download Files Dialog Box
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Figure 2.21 Advanced Downloading (Download Files Dialog Box)
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This section describes how to configure on the Download Files dialog box above when the following cases.

For details on the contents and function in each area, see the section for the Download Files dialog box.

2.5.2.1 Change download conditions for load module files
2.5.2.2 Add download files (*.hex/*.mot/*.bin)
2.5.2.3 Perform source level debugging with files other than the load module file format

2.5.2.1 Change download conditions for load module files

Follow the steps below in the Download Files dialog box to change the download conditions (object information and

symbol information) for load module files.

(1) Select aload module file

Select a load module file to download in the [Download file list] area.

(2) Change download conditions

Current download conditions for the selected load module file are displayed in the [Download file property] area.
Change each items displayed in the property.

Download object

Specify whether to download the object information from the specified file.

Default Yes
Modifying Select from the drop-down list.
Available Yes Downloads object information.
values
No Does not download object information.
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Download symbol
information

Specify whether to download the symbol information from the specified fileN® 1,
Default Yes
Modifying Select from the drop-down list.
Available Yes Downloads symbol information.
values - -
No Does not download symbol information.

Generate the infor-
mation for
input completion

Select whether to generate the information for the Symbol name completion function
when downloading

Note 2

Default Yes

Modifying Select from the drop-down list.

Available Yes Generates the information for the symbol name completion
values function. (i.e. uses the symbol name completion function.)

No Does not generate the information for the symbol name com-
pletion function. (i.e. does not use the symbol nhame comple-
tion function.)

Note 1. If the symbol information have not been downloaded, the source level debugging cannot be per-
formed.
Note 2. When [Yes] is selected, the time taken for downloading and the memory usage on the host machine

will increase. We recommend selecting [NO] in this item if you do not intend to use the symbol
name completion function.

(3) Click the [OK] button

Enable all the configuration in this dialog box and change the download conditions.

2.5.2.2 Add download files (*.hex/*.mot/*.bin)

Follow the steps below to add download files other than the load module format (Intel HEX file (*.hex), Motorola S-
record file (*.mot) or binary file (*.bin)) in the Download Files dialog box.

(1) Click the [Add] button

When the [Add] button is clicked, a blank list item "-" is displayed in the last line of the [Download file list] area.

(2) Property configuration of the download files to add
Configure the download conditions for the download file to add in the [Download file property] area.
Configure each item displayed with the following condition.
When the configuration is completed, the file name specified in this property is displayed in the blank list of the
[Download file list] area.

File

Specify the download file (Intel HEX file (*.hex), Motorola S-record file (*.mot) or binary file
(*.bin)) to download (up to 259 characters).

Default Blank

Modifying Directly enter from the keyboard, or specify with the Select Download File
dialog box that is opened by clicking the [...] button.

Available See "Table 2.1 Downloadable File Formats".

values
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File type Specify the type of the file to download.
Select [Hex file] or [Binary data file].

Default Load module file

Modifying Select from the drop-down list.

Available Either one of the following
values - Load module file

- Hex file

- S record file

- Binary data file

Offset Specify the offset from the address at which the file's download is to start.
Note that this item appears only when [File type] or [S record file] is set to [Hex file].

Default 0

Modifying Directly enter from the keyboard.

Available 0x0 to OXFFFFF in hexadecimal number
values
Start address Specify the address at which to start the file's download.

Note that this item appears only when [File type] is set to [Binary data file].

Default 0

Modifying Directly enter from the keyboard.

Available 0x0 to OXFFFFF in hexadecimal number
values
Remark The settings of whether to download the object information or symbol information can be made only

when the type of the file to download is load module files.

(3) Check the order of download
The order of the download is the display order of the files displayed in the [Download file list] area.
If you want to change the order, use the [Up]/[Down] button.

(4) Click the [OK] button
Enable all the configuration in this dialog box and add a download file (the file name is displayed in the [Download]
category on the [Download File Settings] tab of the Property panel).

2.5.2.3 Perform source level debugging with files other than the load module file format

Even when an Intel HEX file (*.hex), Motorola S-record file (*.mot) or binary file (*.bin) is specified to be the subject file
to download, it is possible to do source level debugging by downloading symbol information for the load module file from
which the subject file was created, along with the subject file that you download.

To do so, follow the steps below on the Download Files dialog box.

(1) Click the [Add] button
When the [Add] button is clicked, a blank list item "-" is displayed in the last line of the [Download file list] area.

(2) Property configuration of the load module file to add
Configure each item displayed with the following condition in the [Download file property] area.

File Specify a load module file from which the Intel HEX file (*.hex), Motorola S-record file
(*.mot) or binary file (*.bin) that you want to download was created.

Directly enter from the keyboard, or specify with the Select Download File dialog box that
is opened by clicking the [...] button that appears at right by selecting this property.

File type Select [Load module file] (default).

Download object Specify [No].
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Download symbol | Select [Yes] (default).
information

Generate the infor- | Select whether to generate the information for the Symbol name completion function
mation for when downloadingN°te.
input completion

Default Yes

Modifying Select from the drop-down list.

Available Yes Generates the information for the symbol name completion
values function. (i.e. uses the symbol name completion function.)
No Does not generate the information for the symbol name com-

pletion function. (i.e. does not use the symbol hame comple-
tion function.)

Note When [Yes] is selected, the time taken for downloading and the memory usage on the host machine
will increase. We recommend selecting [NO] in this item if you do not intend to use the symbol
name completion function.

(3) Click the [OK] button
Enable all the configuration in this dialog box and add the specified load module file (Only the symbol information
included in the load module file will be downloaded).

2.5.3 Execute uploading

The contents of the memory of the debug tool currently connected can be saved (uploaded) in an arbitrary file.
You can upload the data in the Data Save dialog box that is opened by selecting the [Debug] menu >> [Upload...].
In this dialog box, follow the steps below.

Figure 2.22 Execute Uploading (Data Save Dialog Box)
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(1) Specify [File Name]
Specify the name of the file to save.
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history
via the drop-down list (up to 10 items). You can also specify the file by clicking the [...] button, and selecting a file
via the Select Download File dialog box.

(2) Specify [File Type]
Select the format in which to save the file from the following drop-down list.
The following file formats can be selected.

Table 2.2 Type of Files That Can be Uploaded

Displayed List Items File Format
Intel Hex format (*.hex) Intel Hex format
Motorola Hex format (*.hex) Motorola S type format
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Displayed List Items File Format

Binary data (*.bin) Binary format

(3) Specify [Save Range Address/Symbol]
Specify the range of addresses to save via "start address" and "end addresses".
Directly enter hexadecimal number/address expression in each text box or select from the input history displayed
in the drop-down list (up to 10 items).

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in each text box (see "2.19.2 Symbol name completion function™).

(4) Click the [Save] button
Save the contents of the memory in the specified file in specified format as upload data.
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2.6 Display/Change Programs

This section describes how to display and change programs when a load module file with the debug information is
downloaded to a debug tool.
Downloaded programs can be displayed in the following panels.

- Editor panel
The source file is displayed and can be edited.
Furthermore, the source level debugging/instruction level debugging (see "2.7.3 Execute programs in steps") and the
display of the code coverage measurement result (see "2.13.2 Display the coverage measurement result") can be
performed in this panel.

- Disassemble panel
The result of disassembling the downloaded program (the memory contents) is displayed and can be edited (line
assemble).
Furthermore, the instruction level debugging (see "2.7.3 Execute programs in steps") and the display of the code cov-
erage measurement result (see "2.13.2 Display the coverage measurement result") can be performed in this panel.
In this panel, the disassemble results can be displayed with the corresponding source text (default).

Remark It is normally necessary to download a load module file with debugging information in order to perform
the source level debugging, but it is also possible to do so by downloading an Intel HEX file (*.hex),
Motorola S-record file (*.mot) or binary file (*.bin) (see "2.5.2.3 Perform source level debugging with files
other than the load module file format").

2.6.1 Display source files

The source file is displayed in the Editor panel below. The Editor panel automatically opens with displaying source text
of the specified position (see "2.5.1 Execute downloading") when a load module file is successfully downloaded.

If you want to open the Editor panel manually, double-click on the source file in the Project Tree panel.

For details on the contents and function in each area, see the section for the Editor panel.

Figure 2.23 Display Source File (Editor Panel)
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2.6.2 Display the result of disassembling

The result of disassembling the downloaded program (disassembled text) is displayed in the Disassemble panel below.

Select [View] menu >> [Disassemble] >> [Disassemblel - 4].

The maximum of 4 Disassemble panels can be opened. Each panel is identified by the names "Disassemblel",
"Disassemble2", "Disassemble3" and "Disassemble4" on the titlebar.

For details on the contents and function in each area, see the section for the Disassemble panel.

R20UT4857EJ0100 Rev.1.00 RENESAS Page 32 of 391
Nov 01, 2020



CS+Vv8.05.00

2. FUNCTIONS

Figure 2.24 Display Result of Disassembling (Disassemble Panel)
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(1): Event area
(2): Address area
(3): Disassemble area

Remark

You can set the scroll range of the vertical scroll bar on this panel via the Scroll Range Settings dialog

box that is opened by clicking the button from [View] on the toolbar.

This section describes the following.

2.6.2.1 Change display mode
2.6.2.2 Change display format

2.6.2.3 Move to the specified address
2.6.2.4 Move to the symbol defined location
2.6.2.5 Save the disassembled text contents

2.6.2.1 Change display mode

You can change the display mode of the Disassemble panel by clicking the button (toggle) on the toolbar.

(1) Mixed display mode
In this display mode (default), the disassembled text is displayed combined with the source text.
Figure 2.25 Mixed Display Mode (Disassemble Panel)
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(2) Disassemble display mode

In this display mode, the source text is hidden and only the disassembled text is displayed.
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Figure 2.26 Disassemble Display Mode (Disassemble Panel)

_funel:

10 1dl ol PL&EH HL

101 el 16 GLRN Al

101d i[5 HIWH HL ., &K

1014 K HOW'H AN, HL

101 d= 441400 CYPY A H004H

inid dell? BEG 3 funcl4+0=10
% 001 da feadl100D  CALL T funcla

10| da o TRCH HL

101 df affa BE 3 funci40:=3

101 el ch POP HL

10 e _fml:f&?i RET Disassembled text

101 &3 F) PLEH HL

101 ed TH CLRY ik

2.6.2.2 Change display format

The display format of the disassemble area can be changed using buttons below on the toolbar.

View The following buttons to change the display format are displayed.

Show Offset Displays the offset value of the label. The offset value from the nearest label is dis-
played when a label is defined for the address.

Show Symbol Displays the address value as the result of disassembling in the format "symbol + off-
set value" (default).

Note that when a symbol has been defined as the address value, only the symbol is
displayed.

Show Function Name | Displays the name of the register by its function name (default).

Show Absolute Name | Displays the name of the register by its absolute name.

2.6.2.3 Move to the specified address

You can move to the specified address in the disassembled text in the Go to the Location dialog box which opens when
selecting [Go to...] from the context menu.
In this dialog box, follow the steps below.

Figure 2.27 Move to Specified Address in Disassembled Text (Go to the Location Dialog Box)
Go to the Location E
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(1) Specify [Address/Symbol]
Specify the address you want to move the caret to.
You can either type an address expression directly into the text box (up to 1024 characters), or select them from
the input history via the drop-down list (up to 10 items).

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in this text box (see "2.19.2 Symbol name completion function").

(2) Click the [OK] button
Caret is moved to the specified address.

2.6.2.4 Move to the symbol defined location

You can move the caret to the address where the symbol is defined.
Click the button on the toolbar after moving the caret to the instruction which refers to the symbol.
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Furthermore, click the button on the toolbar following the previous operation returns the caret to the instruction
which refers to the symbol at previous caret is defined.

2.6.2.5 Save the disassembled text contents

Contents of the disassembled text can be saved in text files (*.txt)/CSV files (*.csv).

When saving to the file, the latest information is acquired from the debug tool, and it is saved in accordance with the dis-
play format on this panel.

The Data Save dialog box can be opened by selecting the [File] menu >> [Save Disassemble Data As...] (when this
operation takes place with the range selected on the panel, the disassembled data can be saved only for the selected
range).

In this dialog box, follow the steps below.

Figure 2.28 Save Disassembled Text Contents (Data Save Dialog Box)
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[

File Mame: | GhEample_projecisiDizassenble] -

File Typer | Teut files{* tat)
Save Raree Address Swmbal:

_imairrt [l E| - _man+lxe

(1) Specify [File Name]
Specify the name of the file to save.
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history
via the drop-down list (up to 10 items).
You can also specify the file by clicking the [...] button, and selecting a file via the Select Data Save File dialog box.

(2) Specify [File Type]
Select the format in which to save the file from the following drop-down list.
The following file formats can be selected.

List Item Format
Text files (*.txt) Text format (default)
CSV (Comma-Separated Variables)(*.csv) CSV formatNote
Note The data is saved with entries separated by commas (,).
If the data contains commas, each entry is surrounded by double quotes " in order to avoid illegal
formatting.

(3) Specify [Save Range Address/Symbol]
Specify the range of addresses to save via "start address” and "end addresses".
Directly enter hexadecimal number/address expression in each text box or select from the input history displayed
in the drop-down list (up to 10 items).
If a range is selected in the panel, that range is specified as the default. If there is no selection, then the range
currently visible in the panel is specified.

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in each text box (see "2.19.2 Symbol name completion function™).

(4) Click the [Save] button
Disassembling data is saved in the specified file with the specified format.
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Figure 2.29 Output Example of Disassembling Data
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Remark 1. When the contents of the panel are overwritten and saved by selecting the [File] menu >> [Save
Disassemble Data], the Disassemble panels (Disassemblel-4) are handled individually for these
respectively. In addition, saving range is same as the previously specified address range.

Remark 2. You can print the current screen image of this panel by selecting the [File] menu >> [Print...].

2.6.3 Run a build in parallel with other operations

CS+ can automatically start a build when one of the following events occurs (rapid build function).
- For other than the debug-only project

- When any one of the following files that are added to the project is updated:
(C source file, assembler source file, header file, link directive file, symbol information file, object module file,
and library file)

- When a build target file has been added to or removed from the project
- When the link order of object module files and library files is changed

- When the property of the build tool or the build target file is changed

- For the debug-only project

- When you have edited and saved the C source file, assembler source file and header file that are added to the
debug-dedicated project

- When a C source file, assembler source file, or header file has been added to or removed from the debug-dedi-
cated project

- When the property of the debug-dedicated project is changed
If a rapid build is enabled, it is possible to perform a build in parallel with the above operations.
To enable/disable a rapid build, select [Rapid Build] from the [Build] menu. A rapid build is enabled by default.

Caution When an external text editor is used, check the [Observe registered files changing] check box on the
[General - Build] category in the Option dialog box to enable this function.

Remark 1. After editing source files, it is recommend to save frequently by pressing the [Ctrl] + [S] key.
Remark 2. Enable/Disable setting of the rapid build applies to the entire project (main project and subprojects).

Remark 3. If you disable a rapid build while it is running, it will be stopped at that time.

2.6.4 Perform line assembly

Instructions and code displayed in the Disassemble panel can be edited (line assembly).
This section describes the following.

2.6.4.1 Edit instructions
2.6.4.2 Edit code

2.6.4.1 Edit instructions

Follow the steps below to edit instructions.
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(1) Switch to edit mode

Double-click the instruction to edit or select [Edit Disassemble] from the context menu after moving the caret to the
instruction to edit.

(2) Edit instructions
Use keyboard to directly edit the instructions.

(3) Write to memory

Press the [Enter] key to line assemble the edited instructions after editing. The code is automatically written to the
memory.

If the edited instruction is invalid, the instruction is shown in red and will not be written to the memory.

If there is a space because of overwriting the displayed result of disassembling by another instruction, its byte number is
automatically compensated with NOP instruction as follows:

Example 1.  MOVW instruction (4-byte instruction) in the second line is overwritten by DEC instruction (1-byte instruc-

tion).

Before editing | 0461CF ADDW AX,#0CF61H
CBF820FE MOVW SP,#0FE20H
FC8E1800 CALL 11_funcA
53C0 MOV B, #OCOH

After editing 0461CF ADDW AX,#0CF61H
93 DEC B
00 NOP
00 NOP
00 NOP
FC8E1800 CALL 11_funcA
53C0 MOV B, #OCOH

Example 2.  ADDW instruction (3-byte instruction) in the first line is overwritten by MOVW instruction (4-byte instruc-

tion).

Before editing 0461CF ADDW AX,#0CF61H
CBF820FE MOVW SP,#0FE20H
FC8E1800 CALL 11_funcA
53C0 MOV B, #OCOH

After editing CBF820FE MOVW SP, #OFE20H
00 NOP
00 NOP
00 NOP
FC8E1800 CALL 11 _funcA
53C0 MOV B, #OCOH

2.6.4.2 Edit code

Follow the steps below to edit code.

(1) Switch to edit mode
Double-click the code to edit or select [Edit Code] from the context menu after moving the caret to the code to edit.

(2) Editcode
Use keyboard to directly edit the code.

(3) Write to memory
Press the [Enter] key to write the code to the memory after editing.
If the edited instruction is invalid, the instruction is shown in red and will not be written to the memory.
When the code is written to the memory, the result of disassembling is also updated.
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2.7 Execute Programs

This section describes how to execute programs.
Main operations in this section are taken place from the debug toolbar or the [Debug] menu in the Main window, where
commands to control the execution of programs are included.

Caution Items of the debug toolbar and the [Debug] menu are valid only while connected to the debug tool.

Figure 2.30 Debug Toolbar
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2.7.1 Reset microcontroller (CPU)

To reset CPU, click the button on the debug toolbar.
When CPU is reset, the current PC value is set to the reset address.

Remark You can automatically overwrite the value of SFR/CPU register with the specified values after CPU reset
under breaking (see "2.16 Use Hook Function" for details).

2.7.2 Execute programs

The following types of CS+ execution functions are provided.
Select any of the following operations according to the purpose of debugging.
See "2.8 Stop Programs (Break)" for details on how to stop the program in execution.

2.7.2.1 Execute after resetting microcontroller (CPU)
2.7.2.2 Execute from the current address
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2.7.2.3 Execute after changing PC value
Remark You can automatically overwrite the value of SFR/CPU register with the specified values before starting

program execution (see "2.16 Use Hook Function” for details).

2.7.2.1 Execute after resetting microcontroller (CPU)

Click the button on the debug toolbar.
Reset CPU and start execution of the program from the reset address.
When this operation is performed, the program continues to be executed until either of the following occurs:

- The button has been clicked (see "2.8.2 Stop the program manually").
- The PC has reached a breakpoint (see "2.8.3 Stop the program at the arbitrary position (breakpoint)").

- A break event condition has been met (see "2.8.4 Stop the program at the arbitrary position (break event)" or "2.8.5
Stop the program with the access to variables/SFRs").

- A fail-safe break has occurred (see "2.8.6 Stop the program when an invalid execution is detected [[IECUBE]").

- Other break causes have occurred.
Remark This operation is the same as when the button is clicked after clicking the button.

2.7.2.2 Execute from the current address

Perform any of the following operations to start executing the program from the address at the current PC value.

(1) Normal execution
Click the button on the debug toolbar.
When this operation is performed, the program continues to be executed until either of the following occurs:

- The button has been clicked (see "2.8.2 Stop the program manually™).

- The PC has reached a breakpoint (see "2.8.3 Stop the program at the arbitrary position (breakpoint)™).

- A break event condition has been met (see "2.8.4 Stop the program at the arbitrary position (break event)" or

"2.8.5 Stop the program with the access to variables/SFRs").
- A fail-safe break has occurred (see "2.8.6 Stop the program when an invalid execution is detected [[ECUBE]").
- Other break causes have occurred.
(2) Execution ignoring break-related events

Click the button on the debug toolbar.

When this operation is performed, the program continues to be executed until either of the following occurs:

- The button has been clicked (see "2.8.2 Stop the program manually").

- A fail-safe break has occurred (see "2.8.6 Stop the program when an invalid execution is detected [[ECUBE]").

- Other break causes have occurred.

Remark If you have started the execution with this operation, the occurrence of Action event will also be
ignored.

(3) Execution to the caret position

To start this operation, move the caret to the line/instruction to stop the program in the Editor panel/Disassemble

panel, then select [Go to Here] from the context menu.

When this operation is performed, the program continues to be executed until either of the following occurs:

- The PC has reached the address of the caret position.

- The button has been clicked (see "2.8.2 Stop the program manually").

- A fail-safe break has occurred (see "2.8.6 Stop the program when an invalid execution is detected [[ECUBE]").

- Other break causes have occurred.

Caution When the corresponding address of the line at the caret position does not exist, the program is exe-
cuted to the corresponding address of the lower valid line (if the corresponding address does not
exist, an error message will appear).
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Remark If you have started the execution with this operation, the occurrence of Action event will also be
ignored.

2.7.2.3 Execute after changing PC value

The program is executed after forcibly changing the current PC value to an arbitrary address.

To start this operation, move the caret to the line/instruction to start the program in the Editor panel/Disassemble panel,
then select [Set PC to Here] from the context menu (the current PC value is set to the address of the line/instruction where
the caret currently exists).

Then execute either one of the execution method described in "2.7.2.2 Execute from the current address".

2.7.3 Execute programs in steps

When either of the following operation has occurred, the program will stop automatically after conducting step execution
in the source level (1 line of source text) or in the instruction level (1 instruction).

Once the program is stopped, the contents of each panel will be updated automatically. As such, step execution is
suited for debugging the program execution in transition either in source or instruction level.

The unit in which the program is step-executed depends on the setting of the Editor panel as follows:

- When the button on the toolbar is invalid (default):
Step execution is conducted in source level.
Note, however, that when the focus is in the Disassemble panel or the line information does not exist in the address
specified by the current PC value, the step execution is conducted in instruction level.

- When the button on the toolbar is valid:
Step execution is conducted in instruction level.

Remark The button is only enabled if the mixed display mode is selected on the Editor panel (see "CS+ Inte-
grated Development Environment User's Manual: Editor").

Step execution is divided into the following types:

2.7.3.1 Step in function (Step in execution)
2.7.3.2 Step over function (Step over execution)
2.7.3.3 Execute until return is completed (Return out execution)

Caution 1.  Breakpoints, break events, and action events that have been set do not occur during step execution.

Caution 2. If an instruction to move to standby mode (HALT/STOP) is executed during step execution, the program
will break at the next instruction after the standby mode instruction.
This behavior differs depending on the debug tool used.

- For other than [Simulator]
It will not go into standby mode during step execution.

- [Simulator]
It will go into standby mode during step execution.
It will appear that standby mode has been released. Check the CPU status on the Main window's sta-
tusbar to see if standby mode has been released.

Caution 3.  For other than [Simulator]
- Interrupts are not acknowledged and fail-safe breaks [IECUBE] do not occur during step execution.

- If step execution is performed in source level, CS+ determines whether an interrupt is being processed
via the NP, EP, and ID flags in the PSW register. For this reason, if the above register or flags are
changed (e.g. when using multiple interrupts), then Return out execution may be incorrect.

Caution 4.  [Simulator]
You may jump to an interrupt handler during step execution.

Caution 5. During source-level stepping, the debugger may appear to be executing instructions that are not sup-
posed to be executed.
However, the reason for these problems is a difference between the debugging information generated by
the compiler and the actual code. The result of executing the code generated by the compiler is correct.
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Example In the program code shown below, it seems that the position indicated by the current PC
might be moved to position (*1) after the execution of (*2), although (*1) is never actually
executed in the generated code.

void main(void);
int x, y, z1, z2, z3;
void func(int i)

{
it (i ==0) {
++x; // <-(*1)
++z1;++22;++23;
} else {
+ty; /1 <-(*2)
++71;++22;++723;
}
3

int one = 1;
void main(void)

while (1)
{
func(one);
3
3

Note that this caution may be eliminated by making either or both of the following settings on the [Com-
pile Options] tab in the Property panel of the build tool.

- Set the [Enhance debug information with optimization] property to [Yes(-g_line)] in the [Debug Informa-
tion] category.

- Set the [Level of optimization] property to [Debug precedence(-Onothing)] in the [Optimization] cate-
gory.

2.7.3.1 Step in function (Step in execution)

When the function is called, the program is stopped at the top of the called function.
Click the button on the debug toolbar to perform Step in execution.

Caution 1.  Step in execution for a function without the debug information is not possible.

Caution 2. If Step in execution is performed for the longjmp function, program execution may not complete and may
wait for a time-out.

Caution 3.  The beginning of the function (prologue processing) is not skipped. To skip prologue processing, perform
Step in execution again.

2.7.3.2 Step over function (Step over execution)

In the case of a function call by the CALL instruction, all the source lines/instructions in the function are treated as one
step and executed until the position where execution returns from the function (step execution will continue until the same
nest is formed as when the CALL instruction has been executed).

Click the button on the debug toolbar to perform Step over execution.

In the case of an instruction other than CALL, operation is the same as Step in execution.

Caution If Step over execution is performed for the longjmp function, program execution may not complete and
may wait for a time-out.

2.7.3.3 Execute until return is completed (Return out execution)

Step-execute the program so that the program will stop when it returns from the current function to the caller function.
When the execution of source line/instruction that require checking has been completed, you can perform step execution
using this instruction so that you can make the program return to the caller function without step executing the remaining
instructions inside the function.
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Click the button on the debug toolbar to perform Return out execution.

Caution 1.  If Return out execution is performed in the main function, the program is stopped in the startup routine.

Caution 2. If Return out execution is performed in a function that called the longjmp function, breaks may not occur.

Caution 3.  Return out execution cannot be performed immediately after a function return.

2.8 Stop Programs (Break)

This section describes how to stop the program in execution.
CS+ can stop the program in execution at the arbitrary position by using the following functions.

1)

@)

®)

Forced break function
Stops the program forcibly.

Hardware break function

The debug tool consecutively checks the break condition while the program is in execution and stops the program
when the condition is met. This function is implemented using the debug tool resources.

There are two types of Hardware Break event: "execution type" which stops the program at the arbitrary position;
and "access type" which stops the program when an arbitrary variable and so on is accessed with the specified

type.

Remark 1. [IECUBE]
There are two types of Hardware Break event (execution type): "before execution break" which
breaks before the instruction at the specified address is executed; and "after execution break"
which breaks after the instruction at the specified address is executed. CS+ starts by using "before
execution break" resource to set Hardware Break events, and as soon as that resource becomes
unavailable, uses "after execution break" resource (see "2.15.7.1 Maximum number of enabled
events"). For this reason, you cannot select between before and after execution.

Remark 2. [E1][E20][EZ Emulator][COM Port]
Hardware Break events (execution type) break the program after the instruction at the specified
address is executed.

Remark 3. [Simulator]
For a Hardware Break event (execution type), you can select between "before execution break”
which breaks before the instruction at the specified address is executed and "after execution break"
which breaks after the instruction at the specified address is executed (see "2.8.1.3 [Simulator]").

Software break function (except for [Simulator])
Temporarily replaces the instruction code for a specified address with a break instruction and stops the program
when this instruction is executed.

Caution 1.  If aforced break is performed while in standby mode (HALT/STOP), the current PC position will indicate

the address of the next instruction after the standby mode instruction.
This behavior differs depending on the debug tool used.

- For other than [Simulator]
The forced break will release standby mode.

- [Simulator]
The forced break will not release standby mode.
It will appear that standby mode has been released. Check the CPU status on the Main window's sta-
tusbar to see if standby mode has been released.

Caution 2.  [E1][E20][EZ Emulator][COM Port]

Do not decrease the voltage of the target system during a break. A reset that is generated by the low-
voltage detector (LVI) or by power-on-clear (POC) during a break causes an incorrect operation of CS+
or communication errors.

A break during emulation of power supply off also causes communication errors.

Remark When the program in execution is stopped, a statement of the cause of the break appears on the Status-

bar in the Main window.

2.8.1 Configure the break function

Before the break function can be used, it is necessary to make settings relating to the operation of a break.
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This break operation can be configured in the [Break] category on the [Debug Tool Settings] tab of the Property panel.
The setting method differs depending on the debug tool used.

2.8.1.1 [IECUBE]
2.8.1.2 [E1)/[E20)/[EZ Emulator]/[COM Port]
2.8.1.3 [Simulator]

2.8.1.1 [IECUBE]

Figure 2.32 [Break] Category [I[ECUBE]

4 Bresk
First using tvpe of breakpont Sofivware break
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Stop emulation ol serizl group when slapping I
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(1) [First using type of breakpoint]
Specify the type of preferential breakpoint with a single click of the mouse in the Editor panel/Disassemble panel.
Select from the drop-down list below for each use of the breakpoint.

Hardware break Sets hardware breakpoint with priority, by using the Hardware break function.
Once set, it is treated as a Hardware Break event (execution system).

Software break Sets software breakpoint with priority, by using the Software break function (except for
[Simulator]) (default).
Once set, it is treated as a Software Break event.

Caution If the number of the set breakpoints of the specified type exceeds the limit settable (see "2.15.7.1
Maximum number of enabled events"), a breakpoint of another type will be used.

(2) [Stop emulation of timer group when stopping]
Select whether to terminate the peripheral emulation of timers while stopping the program execution (Peripheral
Break).
Select [Yes] to terminate (default: [No]).

(3) [Stop emulation of serial group when stopping]
This property appears only when the selected microcontroller supports the function that terminates the peripheral
emulation of serials (Peripheral Break).
Select whether to terminate the peripheral emulation of serials while stopping the program execution.
Select [Yes] to terminate (default: [No]).

(4) [Use open break function]
This property appears only when the selected microcontroller supports the open break function.
Select from the following drop-down list whether to use the open break function.
The default value depends on the type of the selected microcontroller.

Yes(Hi-2) The open break target pin becomes the Hi-Z state after the CPU is stopped.

No(Output signal) The open break target pin outputs the signal even after the CPU is stopped.

2.8.1.2 [E1])/[E20)/[EZ Emulator]/[COM Port]

Figure 2.33 [Break] Category [E1][E20][EZ Emulator][COM Port]
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(1) [First using type of breakpoint]
This property appears only when the selected microcontroller supports multiple types of breakpoint.
Specify the type of preferential breakpoint with a single click of the mouse in the Editor panel/Disassemble panel.
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Select from the drop-down list below for each use of the breakpoint.

Hardware break Sets hardware breakpoint with priority, by using the Hardware break function.
Once set, it is treated as a Hardware Break event (execution system).

Software break Sets software breakpoint with priority, by using the Software break function (except for
[Simulator]) (default).
Once set, it is treated as a Software Break event.

Caution If the number of the set breakpoints of the specified type exceeds the limit settable (see "2.15.7.1
Maximum number of enabled events"), a breakpoint of another type will be used.

(2) [Stop emulation of timer group when stopping]
Select whether to terminate the peripheral emulation of timers while stopping the program execution (Peripheral
Break).
Select [Yes] to terminate (default: [No]).
In the case of the selected microcontroller that provides the open break function, when this property is set to [Yes],
the open break target pin becomes the Hi-Z state after the CPU is stopped (when this property is set to [No], the
open break target pin outputs the signal even after the CPU is stopped).

(3) [Stop emulation of serial group when stopping]
This property appears only when the selected microcontroller supports the function that terminates the peripheral
emulation of serials (Peripheral Break).
Select whether to terminate the peripheral emulation of serials while stopping the program execution.
Select [Yes] to terminate (default: [No]).

(4) [Restore the breakpoint when pin reset occurs]
This property only appears if the selected microcontroller supports the function of restoring breakpoints after a pin
reset and the [Permit flash programming] property in the [Flash] category on the [Connect Settings] tab is set to
[Yes].
Select whether to restore the breakpoints when a pin reset occurs.
When [Yes] is selected, the CPU is briefly halted for restoration of the breakpoints after a pin reset (default).
When [No] is selected, the breakpoints are ignored and not restored after a pin reset, but are restored when the
program is stopped.

2.8.1.3 [Simulator]

Figure 2.34 [Break] Category [Simulator]
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Exesute nslruction 21 breakpant wken break Hi

(1) [Execute instruction at breakpoint when break]
You can specify the timing to stop the program execution by breakpoints whether after or before the execution of
the instruction at the breakpoint. Specify in this property whether to break after executing the instruction.
Select [Yes] to break after execution of the instruction (default: [No]).
All set breakpoints are handled as Hardware Break events.

Caution When [Yes] is selected, all of action events currently being set are handled as Hardware Break
events (see "2.14 Set an Action into Programs").

2.8.2 Stop the program manually

The program in execution is forcibly stopped by clicking the button on the debug toolbar.

2.8.3 Stop the program at the arbitrary position (breakpoint)

The program in execution can be stopped at the arbitrary position by setting a breakpoint. A breakpoint can be set by
one-clicking with the mouse.

You need to configure the type of breakpoints to use before setting a breakpoint.

This section describes the following operations.

2.8.3.1 Set a breakpoint
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2.8.3.2 Edit a breakpoint
2.8.3.3 Delete a breakpoint

2.8.3.1 Set a breakpoint

Breakpoints can be set via the Editor panel/Disassemble panel in which the source text/disassembly text is displayed.

Within the Main area (Editor panel) or Event area (Disassemble panel) in which a valid address is displayed, click on the
location where you want to set a breakpoint. A breakpoint whose type is being selected in the [First using type of break-
point] property is set to the instruction at the start address corresponding to the clicked line.

When a breakpoint is set, the following event mark appears at the breakpoint location, and the source text line/disas-
sembled text line is highlighted.

Itis interpreted as if a break event (Software Break or Hardware Break) has been set at the target address, and it is
managed in the Events panel (see "2.15 Manage Events" for details).

Table 2.3 Event Marks of Breakpoint

Type of Breakpoint Event Type Event Mark
Hardware breakpoint Hardware Break eventNote *,
Software breakpoint Software Break eventN°® 05
(except [Simulator])

Note In the [Name] area of the Events panel, "Break" is displayed as the event type name.

Figure 2.35 Breakpoint Setting Example (Disassemble Panel)
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Figure 2.36 Example of Setting Breakpoint in Events Panel
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Caution 1.  Since a breakpoint is set as a break event and managed as a event, restrictions apply to the number of
breakpoints that can be simultaneously set. Also see "2.15.7 Notes for setting events" for details on
breakpoints (e.g. limits on the number of enabled events).

Caution 2. No software breakpoints can be set to the data flash memory area.
Caution 3.  Breakpoints can only be set at lines that have valid addresses.

Remark 1. Event marks differ depending on the event state (see "2.15.1 Change the state of set events (valid/
invalid)").
When an event is set at the point where other event is already set, the event mark ( h,_,':’ ) is displayed
meaning more than one event is set at the point.

Remark 2. [Simulator]
The type of breakpoint that can be set is locked to hardware breakpoints.
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Remark 3. For other than [Simulator]
You can set hardware breakpoints/software breakpoints without depending on the specification of "2.8.1
Configure the break function" by following the step below.
Note, however, that "Operation 1" is only available in the Disassemble panel.

Type Operation 1 Operation 2

Hardware breakpoint [Ctrl] + mouse click Select [Break Settings] >> [Set Hardware Break]
from the context menu.

Software breakpoint [Shift] + mouse click Select [Break Settings] >> [Set Software Break]
from the context menu.

2.8.3.2 Edit a breakpoint

It is possible to edit a breakpoint you have set.
For details on how to do it, see "2.15.4.1 Edit execution-related events".

Caution This function applies to only a breakpoint whose type is Hardware Break.

2.8.3.3 Delete a breakpoint

Click event marks displayed in the Editor panel/Disassemble panel to delete set breakpoints (the event mark will be
erased).

2.8.4 Stop the program at the arbitrary position (break event)

The program in execution can be stopped at the arbitrary position by setting a break event (execution type).
This section describes the following operations.

2.8.4.1 Set a break event (execution type)
2.8.4.2 Edit a break event (execution type)
2.8.4.3 Delete a break event (execution type)

2.8.4.1 Set a break event (execution type)

Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is displayed.
Follow the operation listed below from the context menu, in accordance with your desired event type, after moving the
caret to the target line that has a valid address.

Event Type Operation Description
Hardware Break Select [Break Settings] >> [Set Hardware | Sets a Hardware Break event by using the Hard-
Break] ware break function.
Software Break Select [Break Settings] >> [Set Software Sets a Software Break event by using the Soft-
(except [Simulator]) | Break] ware break function (except for [Simulator]).

Combination Break | Select [Break Settings] >> [Set Combina- | A combined break event, that is, a break condi-
[E1][E20] tion Break] tion that is a combination of multiple break
events, may be set as the target event condition
on the E1 and E20N°® (see "Edit combination
conditions of events [E1] [E20]").

Note [E1][E20]
This function is enabled only when the selected microcontroller supports a combination break event.

A break event is set to the instruction at the start address corresponding to the line of the caret position. When a break
event (execution type) is set, the following event mark appears at the break event location, and the source text line or dis-
assembled text line will be highlighted.
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When you have performed this operation, the set break event is managed in the Events panel as a Hardware Break
event (execution type)/Software Break event (execution type) or a execution-related event in the detailed information on a
Combination Break event (see "2.15 Manage Events" for details).

Table 2.4 Event Marks of Break Event
Event Type Event Mark
Hardware Break »
Software Break ﬂ.}?
(except [Simulator])
Combination Break )
[E1][E20]
Figure 2.37 Break event Setting Example (Disassemble Panel)
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Figure 2.38 Example of Setting Hardware Break Event (Execution Type) in Events Panel
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Figure 2.39 Example of Setting Combination Break Event (Execution Type) in Events Panel [E1][E20]
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Caution 1.  When setting a break event (execution type), also see "2.15.7 Notes for setting events" for details (e.g.
limits on the number of valid events).
Caution 2.  No software breakpoints can be set to the data flash memory area.
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Remark Event marks differ depending on the event state (see "2.15.1 Change the state of set events (valid/
invalid)"). When an event is set at the point where other event is already set, the event mark ( h,_.‘:’ )is
displayed meaning more than one event is set at the point.

2.8.4.2 Edit a break event (execution type)

It is possible to edit a break event (execution type) you have set.
For details on how to do it, see "2.15.4.1 Edit execution-related events" or "2.15.4.3 Edit combination conditions of
events [E1] [E20]".

Caution This function applies to only a break event (execution type) whose type is Hardware Break or Combina-
tion Break [E1][E20].

2.8.4.3 Delete a break event (execution type)

To delete a break event (execution type) you have set, click the event mark displayed in the Editor panel/Disassemble
panel.

Also, there is another way to delete a set break event. Select a Software Break event/Hardware Break event, or Com-
bination Break event [E1][E20] in the Events panel, and then click the button in the toolbar (see "2.15.5 Delete
events").

Caution In the Events panel, you cannot delete a break event (execution type) selectively in the combination
breaks. All the break events (including access type) displayed in the detailed information on the combina-
tion break will be deleted.

2.8.5 Stop the program with the access to variables/SFRs

By setting a break event with the access, the program can be stopped when an arbitrary variable or SFR is accessed
with the specified type.

You can also limit the accessed value.

The following types can be specified with the access.

Table 2.5 Types of Accesses to Variables

Access Type Description
Read The program is stopped with the read access to (after reading) the specified variable/SFR.
Write The program is stopped with the write access to (after writing) the specified variable/SFR.
Read/Write The program is stopped with the read access/write access to (after reading or writing) the
specified variable/SFR.

Caution [IECUBE][E1][E20][EZ Emulator][COM Port]
The program is stopped with the access via DMA (Direct Memory Access).

This section describes the following.

2.8.5.1 Set a break event (access type)
2.8.5.2 Edit a break event (access type)
2.8.5.3 Delete a break event (access type)

2.8.5.1 Set a break event (access type)

Use one of the following methods to set a break event (access type) that stops programs with the access to a variable/
SFR.

Caution 1.  Also see "2.15.7 Notes for setting events" for details on breakpoints (e.g. limits on the number of enabled
events).

Caution 2. For other than [Simulator]
The access break events described here cannot be set for 32-bit (4-byte) variables.
Additionally, accessing a single byte of a 16-bit (2-byte) variable will not be detected as an access.
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(1) Setabreak eventto a variable/SFR in the Editor panel/Disassemble panel
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is dis-
played.
Follow the operation listed below from the context menu, in accordance with your desired access type, after
selecting an arbitrary variable or SFR on the source text/disassembled text. Note, however, that only global vari-
ables, static variables inside functions, and file-internal static variables can be used.

Access Type Operation

Read Select [Break Settings] >> [Set Read Break to]/[Set Read Combination Break to]NOte, and
then press the [Enter] key.

Write Select [Break Settings] >> [Set Write Break to]/[Set Write Combination Break to]NOte, and
then press the [Enter] key.

Read/Write Select [Break Settings] >> [Set R/W Break to]/[Set R/W Combination Break to]Nc’te, and then
press the [Enter] key.

Note [E1][E20]
A combined break event, that is, a break condition that is a combination of multiple break events,
may be set as the target event condition on the E1 and E20 (see "2.15.4.3 Edit combination condi-
tions of events [E1] [E20]").
Note, however, that this function is enabled only when the selected microcontroller supports a com-
bination break event.

At this time, if you have specified a value in the text box in the context menu, break will occur only when the spec-
ified value is used for the reading, writing or reading/writing. On the other hand, if no value is specified, reading.,
writing or reading/writing the selected variable by any value will cause the break to occur.

Caution 1.  Variables within the current scope can be specified.

Caution 2. Variables or SFR at lines that have no valid addresses cannot be used for break events.

Figure 2.40 Example of Setting Break Event (Access Type) on Variable in Editor Panel
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Figure 2.41 Example of Setting Combination Break Event (Access Type) on Variable in Editor Panel [E1][E20]
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(2) Setabreak event (access type) to a registered watch-expression
You can set break events in the Watch panel.
Follow the operation listed below from the context menu, in accordance with your desired access type, after
selecting the registered watch-expression (multiple selections not allowed).
Note, however, that only global variables, static variables inside functions, file-internal static variables, and SFR

can be used.
Access Type Operation
Read Select [Access Break] >> [Set Read Break to]/[Set Read Combination Break to]N°®¢, and
then press the [Enter] key.
Write Select [Access Break] >> [Set Write Break to]/[Set Write Combination Break to]'V°'¢, and then
press the [Enter] key.
Read/Write Select [Access Break] >> [Set R/W Break to]/[Set R/W Combination Break to]N°®, and then
press the [Enter] key.
Note [E1][E20]

A combined break event, that is, a break condition that is a combination of multiple break events,
may be set as the target event condition on the E1 and E20 (see "2.15.4.3 Edit combination condi-
tions of events [E1] [E20]").

Note, however, that this function is enabled only when the selected microcontroller supports a com-
bination break event.

At this time, if you have specified a value in the text box in the context menu, break will occur only when the spec-
ified value is used for the reading., writing or reading/writing. On the other hand, if no value is specified, reading.,
writing or reading/writing the selected watch-expression by any value will cause the break to occur.

Caution A watch-expression within the current scope can be specified.
To target a watch-expression outside the current scope, select a watch-expression with a specified
scope.
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Figure 2.42 Example of Setting Hardware Break Event (Access Type) on Watch-Expression
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From the context menu above the watch-expression "datal",
enter a value in [Access Break] >> [Set Write Break to], then
press the [Enter] key.

Here, the program will break when the value "0xb" is written to
the watch-expression "datal”.

Figure 2.43 Example of Setting Combination Break Event (Access Type) on Watch-Expression [E1][E20]
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From the context menu above the watch-expression "datal”, Break to
. | enter a value in [Access Break] >> [Set Write Combination
m Break to], then press the [Enter] key.
Here, the program will break when the value "0xb" is written to
the watch-expression "datal".

When you have performed the above operation, the set break event (access type) is managed in the Events panel
as a Hardware Break event (access type) or a execution-related event in the detailed information on a Combina-
tion Break event (see "2.15 Manage Events" for details).

Figure 2.44 Example of Setting Hardware Break Event (Access Type) in Events Panel
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Figure 2.45 Example of Setting Combination Break Event (Access Type) in Events Panel [E1][E20]
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2.8.5.2 Edit a break event (access type)

It is possible to edit a break event (access type) you have set.
For details on how to do it, see "2.15.4.1 Edit execution-related events" or "2.15.4.3 Edit combination conditions of
events [E1] [E20]".

2.8.5.3 Delete a break event (access type)

To delete a break event (access type) you have set, select a Hardware Break event, or Combination Break event
[E1][E20] in the Events panel, and then click the button in the toolbar (see "2.15.5 Delete events").

For a Combination Break event [E1][E20], it is also possible to delete a break event (access type) by clicking on the
event mark on the Editor panel/Disassemble panel.

Caution In the Events panel, you cannot delete a break event (execution type) selectively in the combination
breaks. All the break events (including access type) displayed in the detailed information on the combina-
tion break will be deleted.

2.8.6 Stop the program when an invalid execution is detected [IECUBE]

The system forcibly breaks the program execution when unexpected program behavior such as invalid access to inter-
nal ROM/internal RAM/SFR/external memory is detected (fail-safe break function).

This function has various break conditions. Enable/disable each break condition in the [Fail-safe Break] category on the
[Debug Tool Settings] tab of the Property panel.

Caution The fail-safe break function becomes invalid during step execution.

Figure 2.46 [Fail-safe Break] Category
4 Fail-zafe Break

Hap when fetched fram felch profected ares s
stop when wrote fooweite protected area g
Stap when read from read protected SFR Yes
Shap when wrole fo write prelected SFR Yes
stop when overflowed user stack Mo
Stop when widarflomed user stack Mo
Uzar slack saction siack basz
hop when cperated winitalzed stack ponter Yes
Stop when read from uninitialized P Yeg
Stap when accessed (o non-mapping asa Yes
Hop when word miss=alien accessad s
Stop when received fail zafe from peripheral ies
Stop when occurred flash illzgal Mo

In the following property setting, select [Yes] to enable and [No] to disable the function from the drop-down list.
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All the properties are set to [Yes] by default (with some exceptions).
- [Stop when fetched from fetch protected area]

- [Stop when wrote to write protected area]

- [Stop when read from read protected SFR]

- [Stop when wrote to write protected SFR]

- [Stop when overflowed user stack]Nt

- [Stop when underflowed user stack]N°t®

- [Stop when operated uninitialized stack pointer]
- [Stop when read from uninitialized RAM]

- [Stop when accessed to hon-mapping area]

- [Stop when word miss-align accessed]

- [Stop when received fail safe from peripheral]

- [Stop when occurred flash illegal]

Note [No] is selected by default.
To set to [Yes], the [User stack section] property on the bottom must be set to the address of the user
stack section (default: [.stack _bss]).

2.8.7 Other break causes

The cause of the break other than the described above is as follows:
You can confirm the break cause with the Status message on the statusbar in the Main window.

Table 2.6 Other Break Causes

Break Cause Debug Tool to Use
IECUBE E1/E20/ E2 Simulator
EZ Emulator/
COM Port

Full of the trace memoryN°te 1 v - - 7

An occurrence of Trace Delay Break s - - -
Execution time-over detected Vs - - -

An access to non-mapped area v - - e

A writing to write-protected area v - - v

An access to the odd number address by the word v - - e
width

An occurrence of Temporary BreakNot® 2 7 7 v 7

An occurrence of Flash lllegal Break s - - -
lllegal action of program related to the peripheral chip e - - -
functionNote 3

Failure to execute/uncertain cause Vs Ve vy -

Full of the current consumption bufferNot 4 - - - 7

E2 expansion function - - « -
Fully used the storage memory - - vy -

Note 1. The operation depends on the setting of the [Operation after trace memory is full] property in the [Trace]
category on the [Debug Tool Settings] tab of the Property panel.
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Note 2.
Note 3.
Note 4.

A break that is internally used by CS+. (Users cannot use it.)

See the documentation on peripheral emulation board to use.

The operation is supported only by the simulator that supports the current consumption measurement.

2.9 Display/Change the Memory, Register and Variable

This section describes how to display/change the memory, register and variable.

2.9.1 Display/change the memory

The contents of the memory can be displayed and its values can be changed in the Memory panel below.
Select the [View] menu >> [Memory] >> [Memoryl - 4].
The maximum of 4 Memory panels can be opened. Each panel is identified by the names "Memory1", "Memory2",
"Memory3" and "Memory4" on the titlebar.
For details on the contents and function in each area, see the section for the Memory panel.

Figure 2.47 Display the Contents of Memory (Memory Panel)

Memory i

Z| @ | Notation- | Size Notation- | Encoding-  View -

|
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| Move |

[ HI 41 +F 43 +4 45 +5 47 #5 43 48 b #ONLeear T AOPTP
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0070 | 02 0 FC A7 |03 00 FC D1 (01 00 FC FI (0T Do S Tee s T T 1T
00740 | 07 GF BB D517 44 14 00(DE 07 FC EZ (01 00 &7 EF T el a4
007=0 | F3 C& D7 CF|F6 06 17 44|04 00 DE 03 (A7 EF F7 CR T DT
TOIF0 07 CF FB 18] 17 44 04 00 |DE 07 FC 0F (02 00 &7 EF Tl T Tua . T
gozon | F3 oE 09 % FE 18 17 440G 00 LE 03 |AT EF F7 CE T DTS
gozin | 07 & 77 FC 43 02 OD)FC 32 02 00|FC 4E 02 00 Tl Tl T2 THa
00220 F5 FO02 FS|79 00 U7 71|78 Fa FC 11]02 00 71 TA .0 1a9{01.. 0z
00230 | FA D7 F5 ADIFF 71 74 AT|71 4B 4 71|64 41 OF F3 TITITazgh Tl 1YY <
| | | 1 I 'l | |
@) @ ®)

(1): Address area

(2): Memory value area

(3): Character strings area

Remark

You can set the scroll range (as start and end address) of the vertical scroll bar on this panel via the
Scroll Range Settings dialog box that is opened by clicking the button from [View] on the toolbar.

This section describes the following.

2911
29.1.2
29.13
2914
29.15
29.16
29.17

Specify the display position
Change display format of values
Modify the memory contents
Display/modify the memory contents during program execution
Search the memory contents
Modify the memory contents in batch (initialize)

Save the memory contents

2.9.1.1 Specify the display position

It is possible to specify the display start position of the memory contents by specifying an address expression in the dis-

play position specification area (starting with address 0x0 by default).

Remark

An offset value of the display start position of memory values can be set via the Address Offset Settings
dialog box that is opened by selecting [Address Offset Value Settings...] from the context menu.
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Figure 2.48 Display Position Specification Area (Memory Panel)

7] Mawe when Siop

(1) Specify an address expression

Lo |

Directly enter the address expression of the memory value address to display in the text box. You can specify an
input expression with up to 1024 characters. The result of the expression is treated as the display start position

address.

Note that if an address value greater than the microcontroller address space is specified, the high-order address

value is masked.

An address value greater than the value expressed within 32 bits cannot be specified.

Remark 1. A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in this text box (see "2.19.2 Symbol name completion function").

Remark 2. If the specified address expression is the symbol and its size can be recognized, everything from
the start address to the end address of that symbol is displayed selected.

(2) Specify automatic/manual evaluation of the address expression
The timing to change the display start position can be determined by specifying in the [Move when Stop] check

box and the [Move] button.

[Move when Stop]

The caret is moved to the address which is automatically calculated from the
address expression after the program is stopped.

(]

The address expression is not automatically evaluated after the program is stopped.
Click the [Move] button to manually evaluate the address expression.

[Move]

When the [Move when Stop] check box is not checked, click this button to evaluate
the address expression and move the caret to the result address of the evaluation.

2.9.1.2 Change display format of values

The display format of the address area/memory value area/character strings area can be changed using buttons below

on the toolbar.

Notation

The following buttons to change the notation of memory values are displayed.

Hexadecimal

Displays memory values in hexadecimal number (default).

Signed Decimal

Displays memory values in signed decimal number.

Unsigned Decimal

Displays memory values in unsigned decimal number.

E Octal

Displays memory values in octal number.

Binary

Displays memory values in binary number.

Size Notation

The following buttons to change the notation of sizes of memory values are dis-
played.

4 Bits

Displays memory values in 4-bit width.

1 Byte

Displays memory values in 8-bit width (default).

2 Bytes

Displays memory values in 16-bit width.
Values are converted depending on the endian of the target memory area.

[2] 4 Bytes

Displays memory values in 32-bit width.
Values are converted depending on the endian of the target memory area.

8 Bytes

Displays memory values in 64-bit width.
Values are converted depending on the endian of the target memory area.

Encoding

The following buttons to change the encoding of character strings are displayed.
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ASCII Displays character strings in ASCII code (default).

| Shift_JIS Displays character strings in Shift_JIS code.

EUC-JP Displays character strings in EUC-JP code.

7| UTF-8 Displays character strings in UTF-8 code.

[“El| UTF-16 Displays character strings in UTF-16 code.

Half-Precision Float Displays character strings as a half-precision floating-point value.

riel| Float Displays character strings as a single-precision floating-point valueN°t.

Double Displays character strings as a double-precision floating-point valueNote,

Float Complex Displays character strings as a complex number of single-precision floating-
pointNote,

Double Complex Displays character strings as a complex number of double-precision floating-
pointNote,

Float Imaginary Displays character strings as an imaginary number of single-precision floating-
pointNote,

Double Imaginary Displays character strings as an imaginary number of double-precision floating-
pointNote,

View The following buttons to change the display format are displayed.

Settings Scroll Range... Opens the Scroll Range Settings dialog box to set the scroll range for this panel.

Column Number Settings... Opens the Column Number Settings dialog box to set the number of view col-
umns in the memory value area.

Address Offset Value Settings... | Opens the Address Offset Settings dialog box to set an offset value for
addresses displayed in the address area.

Note For details on the display of a floating-point value, see the section for the Memory panel.

2.9.1.3 Modify the memory contents

The memory values can be edited.

Directly edit from the keyboard after moving the caret to the line to modify in memory value area/characters area.

The color of the memory value changes when it is in editing. Press the [Enter] key to write the edited value to the target
memory (if the [Esc] key is pressed before the [Enter] key is pressed, the editing is cancelled).

However, the character string that can be inputted during the editing is limited to that character string that can be han-
dled by the display notation that has been currently specified. In the character strings area, modification can only be made
with "ASCII" character code.

This operation can be taken place while the program is in execution. See "2.9.1.4 Display/modify the memory contents
during program execution” for details on how to operate it.

When you modify the values, be aware of the following examples.

Example 1.  The value exceeds the upper limit of the display bit wide
If you edit the display value "105" as "1" to "3" in the decimal 8-bit display, the value will be changed to
the upper limit of "127".

Example 2.  The symbol, "-" is entered between numbers
If you edit the display value "32768" as "32-68" with signed decimal 16-bit display, "3" and "2" are
changed to the blank and the value is changed to "-68".

Example 3.  The blank symbol (space) is entered between numbers
If you edit the display value "32767" as "32 67", "3" and "2" are changed to the blank and the value is
changed to "67".
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Example 4. The same value is entered
Even if the same value as the current memory value is specified, the specified value is written to the
memory.

2.9.1.4 Display/modify the memory contents during program execution

The Memory panel/Watch panel has the real-time display update function that can update/modify the display contents of
the memory/watch-expression in real-time while executing the program.

Using the real-time display update function allows you to display/modify the value of memory/watch-expression not only
while the program is stopped, but also in execution.

The real-time display update function is realized by the RRM function (reading) [IECUBE][Simulator], a RAM monitor
function (reading) (other than [Simulator]) or by the DMM function (modifying). Each function has a different area that can
be used for reading and writing.

Firstly, enable the real-time display update function by making the basic settings below on the [Debug Tool Settings] tab
of the Property panel.

Table 2.7 Basic Settings for Real-time Display Update Function

Category Property Set Value
[Access memory while running] [Update display during the execution] [Yes] (default)
[Display update interval[ms]] except [COM Port]

[Integer number between 100 and
65500]
[COM Port]
[Integer number between 5000 and
65500]

Caution Local variables are not subject to the real-time display update function.

Remark See "2.9.1.3 Modify the memory contents” or "2.9.6.6 Modify the contents of watch-expressions" for

details on how to modify values in the Memory panel/Watch panel.

(1) RRM function (reading) [IECUBE][Simulator]
This function is used to read the contents of the memory or of watch-expressions in real-time during execution of a
program.
The following area can be read by the RRM function.
Memory and watch-expressions allocated to this area can always be displayed in real-time.

Table 2.8 Target Area of RMM Function

Area IECUBE Simulator

Internal ROM o Noel v
Internal RAM (except register area) e v
Data flash e -
Emulation memory - v
Target memory - v
CPU register s Noe2 - Note 3
SER _ v Note 3

Note 1. This refers to data that were in the cache before execution, to the values are not real-time.

Note 2. Possible only for general-purpose registers and PC

Note 3. Impossible during tracer/timer execution

(2) RAM monitor function (reading) (other than [Simulator])
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This function is used to read the contents of memory or a watch-expression through software emulation by briefly

halting the program.

The following area can be read by the RAM monitor function.

Caution If CPU status shifts to the standby mode (HALT/STOP/IDLE) mode, a monitor time-out error will
occur.
Table 2.9 Target Area of RAM Monitor Function
Area IECUBE E1/E20/EZ Emulator/COM Port
Internal ROM -Note 1 -
Internal RAM (except register area) -Note 1 7
Data flash -Note 1 v
Emulation memory - -
Target memory e -
CPU register 7 o Note2
SFR 7 v Note 3
Note 1. When it is available, priority is given to the RRM function. That is, the RAM monitor function is not
used in such cases.
Note 2. This only applies to the general-purpose registers corresponding to the bank specification.
Note 3. This does not apply to BCDADJ.

Note that to enable the RAM monitor function, the setting below is required in addition to the Basic Settings for

Real-time Display Update Function.

Category

Property

Set Value

[Access memory while running]

[Access by stopping execution]

[Yes]

(3) DMM function (modifying)

This function is used to write to the memory or watch-expressions in real-time during execution of a program.
The following area can be modified by the DMM function.

Caution
occur.

Table 2.10 Target Area of DMM Function

If CPU status shifts to the standby mode (HALT/STOP/IDLE) mode, a monitor time-out error will

Area IECUBE E1/E20/EZ Emulator/ Simulator
COM Port
Internal ROM - - i
Internal RAM (except register area) A A i
Emulation memory - - i
Target memory A - i
CPU register A ANet (yNote 2
SFR A I‘Note 3 I::lNOte 2
ik Possible by briefly halting execution
i Possible without briefly halting execution
Note 1. This only applies to the general-purpose registers corresponding to the bank specification.
Note 2. Impossible during tracer/timer execution
Note 3. Possible only for standard SFRs
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To enable the DMM function, the setting below is required in addition to the Basic Settings for Real-time Display

Update Function.

Debug Tool Property Set Value
Simulator No setting is required.
Other than above | [Access memory while running] category [Yes]
>> [Access by stopping execution]
Caution When a 2-, 4-, or 8-byte variable is to be read through the RRM or RAM monitor function, the process of

assigning a value to the variable may be divided into two steps.

If reading of the variable takes place between the two steps, an incorrect value may be read out because

the assignment is not completed.
Example)

In the following example, if reading takes place before "(2)" is executed, the value of variable "value_a" in
which only the assignment to the two lower-order bytes has been completed is read out.

[C source text]

long int value_a = 0; // Definition of a 4-byte variable
void func(void)
{

value_a = 4000000000; // Assignment to a 4-byte variable
}

[Assembly instructions for the assignment processing above]

MOVW AX, #2800H

MOVW 1 value_a, AX ; (D: Assigment to the wo loner-order bytes of variable
"“Value a*

MOVW AX, #OEEG6BH

MOvwW 1 _value_a+2, AX ;(@: Assigment to the o high-order bytes of variable
"Value &'

On the Memory panel/Watch panel, the memory values/watch-expressions updated by the real-time display update

function are highlighted in pink.

Figure 2.49 Example of Memory Display by Real-time Display Update Function
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Moreover, on the Memory panel using IECUBE, the background color of the memory values updated by the RRM func-

tion are highlighted as follows in accordance with the access status (character colors and background colors depend on

the configuration in the [General - Font and Color] category of the Option dialog box).

Access Condition Display Example
Read 00 00 00
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Access Condition

Display Example

Write

00 00 00

Read and

write

00 00 00

Figure 2.50 Example of Memory Display by Real-time Display Update Function (RRM Function) [IECUBE]
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2.9.1.5 Search the memory contents

Values of memory can be searched in the Memory Search dialog box that is opened by selecting [Find...] from the con-
text menu. The search is operated either in the memory value area or character strings area, in which the caret exists. In
this dialog box, follow the steps below.

Figure 2.51 Search Memory Contents (Memory Search Dialog Box)

Memory Search
Search Datz

Sesrch Baree  Specify addeess ranes

Address el [w| = e | =
| Cancel | | Help |
Caution 1.  The contents of the memory cannot be searched during execution of a program.
Caution 2.  Character strings displayed as floating-point values cannot be searched.

(1) Specify [Search Data]
Specify data to search.
You can either type a value directly into the text box (up to 256 bytes), or select one from the input history via the
drop-down list (up to 10 items).
If the search is performed in the memory value area, the value must be entered in the same display format (nota-
tion and size) as that area.
If the search is performed in the character strings area, then the target of the search must be a string. The speci-

fied string is converted into the encoding format displayed in that area, and searched for.

If a memory value was selected immediately prior to opening this dialog box, then that value will appear as default.

(2) Specify [Search Range]
Select the range to search from the following drop-down list.
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(4)

Specify address range Searches in the address range specified in the [Address] area.

Memory mapping Searches within the selected memory mapping range.
This list item displays individual memory mapping configured in the Memory Map-
ping dialog box (except the non-mapped area).

Display format: <memory type> <address range> <size>

Specify [Address]

This item is only enabled if [Specify address range] is selected in the (2) Specify [Search Rangel].

Specify the range of memory address to search via the start and end addresses. You can either type address
expressions directly into the text boxes (up to 1024 characters), or select them from the input history via the drop-
down list (up to 10 items).

The results of calculating the address expressions you have entered are treated as start and end addresses,
respectively.

Note that if an address value greater than the microcontroller address space is specified, the high-order address
value is masked.

An address value greater than the value expressed within 32 bits cannot be specified.

Remark 1. A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in each text box (see "2.19.2 Symbol name completion function™).

Remark 2. If the start address field is left blank, it is treated as if "Ox0" were specified.

Remark 3. If the end address field is left blank, then it is treated as if the maximum value in the microcon-

troller's address space were specified.

Click the [Search Backward]/[Search Forward] button

When the [Search Backward] button is clicked, search will start in the order from the large address number to
small and the search results are displayed selected in the Memory panel.

When the [Search Forward] button is clicked, search will start in the order from the small address number to small
and the search results are displayed selected in the Memory panel.

2. FUNCTIONS

2.9.1.6 Modify the memory contents in batch (initialize)

Contents of the memory can be modified in batch (initialize).

When [Fill...] from the context menu is selected, the Memory Initialize dialog box opens to modify the memory value of

the specified address range in batch.
In this dialog box, follow the steps below.

Figure 2.52 Modify Memory Contents in Batch (Memory Initialize Dialog Box)

Memory Initialize

Siart address/symbal: End address symbol:

the end address or 2

oF

Lhput

|T| =

=5

[nitialize data:
wes [ Imput the initial data n bexadecimal bhere. The teo or more data HE
[ Cizncel | | Help ]
(1) Specify [Start address/symbol] and [End address/symbol]

Specify the range of memory address to initialize via the [Start address/symbol] and [End address/symbol]. You
can either type address expressions directly into the text boxes (up to 1024 characters), or select them from the

input history via the drop-down list (up to 10 items).

The results of calculating the address expressions you have entered are treated as start and end addresses,

respectively.

Note that address values greater than the microcontroller address space cannot be specified.

Caution

Remark

You cannot specify the range of address aligned across the different endian area.

A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]

key in each text box (see "2.19.2 Symbol name completion function™).

(2) Specify [Initialize data]
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Specify the initializing data to write to the memory.

You can either type the initial value into the text box directly in hexadecimal number, or select one from the input
history via the drop-down list (up to10 items).

You can specify more than one initial value. Specify up to 16 values of up to 4 bytes (8 characters) each, sepa-
rated by spaces.

Each initial value is parsed from the end of the string, with each two characters interpreted as a byte.

If the string has an odd number of characters, then the first character is interpreted as one byte.

Note that if a initial value consists of more than one byte, then the target memory is overwritten with the value con-
verted into an array of bytes of the specified address range's endian, as follows.

Input Character Strings How Data is Overwritten (in Bytes)
(Initial Value) - , . .
Little Endian Big Endian
1 01 01
012 00 12 00 12
00 012 345 00 12 00 45 03 0000 12 03 45
000 12 000345 00 00 12 45 03 00 00 00 12 00 03 45

(3) Click the [OK] button
Click the [OK] button.
The memory area in the specified address range is repeatedly overwritten with the specified initial data pattern. If
the end address is reached in the middle of the pattern, then writing ends at that point.
Note that if an illegal value is specified, a message will appear, and the memory value will not be initialized.

2.9.1.7 Save the memory contents

Contents of the memory can be saved with range selection in text files (*.txt)/CSV files (*.csv).

When saving to the file, the latest information is acquired from the debug tool, and it is saved in accordance with the dis-
play format on this panel.

The Data Save dialog box can be opened by selecting the [File] menu >> [Save Memory Data As...] (when this opera-
tion is taken place with range selection on the panel, the memory data only in the selected range is saved).

In this dialog box, follow the steps below.

Figure 2.53 Save Memory Data (Data Save Dialog Box)
Data Save - Memory Data .,

File Mame: | ZEITRAI x

File Typer | Teut files{* tat)
Save Raree Address Swmbal:

000000160 [=] - Dx000OD22f -

[ Sawe |: Cancel ] Hela

(1) Specify [File Name]
Specify the name of the file to save.
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history
via the drop-down list (up to 10 items).
You can also specify the file by clicking the [...] button, and selecting a file via the Select Data Save File dialog box.

(2) Specify [File Type]
Select the format in which to save the file from the following drop-down list.
The following file formats can be selected.
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List Item Format
Text files (*.txt) Text format (default)
CSV (Comma-Separated Variables)(*.csv) CSV formatNote
Note The data is saved with entries separated by commas (,).
If the data contains commas, each entry is surrounded by double quotes " in order to avoid illegal
formatting.

(3) Specify [Save Range Address/Symbol]
Specify the range of addresses to save via "start address" and "end addresses".
Directly enter hexadecimal number/address expression in each text box or select from the input history displayed
in the drop-down list (up to 10 items).
If a range is selected in the panel, that range is specified as the default. If there is no selection, then the range
currently visible in the panel is specified.

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in each text box (see "2.19.2 Symbol name completion function™).

(4) Click the [Save] button

Saves the memory data to a file with the specified filename, in the specified format.
Figure 2.54 Output Example of Memory Data
- [Text files (*.txt)] (Hexadecimal notation/8-bit width/ASCII code)

+0 +1 +2 +3 +4 +5 +6 +7 +8 +9 +a +b +c +d +e +F
0000 | 00 00 00 00 00O OO0 00O OO0 OO 00 OO OO 00 00 00 00 |
0010 | 11 12 1171 11 21 221 12 11 11 11 211 11 11 11 11 11 |

- [CSV files (*.csv)] (Hexadecimal notation/8-bit width/ASCII code)

0000, 00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,
ooio,11,11,122,12,112,11,21,22,12,12,11,21,121,11,11,11,

Remark When the contents of the panel are overwritten by selecting the [File] menu>> [Save Memory Data],
each Memory panel (Memory1-4) is treated as a different panel.
In addition, saving range is same as the previously specified address range.

2.9.2 Display/change the CPU register

The contents of the CPU register (general-purpose register/control register) can be shown and the value can be
changed in the CPU Register panel below.

Select the [View] menu >> [CPU Register].

For details on the contents and function in each area, see the section for the CPU Register panel.

Figure 2.55 Display the Contents of CPU Register (CPU Register Panel)

GPU Register =
#] | MNotation - | e
Aezizier Mone Yalue * |

== Genersl Regizters
7™ Conkrol Registers
=0 General RegistersiRezisier Bank 0

7 ] BXCRPO ) RED 0=0009
7 £] ECCRPI ):RED 0=0000
7 £] DE{FPZ ):RED lzefcd
7 E] HL{FP3 }:RED D=0 0
+17 General RegistersiRegisier Bank | -
1 | 1 | T
(1) 2)
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(1): [Register Name] area
(2): [Value] area

This section describes the following.
2.9.2.1 Change display format of values
2.9.2.2 Modify the CPU register contents

2.9.2.3 Display/modify the CPU register contents during program execution
2.9.2.4 Save the CPU register contents

2.9.2.1 Change display format of values

The display format of the [value] area can be changed using buttons below on the toolbar.

Notation The following buttons to change the notation of a data value are displayed.
ﬂ AutoSelect Displays the value of the selected item (including sub-items) in the default notation
(default).
. Hexadecimal Displays the value of the selected item (including sub-items) in hexadecimal number.
Signed Decimal Displays the value of the selected item (including sub-items) in signed decimal number.

Unsigned Decimal | Displays the value of the selected item (including sub-items) in unsigned decimal number.

E Octal Displays the value of the selected item (including sub-items) in octal number.
Binary Displays the value of the selected item (including sub-items) in binary number.
ASCII Displays the character strings of the selected item (including sub-items) in ASCII code.

If the character size is 2 bytes and above, it is displayed with the characters for each 1
byte arranged side-by-side.

. Float Displays the value of the selected item in Float.
Note that when the value is not 4-byte data, displays it in the default notation.

. Double Displays the value of the selected item in Double.
Note that when the value is not 8-byte data, displays it in the default notation.

Adds the value in hexadecimal number enclosing with "()" at the end of the value.

2.9.2.2 Modify the CPU register contents

The CPU register values can be edited.

Select the value of the CPU register to edit in the [Value] area, then click on it again to switch the value to edit mode
(press the [Esc] key to cancel the edit mode).

To write the edited value to the target memory, directly enter the value from the keyboard then press the [Enter] key.

Caution This operation cannot be performed during program execution.

2.9.2.3 Display/modify the CPU register contents during program execution

By registering a CPU register to the Watch panel as a watch-expression, the value of the CPU register can be dis-
played/modified not only while the program is stopped, but in execution.
See "2.9.6 Display/change watch-expressions" for details on the watch-expression.

2.9.2.4 Save the CPU register contents

The Save As dialog box can be opened by selecting the [File] menu >> [Save CPU Register Data As...], and all the con-
tents in the CPU register can be saved to a text file (*.txt) or CSV file (*.csv).
When saving to files, retrieve the latest information from the debug tool.
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Figure 2.56 Output Example of CPU Register Data

Register name Value

Category name
-Register name Value

R20UT4857EJ0100 Rev.1.00 RENESAS Page 65 of 391
Nov 01, 2020



CS+Vv8.05.00

2. FUNCTIONS

2.9.3 Display/change the SFR

Contents of the SFR can be displayed and its values can be changed in the SFR panel below.

Select the [View] menu >> [SFR].
For details on the contents and function in each area, see the section for the SFR panel.

Figure 2.57 Display the Contents of SFR (SFR Panel)

(1): [SFR] area

(2): [Value] area

(3): [Type (Byte Size)] area
(4): [Address] area

This section describes the following.

2931
2.9.3.2
2933
2935
2935
2.9.3.6

Search for a SFR
Organize SFRs

Change display format of values
Display/modify the SFR contents during program execution
Display/modify the SFR contents during program execution
Save the SFR contents

2.9.3.1 Search for a SFR

A SFR can be searched for.
Specify the SFR name to search with the text box in the search area (case-insensitive). You can either type character
strings directly from the key board (up to 512 characters), or select one from the input history via the drop-down list (up to
10 items).

Then, click either one of the following button.

5FR 3]
7 Toolbar
2 | & | (] > | Notation-
T
[Imput all ar pard of the target SFRACateory “JM T T*]
SFR Yalue TypelBwle Size) dddresz =
B F 000 SFR RS 181010 A FF0N
= 000 SFR RS 1.B101D DA FF010
B F 000 SFR RS 1.B101D Def FFO2
5 F 000 SFR RS 1.B101D DA FFO3
P4 000 SFR RS 1.B101D DA ffid
B 000 SFR RS 1.B101D DA FFOR
EFs 000 SFR RS 1.B101D DA FfOR =
| T : T | T | ]
(1) 2 ©)) 4)

is found.

Searches up for the SFR name containing the string specified in the text box, and selects the SFR that

that is found.

Searches down for the SFR name containing the string specified in the text box, and selects the SFR

Remark 1.

Remark 2.

The hidden SFR name being classified with a category can be searched (the category is opened and the

SFR is selected).

After typing character strings to search, to press the [Enter] key is the same function as clicking the
button, and to press the [Shift] + [Enter] key is the same function as clicking the button.

2.9.3.2 Organize SFRs

The each SFR can be categorized (by folders) and displayed in the tree view.
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Caution 1.  Categories cannot be created within categories.
Caution 2.  SFRs cannot be added or deleted.

(1) Create new category
Move the caret to the SFR name to create a new category then click the button in the toolbar and directly
enter the new category name.

(2) Edit category name
Click the category name to edit, and click it again, then directly modify the category name from the keyboard.

(3) Delete categories
Select categories to delete then click the button in the toolbar.
However, the categories that can be deleted are only the empty categories.

(4) Change the display order
SFR name is categorized when SFR is dragged and dropped in the category.
Also, the display order of the categories and the SFR names (upper or lower position) can be changed easily by
drag and drop operation.

2.9.3.3 Change display format of values

The display format of the [value] area can be changed using buttons below on the toolbar.

Notation The following buttons to change the notation of a data value are displayed.
. Hexadecimal Displays the value of the selected item in hexadecimal number (default).
Signed Decimal Displays the value of the selected item in signed decimal number.

Unsigned Decimal | Displays the value of the selected item in unsigned decimal number.

Octal Displays the value of the selected item in octal number.
Binary Displays the value of the selected item in binary number.
ASCII Displays the value of the selected item in ASCII code.
Adds the value in hexadecimal number enclosing with "()" at the end of the value of the

selected item.

2.9.3.4 Modify the SFR contents

The SFR values can be edited.

Select the value of the SFR to edit in the [Value] area, then click on it again to switch the value to edit mode (press the
[Esc] key to cancel the edit mode).

To write the edited value to the target memory, directly enter the value from the keyboard then press the [Enter] key.

Caution 1.  This operation cannot be performed during program execution.
Caution 2.  The value of the read-only SFR cannot be edited.

Remark 1. If a number with fewer digits than the size of the SFR is entered, the higher-order digits will be padded
with zeroes.

Remark 2. If a number with more digits than the size of the SFR is entered, the higher-order digits will be masked.
Remark 3. ASCII characters can be entered to the SFR value.

- When the numeric "0x41" is written to the SFR "DMC0"
>>"0x41" is written in the port "DMCO0".

- When the ASCII character "A™ is written to the SFR "DMCO0"
>>"0x41" is written in the port "DMCOQ".

2.9.3.5 Display/modify the SFR contents during program execution

By registering a SFR to the Watch panel as a watch-expression, the value of the SFR can be displayed/modified not
only while the program is stopped, but in execution.
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See "2.9.6 Display/change watch-expressions" for details on the watch-expression.

2.9.3.6 Save the SFR contents

The Save As dialog box can be opened by selecting the [File] menu >> [Save SFR Data As...], and all the contents of
the SFR can be saved in a text file (*.txt) or CSV file (*.csv). At this time, the values of all SFRs become targets irrespec-
tive of the setting of display/non-display on this panel.

When saving the contents to the file, the values of the SFR are reacquired and save the latest values acquired.

Note that the values of read-protected SFR are not re-read. If you want to save the latest values of those, select [Force
Read Value] from the context menu then save the file.

Figure 2.58 Output Example of SFR

SFR name Value Type (Byte Size) Address

Category name
-SFR name Value Type (Byte Size) Address

2.9.4 Display/change global variables/static variables

Global variables or static variables are displayed and its values can be changed in the Watch panel.
Register the variables to display/modify their values to the Watch panel as the watch-expressions.
For details, see "2.9.6 Display/change watch-expressions".

2.9.5 Display/change local variables

Contents of local variables can be displayed and its values can be changed in the Local Variables panel below.

Select the [View] menu >> [Local Variable].

Specify the scope in the scope area to display the contents of the target local variable.

In the Local Variables panel, the name of local variables and functions are displayed. The argument of the function is
also displayed as the local variable.

For details on the contents and function in each area, see the section for the Local Variables panel.

Figure 2.59 Display the Contents of Local Variables (Local Variables Panel)

Local Variables ]

(&] | Motation - %  Encoding -
o T

Maree Yalue Tvpe(Bde Size) Address
v dnreg ' ; 2
o ouk reg 0w lgned inb{2) Dzffedd

[ I
@ @) 3 4
(1): [Name] area
(2): [Value] area
(3): [Type (Byte Size)] area
(4): [Address] area

Caution Nothing is displayed on this panel during execution of a program.
When the program is stopped, items in each area are displayed.

This section describes the following.

2.9.5.1 Change display format of values
2.9.5.2 Modify the contents of local variables
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2.9.5.3 Save the contents of local variables

2.9.5.1 Change display format of values

The display format of the [value] area can be changed using buttons below on the toolbar.

Notation

The following buttons to change the notation of a data value are dis-
played.

ﬁ AutoSelect

Displays values on this panel in the default notation according to the
type of variable (default).

. Hexadecimal

Displays values on this panel in hexadecimal number.

. Decimal

Displays values on this panel in decimal number.

H Octal

Displays values on this panel in octal number.

Binary

Displays values on this panel in binary number.

Decimal Notation for Array Index

Displays array indexes on this panel in decimal number (default).

Hexadecimal Notation for Array Index

Displays array indexes on this panel in hexadecimal number.

H Float

Displays values on this panel in Float.

Note that when the value is not 4-byte data, or has the type informa-
tion, displays it in the default notation.

. Double

Displays values on this panel in Double.
Note that when the value is not 4-byte data, or has the type informa-
tion, displays it in the default notation.

Adds the value in hexadecimal number enclosing with "()" at the end
of the value.

Encoding

The following buttons to change the encoding of character variables
are displayed.

=] ASCII

Displays character variables in ASCII code (default).

Shift_JIS

Displays character variables in Shift_JIS code.

[esl] EUC-IP

Displays character variables in EUC-JP code.

[ uTF-8

Displays character variables in UTF-8 code.

[l UTF-16

Displays character variables in UTF-16 code.

2.9.5.2 Modify the contents of local variables

Values and arguments of local variables can be edited.

Select the value of the local variables/arguments to edit in the [Value] area, then click on it again to switch the value to
edit mode (press the [Esc] key to cancel the edit mode).

To write the edited value to the target memory, directly enter the value from the keyboard then press the [Enter] key. At
this time, the edited value is checked and if it is incompatible with the type, the editing is invalidated.

Caution

Remark 1.

Remark 2.

Remark 3.

Remark 4.

This operation cannot be performed during program execution.

If a number with fewer digits than the size of the variable is entered, the higher-order digits will be padded
with zeroes.

If a number with more digits than the size of the variable is entered, the higher-order digits will be
masked.

If the display format of a character array (type char or unsigned char) is set to ASCII, then the value can
also be entered as a string (ASCII/Shift_JIS/EUC-JP/Unicode (UTF-8/UTF-16)).

ASCII characters can be entered to values of local variables.

R20UT4857EJ0100 Rev.1.00

Nov 01, 2020

RENESAS Page 69 of 391



CS+Vv8.05.00 2. FUNCTIONS

- Entering via an ASCII character
In the [Value] area for the variable "ch", enter "A™
>>"0x41" will be written to the memory area allocated to "ch"

- Entering via a numeric value
In the [Value] area for the variable "ch", enter "0x41"
>>"0x41" will be written to the memory area allocated to "ch"

- Entering via an ASCII string
Set the display format of character array "str" to ASCII, and in the [Value] area, enter ""ABC™""
>>"0x41, 0x42, 0x43, 0x00" will be written to the memory area allocated to "str"

2.9.5.3 Save the contents of local variables

The Save As dialog box can be opened by selecting the [File] menu >> [Save Local Variables Data As...], and all the
contents in the local variables can be saved in a text file (*.txt) or CSV file (*.csv).

When saving to files, retrieve the latest information from the debug tool. If arrays, pointer type variables, structures/
unions, and CPU registers (only those with the part name) are displayed expanded, the value of each expanded element
is also saved. When they are not expanded, "+" mark is added on the top of the item and the value becomes blank.

Figure 2.60 Output Example of Local Variables

Scope : Current scope
[V]variable [P]Parameter [F]Function

Name Value Type (Byte Size) Address
[V]lVariable name[1] Value Type Address

- [V1lvariable name[O] Value Type Address

2.9.6 Display/change watch-expressions

By registering C language variables, CPU register, SFR, and assembler symbols to the Watch panel as watch-expres-
sions, you can always retrieve their values from the debug tool and monitor the values in batch.

The values of watch-expressions can be updated during the program is in execution (see "2.9.6.7 Display/modify the
contents of watch-expressions during program execution”).

Select the [View] menu >> [Watch] >> [Watchl - 4] to open the Watch panel.

The Watch panel can be opened up to 4 panels. Each panel is identified by the names "Watch1", "Watch2", "Watch3"
and "Watch4" on the titlebar, and the watch-expressions can be registered/deleted/moved individually, and they are saved
as the user information of the project.

For details on the contents and function in each area, see the section for the Watch panel.

Figure 2.61 Display the Contents of Watch-Expression (Watch Panel)
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(2): [Watch] area

(2): [Value] area

(3): [Type (Byte Size)] area
(4): [Address] area
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(5): [Memo] area
This section describes the following.

2.9.6.1 Register a watch-expression

2.9.6.2 Organize the registered watch-expressions

2.9.6.3 Edit the registered watch-expressions

2.9.6.4 Delete a watch-expression

2.9.6.5 Change display format of values

2.9.6.6 Modify the contents of watch-expressions

2.9.6.7 Display/modify the contents of watch-expressions during program execution
2.9.6.8 Export/import watch-expressions

2.9.6.9 Save the contents of watch-expressions

2.9.6.1 Register a watch-expression

There are three ways as follows to register watch-expressions (watch-expressions are not registered as default).

Remark 1. Each watch-expression registered in each watch panel (Watchl to Watch4) is managed in each panel
and saved as the user information of the project.

Remark 2. More than one watch-expression with the same name can be registered.

(1) Register from other panels
Watch-expressions can be registered from other panel in CS+.
In other panel, drag and drop the watch-expression to register in any watch panel (Watchl to Watch4).
For the relationship between panels that can use this operation and targets that can be registered as watch-
expressions, see "Table A.4 Relationship between Panels and Targets That Can be Registered as Watch-Expres-
sions".

Figure 2.62 Registering Watch-Expressions from Other Panels

Dha_meublel |
2 [80]

Here, the variable "datal" in the Disassemble panel
will be registered as a watch-expression.

Drag and drop on the Watch panel after selecting
the variable "datal"” in the Disassemble panel. —
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Remark You can also add a watch-expression by doing the following. First, select the target for which you

wish to register a watch-expression, or move the caret to one of the target strings (the target is
determined automatically). Next, from the context menu, select [Register Watch1] (but this is limited
to the Watch panel (Watch 1)).

(2) Directly register in the Watch panel
Click the button in the toolbar in any the Watch panel (Watchl to Watch4) to display the following entry box in
the [Watch] area.

Figure 2.63 Entry Box of Watch-Expression
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Directly enter a watch-expression in this area.
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Directly input a watch-expression from the keyboard in the entry box then press the [Enter] key.
For the input forms of watch-expressions entered this way, see the tables listed below.

- "Table 2.28 Basic Input Format of Watch-expressions”

- "Table A.5 Handling of a C Language Function When Registered in Watch by Specifying Scope"
- "Table A.6 Handling of a C Language Variable When Registered in Watch by Specifying Scope"
- "Table A.7 Handling of a CPU Register When Registered in Watch by Specifying Scope"

- "Table A.8 Handling of a SFR when Registered in Watch by Specifying Scope"

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in this area (see "2.19.2 Symbol name completion function™).

(3) Register from other application
Select the character strings of C language variables/CPU registers/SFR/assembler symbols from an external edi-
tor and drag and drop it in the Watch panel (Watch 1 to Watch 4).
The dropped character strings are registered as a watch-expression.

2.9.6.2 Organize the registered watch-expressions

Registered watch-expressions can be organized in categories (folders) and displayed in tree view (there is no category
as default).

Caution 1.  Categories cannot be created within categories.
Caution 2.  Up to 64 categories can be created in one watch panel (if this restriction is violated, a message appears).

(1) Create new category
Move the caret to the position to create a new category then click the button in the toolbar and directly enter
the new category name.

(2) Edit category name
Click the category name to edit, and click it again, then directly modify the category name from the keyboard.

(3) Delete categories
Select categories to delete then click the button in the toolbar.

(4) Change the display order
Registered watch-expressions are categorized when they are dragged and dropped in the category.
Also, the display order of the categories and the watch-expressions (upper or lower position) can be changed eas-
ily by drag and drop operation.

Remark Drag and drop the watch-expressions/categories in other watch panel (Watchl to Watch4) to copy them.

2.9.6.3 Edit the registered watch-expressions

Registered watch-expressions can be edited.

Double-click the watch-expression to edit to switch the watch-expression to edit mode (press the [Esc] key to cancel the
edit mode).

Directly edit from the keyboard and then press the [Enter] key.

2.9.6.4 Delete a watch-expression

To delete watch-expressions, select the one you want to delete in the Watch panel then click the button in the tool-
bar.

2.9.6.5 Change display format of values

The display format of the [value] area can be changed using buttons below on the toolbar.
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Notation

The following buttons to change the notation of a data value are displayed.

M AutoSelect

Displays the value of the selected watch-expression in the default notation (see "Table
A.9 Display Format of Watch-Expressions (Default)") according the type of variable
(default).

. Hexadecimal

Displays the value of the selected item in hexadecimal number.

Signed Decimal

Displays the value of the selected item in signed decimal number.

Unsigned Decimal

Displays the value of the selected item in unsigned decimal number.

Octal

Displays the value of the selected item in octal number.

Binary

Displays the value of the selected item in binary number.

Displays the value of the selected item in ASCII code.

ASCII
H Float

Displays the value of the selected item in Float.
Note that this item becomes valid only when the selected watch-expression value is 4-
byte data.

. Double

Displays the value of the selected item in Double.
Note that this item becomes valid only when the selected watch-expression value is 8-
byte data.

Adds the value in hexadecimal number enclosing with "()" at the end of the value of the
selected item (except the item displayed in hexadecimal number).

2.9.6.6 Modify the contents of watch-expressions

The values of watch-expressions can be edited.

Double-click the value of the watch-expression to edit in the [Value] area to switch the value to edit mode (press the
[Esc] key to cancel the edit mode).

To write the edited value to the target memory, directly enter the value from the keyboard then press the [Enter] key.

Note that only those values that correspond one by one to variables of C language, CPU registers, SFR or assembler
symbols can be edited. In addition, read-only SFR values cannot be edited.

This operation can be taken place while the program is in execution. See "2.9.1.4 Display/modify the memory contents
during program execution" for details on how to operate it.

Remark 1. If a number with fewer digits than the size of the variable is entered, the higher-order digits will be padded
with zeroes.

Remark 2. If a number with more digits than the size of the variable is entered, the higher-order digits will be
masked.

Remark 3. If the display format of a character array (type char or unsigned char) is set to ASCII, then the value can
also be entered as a string (ASCII/Shift_JIS/EUC-JP/Unicode (UTF-8/UTF-16)).

Remark 4. ASCII characters can be entered to values of watch-expressions.

- Entering via an ASCII character
In the [Value] area for the variable "ch", enter "A™
>>"0x41" will be written to the memory area allocated to "ch"

- Entering via a numeric value
In the [Value] area for the variable "ch", enter "0x41"
>>"0x41" will be written to the memory area allocated to "ch”

- Entering via an ASCII string
Set the display format of character array "str" to ASCII, and in the [Value] area, enter ""ABC™""
>>"0x41, 0x42, 0x43, 0x00" will be written to the memory area allocated to "str"

2.9.6.7 Display/modify the contents of watch-expressions during program execution

The Memory panel/Watch panel has the real-time display update function that can update/modify the display contents of
the memory/watch-expression in real-time while executing the program.

R20UT4857EJ0100 Rev.1.00 Page 73 of 391

Nov 01, 2020

RENESAS



CS+Vv8.05.00 2. FUNCTIONS

Using the real-time display update function allows you to display/modify the value of memory/watch-expression not only
while the program is stopped, but also in execution.
See "2.9.1.4 Display/modify the memory contents during program execution" for details on how to operate it.

2.9.6.8 Export/import watch-expressions

This feature is for the export of currently registered watch-expressions to a file and the importing of such files, enabling
the re-registration of watch-expressions.
To do this, follow the procedure described below.

(1) Export watch-expressions
Save watch-expressions currently being registered (including categories) in a file format that is possible to import.
With the Watch panel in focus, select [Save Watch Data As...] from the [File] menu.
On the Save As dialog box that is automatically opened, specify the following items, and then click the [Save] but-

ton.

- [File name]: Specify the name of a file to be saved (the file extension must be "csv").
- [Save as type]: Select "Importable CSV (Comma-Separated Variables)(*.csv)"

Caution Neither values nor the type information of watch-expressions can be saved.

Items that are expanded after analyzing watch-expressions (i.e. an array, structure, and so on) can-
not be saved.

Figure 2.64 Export of Watch-Expressions
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(2) Import watch-expressions
Import the file that exported in (1) to the Watch panel.
On the Watch panel to which you want to import watch-expressions, select [Import Watch Expression] from the
context menu.
On the Open Watch Expression Data File dialog box that is automatically opened, specify the file that exported
previously, and then click the [Open] button.

Remark If watch-expressions have been already registered, then imported watch-expressions will be regis-
tered at the bottom of them.
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Figure 2.65 Import of Watch-Expressions
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2.9.6.9 Save the contents of watch-expressions

By selecting the [File] menu >> [Save Watch Data As...] or selecting [Save Expanded Watch Data...] from the context
menu, the Save As dialog box can be opened, and all the contents of the watch-expression and its value can be saved in

a text file (*.txt) or CSV file (*.csv).

When saving the contents to the file, all the values of the watch-expression are reacquired and save the latest values

acquired.

Note that the values of read-protected SFR are not re-read. If you want to save the latest values of those, select [Force

Read Value] from the context menu then save the file.

Note that for watch-expressions that can be displayed expanded, such as arrays, pointer type variables, structures/
unions, and CPU registers (only those with the part name), the behavior differs depending on whether the watch-expres-

sion is saved with [Save Watch Data As...] or [Save Expanded Watch Data...].

- When saved with [Save Watch Data As...]

If arrays, pointer type variables, structures/unions, and CPU registers (only those with the part name) are displayed
expanded, the value of each expanded element is also saved. When they are not expanded, "+" mark is added on

the top of the item and the value becomes blank.

- When saved with [Save Expanded Watch Data...]

The watch-expression is expanded up to the maximum 255 nests regardless of the expanded state, and the value of

each expanded element is also saved.

Figure 2.66 Output Example of Watch Data

Watch-expression Value Type(Byte Size) Address Memo
Watch-expression  Value Type(Byte Size) Address Memo
-Category name

Watch-expression Value Type(Byte Size) Address Memo

Remark
watch panel (Watchl to Watch4) is treated as a different panel.

When the contents of the panel are overwritten by selecting the [File] menu >> [Save Watch Data], each
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2.10 Display Information on Function Call from Stack

This section describes how to show the information on function call from the stack.

The CS+ compiler (CC-RL) pushes function-call information onto the stack, in accordance with the ANSI standard.

It is thus possible to learn the function call depth, the location of the caller, parameters, and other information by analyz-
ing the function-call information.

This "function-call information" is called the call stack information; this term will be used in the rest of this document.

2.10.1 Display call stack information

Call stack information is displayed in the Call Stack panel below.
Select the [View] menu >> [Call Stack].
For details on the contents and function in each area, see the section for the Call Stack panel.

Caution 1.  Nothing is displayed on this panel during execution of a program.
When the program is stopped, items in each area are displayed.

Caution 2. Except for [Simulator]
If step execution is performed in source level, CS+ determines whether an interrupt is being processed
via the NP, EP, and ID flags in the PSW register. For this reason, if the above register or flags are
changed (e.g. when using multiple interrupts), then call stack information may be incorrect.

Figure 2.67 Display Call Stack Information (Call Stack Panel)
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This section describes the following.

2.10.1.1 Change display format of values

2.10.1.2 Jump to the source line

2.10.1.3 Display local variables

2.10.1.4 Save the contents of call stack information

2.10.1.1 Change display format of values

The display format of this panel can be changed using buttons below on the toolbar.
Note that these buttons are disabled during execution of a program.

Notation The following buttons to change the notation of a data value are displayed.

AutoSelect Displays values on this panel in the default notation according to the type of variable (default).

. Hexadecimal | Displays values on this panel in hexadecimal number.

. Decimal Displays values on this panel in decimal number.
E Octal Displays values on this panel in octal number.
Binary Displays values on this panel in binary number.
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Encoding The following buttons to change the encoding of character variables are displayed.
ASCII Displays character variables in ASCII code (default).
Shift_JIS Displays character variables in Shift_JIS code.
. EUC-JP Displays character variables in EUC-JP code.
UTF-8 Displays character variables in UTF-8 code.
UTF-16 Displays character variables in UTF-16 code.

2.10.1.2 Jump to the source line

Double-clicking on the line will open the Editor panel with the caret moved to the source line of the calling function indi-
cated by the selected line (If the panel is already open, the screen will jump to the editor panel).

Remark Selecting [Jump to Disassemble] from the context menu will open the Disassemble panel (Disassemble
1) with the caret moved to address of the calling function indicated by the selected line (If the panel is
already open, the screen will jump to the Disassemble panel (Disassemble 1)).

2.10.1.3 Display local variables

Selecting [Jump to Local Variable at This Time] from the context menu will open the Local Variables panel that displays
the local variables indicated by the currently selected line.

2.10.1.4 Save the contents of call stack information

By selecting the [File] menu >> [Save Call Stack Data As...], the Save As dialog box can be opened, and all the contents
in the call stack information can be saved in a text file (*.txt) or CSV file (*.csv).
When saving to files, retrieve the latest information from the debug tool.

Figure 2.68 Output Example of Call Stack Information

Depth Call stack
0 Call stack information
1 Call stack information

Note If old information has been obtained from stack data that has lost its reliability, the information on that line
is shown in parentheses "()".
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2.11 Collect Execution History of Programs

This section describes how to collect the execution history of the program.

A history of program execution is generally called a trace; this term will be used in the remainder of this document.

It is nearly impossible to find the cause of runaway program execution from the memory contents, stack information, and
the like after the runaway has occurred. The collected trace data, however, can be used to trace program execution up to
the runaway directly, making this an effective tool for discovering hidden bugs.

Caution 1.  [E1][E20][EZ Emulator][COM Port]
The trace function is supported only when the selected microcontroller incorporates the OCD trace func-

tion.

Caution 2. [Simulator]
4 bytes of the final address of the code flash area (when a code flash area is 0x0 - Ox1FFFF, Ox1FFFC -
1FFFFF corresponds to it) and the RAM area which can be fetched cannot be fetched (a message of
"Stopped by accessing to no map area." will appear).

2.11.1 Configure the trace operation

When the trace function starts, trace data which has recorded in it an execution history of the currently executed pro-
gram is collected in trace memory (when program execution stops, the trace function also automatically stops).

Before the trace function can be used, it is necessary to make settings relating to the operation of a trace.

Note that the method on how to set differs depending on the debug tool used.

2.11.1.1 [IECUBE]

2.11.1.2 [E1)/[E20])/[EZ Emulator]/[[COM Port]
2.11.1.3 [Simulator]

2.11.1.1 [IECUBE]

This trace operation can be configured in the [Trace] category on the [Debug Tool Settings] tab in the Property panel.

Figure 2.69 [Trace] Category [[ECUBE]
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(1) [Clear trace memory before running]
Select whether to clear (initialize) the trace memory before tracing starts in this property.
Select [Yes] to clear the memory (default).

Remark You can forcibly clear the trace memory when clicking the button in the toolbar in the Trace
panel.

(2) [Operation after trace memory is full]
Select the operation after the trace memory is full with the collected trace data, from the following drop-down list.

The trace memory size is 128K frames (fixed).

Non stop and overwrite | Continues overwriting the older trace data after the trace memory is full (default).
to trace memory When the [Clear trace memory before running] property is set to [Yes], at the time of
a resumption, trace data is collected after clearing the trace memory.

Stop trace When the trace memory is full, CS+ stops writing trace data (the program does not
stop execution).

Stop When the trace memory is full, CS+ stops writing trace data and the program stops
execution.

(3) [Rate of frequency division of trace time tag]
Specify the frequency division ratio of the counter to be used for time tag display (i.e. display of the [Time] item in
the Trace panel) (default: [1/1(4ns/0.3min)]).

Remark Values in ()" on the drop-down list indicate the resolution and the maximum measurement time.
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Caution An error occurs in trace time tag due to the following causes:
- When the RAM monitor function is used during user program execution
- When a hardware or software breakpoint is set during user program execution
- When a value is written to memory using the DMM function during user program execution

Caution Information on access to the SFRs and memory by the DMAC is also output with information on data to
which access is normal.

2.11.1.2 [E1)/[E20)/[EZ Emulator]/[COM Port]

This trace operation can be configured in the [Trace] category on the [Debug Tool Settings] tab of the Property panel.

Caution This category appears only when the selected microcontroller incorporates the OCD trace function.

Figure 2.70 [Trace] Category [E1][E20][EZ Emulator][COM Port]
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(1) [Use trace function]
Select whether to use trace function.
Select [Yes] to use the trace function (default: [No]).

(2) [Operation after trace memory is full]
Select the operation after the trace memory is full with the collected trace data, from the following drop-down list.

Non stop and overwrite | Continues overwriting the older trace data after the trace memory is full (default).
to trace memory

Stop trace When the trace memory is full, CS+ stops writing trace data (the program does not
stop execution).

(3) [Trace memory size[frames]]
The size of trace memory (i.e. the number of trace frames) is displayed.
You cannot change the value of this property.
The trace frame is a unit of trace data. One trace frame is used for each operation in fetch/write/read.

Operation specifications of the OCD trace function are as follows:

Table 2.11  Operation Specifications of OCD Trace Function

Item Description
Clearing the trace The trace memory is cleared when:
memory - The program is executed.
- The external reset signal is generated (the internal reset signal does not cause
clearing the trace memory).
Operation after the The trace full break is not supported.

trace memory is full
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Item Description

Target of trace data Branch origin instructions (internal ROM only)

For a branch instruction with a condition, it will be traced only when the condition is
met. Complement display of instructions between branch instructions cannot be per-
formed.

Note that, for the following instructions, an instruction of the next address of its cor-
rect position will be displayed.

- BT ES:[HL].bit, $addr20
- BF ES:[HL].bit, $addr20

- BTCLR ES:[HL].bit, $addr20
The following items are supported on the Trace panel.

- [Number]
- [Line/Address]

- [Source/Disassemble]

Trace event See "2.15.7 Notes for setting events".

Notes The following items cannot be traced.
- Interrupt vectors
- Instructions during a step execution

- Skip instructions with a condition

2.11.1.3 [Simulator]

This trace operation can be configured in the [Trace] category on the [Debug Tool Settings] tab of the Property panel.

Figure 2.71 [Trace] Category [Simulator]
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[Use trace function]
Select whether to use trace function.
Select [Yes] to use the trace function (default: [No]).

[Clear trace memory before running]
Select whether to clear (initialize) the trace memory before tracing starts.
Select [Yes] to clear the memory (default).

Remark You can forcibly clear the trace memory when clicking the button in the toolbar in the Trace
panel.

[Operation after trace memory is full]
Select the operation after the trace memory is full with the collected trace data, from the following drop-down list.

Non stop and overwrite | Continues overwriting the older trace data after the trace memory is full (default).
to trace memory When the [Clear trace memory before running] property is set to [Yes], at the time of
a resumption, the trace data is collected after clearing the trace memory.

Stop trace When the trace memory is full, CS+ stops writing trace data (the program does not
stop execution).

Stop When the trace memory is full, CS+ stops writing trace data and the program stops
execution.
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(4) [Accumulate trace time]
Select whether to display the trace time with accumulated time.
Specify [Yew] to display trace time with accumulated time. Specify [No] to display the trace time with differential
time (default).

(5) [Trace memory size[frames]]
Select the trace memory size (trace frame number) (default: [4K]).
The trace frame is a unit of trace data. One trace frame is used for each operation in fetch/write/read.

2.11.2 Collect execution history until stop of the execution

In the debug tool, there is a function to collect the execution history from the start of program execution to the stop.

Therefore, the trace data collection is automatically started when the program starts executing and stopped when the
program stops.

See "2.11.6 Display the collected execution history" for how to check the collected trace data.

Remark This function is actuated by an Unconditional Trace event, one of the built-in events that are set in the
debug tool by default.
Consequently, if the Unconditional Trace event is set to Invalid state by clearing the check box in the
Events panel, trace data linked to the start of program execution will not be collected (the Unconditional
Trace event is set to Valid state by default).
Note that Unconditional Trace event and Trace event described later (see "2.11.3 Collect execution his-
tory in a section") are used exclusively of each other. Therefore, if Trace event with Valid state is set,
Unconditional Trace event is automatically set to Invalid state.

2.11.3 Collect execution history in a section

The execution history is collected as trace data only for a section while the program is in execution by setting a Trace
event.

This Trace event consists of a trace start event and a trace end event.

To use this function, follow the procedure described below.

2.11.3.1 Set a Trace event
2.11.3.2 Execute the program
2.11.3.3 Edit a Trace event
2.11.3.4 Delete a Trace event

Caution 1.  Also see "2.15.7 Notes for setting events" for details on Trace events (e.g. limits on the number of
enabled events).

Caution 2.  The event type (execution type/access type) that can be set as trace start and end events differ with each
debug tool used.

Caution 3.  [Simulator]
Trace start events and trace stop events cannot be set/deleted while a tracer is running.

Caution 4.  [Simulator]
If you perform a trace from a trace start event until a trace end event, the simulator will not include the
trace end event in the results of the trace. For this reason, if you are using a simulator, set the trace end
event one line below the range for which you require display of the trace data.

2.11.3.1 Set a Trace event

To set a Trace event, set a trace start event and a trace end event that starts/stops collecting the trace data.
Use one of the following methods to set a trace start event and a trace end event.

(1) For execution-related events
By setting execution-related events for a trace start event and a trace end event, it is possible to start and stop the
collection of trace data at any place.
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is dis-
played.
Follow the operation listed below from the context menu, in accordance with your desired event type, after moving
the caret to the target line that has a valid address.
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Event Type Operation
Trace start Select [Trace Settings] >> [Start Tracing]
Trace end Select [Trace Settings] >> [Stop Tracing]
Caution [Simulator]

Simulator will not display a trace end event as the results of a trace. For this reason, set a trace
end event to one line below the range that you wish to display as the trace data.

A trace start event or a trace end event is set to the instruction at the start address corresponding to the line of the
caret position.

Once a trace start event or a trace end event is set, the following event mark is displayed in the event area of the
line that an event is set.

Table 2.12 Event Marks of Trace Start Event and Trace End Events

Event Type Event Mark
Trace start ;]9'
Trace end 3?

Figure 2.72 Trace Start and Trace End Events Setting Example (Disassemble Panel)
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(2) For access-related events [E1][E20]
By setting access-related events for a trace start event and a trace end event, it is possible to start and stop the
collection of trace data when a specified access is made to any variable or SFR.

Remark The types of access that can be set by using methods described here are only a read/write (see
“Table 2.5 Types of Accesses to Variables").
To change the access type to a read or write, after setting trace start and end events, edit their
[access type] item (see "2.15.4.2 Edit access-related events").

(&) To set events for variables or SFR in the Editor panel/Disassemble panel
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is dis-
played.
Follow the operation listed below from the context menu, in accordance with your desired event type, after
selecting an arbitrary variable or SFR on the source text/disassembled text.
Note, however, that only global variables, static variables inside functions, and file-internal static variables can

be used.
Event Type Operation
Trace start Select [Trace Settings] >> [Record Start R/W Value], and then press the [Enter] key.
Trace end Select [Trace Settings] >> [Record End R/W Value], and then press the [Enter] key.

At this time, if you have specified a value in the text box in the context menu, collection of trace data is started or
finished only when a read/write is performed with a specified value. On the other hand, if no value is specified,
reading/writing the selected variable or SFR by any value will cause the break to occur.

Caution 1.  Variables within the current scope can be specified.
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Caution 2.  Variables or SFR at lines that have no valid addresses cannot be used for trace start events and
trace end events.

(b) To set events for registered watch-expressions
Perform this operation in the Watch panel.
Follow the operation listed below from the context menu after selecting the registered watch-expression (multi-
ple selections not allowed).
Note, however, that only global variables, static variables inside functions, file-internal static variables, and SFR

can be used.
Event Type Operation
Trace start Select [Trace Output] >> [Record Start R/W Value], and then press the [Enter] key.
Trace end Select [Trace Output] >> [Record End R/W Value], and then press the [Enter] key.

At this time, if you have specified a value in the text box in the context menu, collection of trace data is started or
finished only when a read/write is performed with a specified watch-expression. On the other hand, if no value
is specified, reading/writing the selected watch-expression by any value will cause the break to occur.

Caution A watch-expression within the current scope can be specified.
To target a watch-expression outside the current scope, select a watch-expression with a speci-
fied scope.

When a trace start event and a trace end event are set, they are managed collectively on the Events panel as one
instance of a Trace event (see "2.15 Manage Events"). When you click the "+" mark at a Trace event item, detailed infor-
mation on the trace start event and the trace end event you have set is displayed.

Figure 2.73 Example of Trace Start and Trace End Events (Execution Type) in Events Panel
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Remark 1. If either one of a trace start event and a trace end event is set as Valid state, the check box of Uncondi-
tional Trace event in the Events panel is automatically cleared, therefore, trace data collection does not
automatically start with the start of the program execution (the tracer will not run until the condition of the
trace start event that has been set is met).

Remark 2. A trace end event is not indispensable for a Trace event.

Remark 3. Event marks differ depending on the event state (see "2.15.1 Change the state of set events (valid/
invalid)").
When an event is set at the point which other event is already set, the event mark ( h,_.‘:’ ) is displayed
meaning more than one event is set at the point.

Remark 4. [Simulator]
If either one of a trace start event and a trace end event is set to Valid state, the [Use trace function] prop-
erty in the [Trace] category on the [Debug Tool Settings] tab of the Property panel is automatically set to
[Yes] and the trace function will be enabled.
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2.11.3.2 Execute the program

Execute the program (see "2.7 Execute Programs").
Collection of trace data is started or finished when the condition set for a trace start event or a trace end event is met.
See "2.11.6 Display the collected execution history" for how to check the collected trace data.

2.11.3.3 Edit a Trace event

It is possible to edit a trace start event or a trace end event you have set.
For details on how to do it, see "2.15.4.1 Edit execution-related events" or "2.15.4.2 Edit access-related events".

2.11.3.4 Delete a Trace event

To delete a Trace event you have set, on the Editor panel/Disassemble panel, right-click the event mark in the event
area and select [Delete Event] from the context menu that is displayed.

Also, there is another way to delete a set event. Select the Trace event you want to delete on the Events panel, and
then click the button in the toolbar (see "2.15.5 Delete events").

Caution It is not possible to delete only a trace start event or a trace end event (i.e. if either a trace start event or
a trace end event is deleted from the event marks on the event area, all of the corresponding event
marks are deleted).

2.11.4 Collect execution history only when the condition is met [IECUBE][Simulator]

The program execution history can be collected only when a condition is met.

By setting a Point Trace event, the execution history is collected as trace data only when an arbitrary variable or SFR is
accessed with the specified type.

To use this function, follow the procedure described below.

2.11.4.1 Set a Point Trace event
2.11.4.2 Execute the program
2.11.4.3 Edit a Point Trace event
2.11.4.4 Delete a Point Trace event

Caution [E1][E20][EZ Emulator][COM Port]
This function is not supported.

2.11.4.1 Set a Point Trace event

Use one of the following methods to set a Point Trace event.

Caution 1.  Also see "2.15.7 Notes for setting events" for details on Point Trace events (e.g. limits on the number of
enabled events).

Caution 2. [IECUBE]
Point Trace events cannot be set for 32-bit (4-byte) variables.
Additionally, see "(3) For access to a variable/SFR of 16-bit (2-byte) size [[ECUBE]" for setting of Point
Trace events for 16-bit (2-byte) variables.

Caution 3.  [Simulator]
Point Trace events cannot be set/deleted while a tracer is running.

Remark 1. [IECUBE]
Accesses via DMA can be traced.

Remark 2. [Simulator]
When a Point Trace event is set to Valid state, the [Use trace function] property in the [Trace] category on
the [Debug Tool Settings] tab of the Property panel is automatically set to [Yes] and the trace function will
be enabled.

(1) For access to a variable/SFR on the Editor panel/Disassemble panel
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is dis-
played.
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Follow the operation listed below from the context menu, in accordance with your desired access type, after
selecting the variable or SFR as the subject to access.
Note, however, that only global variables, static variables inside functions, and file-internal static variables can be

used.

Access Type Operation
Read Select [Trace Settings] >> [Record Reading Value].
Write Select [Trace Settings] >> [Record Writing Value].
Read/Write Select [Trace Settings] >> [Record R/W Value].

Caution Variables within the current scope can be specified.

(2) For access to a registered watch-expression
Perform this operation in the Watch panel.
Select the watch-expression as the subject to access and perform the following operation from the context menu.
Note, however, that only global variables, static variables inside functions, file-internal static variables, and SFR

can be used.
Access Type Operation
Read Select [Trace Output] >> [Record Reading Value].
Write Select [Trace Output] >> [Record Writing Value].
Read/Write Select [Trace Output] >> [Record R/W Value].
Caution A watch-expression within the current scope can be specified.
To target a watch-expression outside the current scope, select a watch-expression with a specified
scope.

(3) For access to a variable/SFR of 16-bit (2-byte) size [[ECUBE]
If you want to set a Point Trace event to a variable/SFR of 16-bit (2-byte) size when using IECUBE, register each
address of the higher 8-bit and the lower 8-bit of the variable/SFR in the Watch panel directly as watch-expres-
sions (see "2.9.6.1 Register a watch-expression").
Then, set a Point Trace event to each watch-expression by using the method described in "(2) For access to a
registered watch-expression".

Figure 2.74 How to Set Point Trace Event for 16-bit (2-byte) Variable/SFR [IECUBE]

Watch |
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This example shows how to set a Point Trace event for the 2-byte SFR (ADCR).
Directly register Oxfffle (lower 8-bit address) and 0xfff1f (higher 8-bit address) as
watch-expressions, and then set a Point Trace event to each watch-expression.

By performing the above operation, it is interpreted as if a Point Trace event has been set at the target variable/
SFR/watch-expression, and it is managed in the Events panel (see "2.15 Manage Events" for details).
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Figure 2.75 Example of Setting Point Trace Event in Events Panel
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2.11.4.2 Execute the program

Execute the program (see "2.7 Execute Programs").

If the conditions for a Point Trace event that you have set are met while the program is executing, that information is col-
lected as trace data.

See "2.11.6 Display the collected execution history" for details on checking trace data.
Figure 2.76 Example of Point Trace Event Results View
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Figure 2.77 Example of Point Trace Event Results View (For 16-bit (2-byte) Variable/SFR) [I[ECUBE]
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An access address of trace shows The data is displayed

a defined SFR name or address. each 1 byte.

2.11.4.3 Edit a Point Trace event

It is possible to edit a Point Trace event you have set.
For details on how to do it, see "2.15.4.2 Edit access-related events".
2.11.4.4 Delete a Point Trace event

To delete a Point Trace event you have set, select the Point Trace event you want to delete on the Events panel, and
then click the button in the toolbar (see "2.15.5 Delete events").
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2.11.5 Stop/restart collection of execution history [IECUBE][Simulator]

It is possible to temporarily stop or restart the collection of execution history during program execution.

2.11.5.1 Stop collection of execution history temporarily

By clicking the button on the toolbar in the Trace panel during program execution, it is possible to temporarily stop
collection of trace data without stopping program execution.

Use this function when you want to stop only the trace function without halting the program and check the trace data that
has been collected until you stop it.

2.11.5.2 Restart collection of execution history

If you have halted the trace function during program execution, you can start collection of trace data again by clicking
the button on the toolbar in the Trace panel.
Note that the trace data that has been collected before you restart is cleared once.

2.11.6 Display the collected execution history

The collected trace data is displayed in the Trace panel below.

Select the [View] menu >> [Trace].

The trace data displays by mixing the disassembled text and source text by default, but it is also possible to display
either one of these by selecting the Display mode.

For details on the contents and function in each area, see the section for the Trace panel.

Figure 2.78 Display Trace Data (Trace Panel)
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(2): [Number] area

(2): [Time (h:min:s,ms,us,ns)] area

(3): [Line/Address] area

(4): [Source/Disassemble] area

(5): [Address] area

(6): [Data] area

This section describes the following.
2.11.6.1 Change display mode
2.11.6.2 Change display format of values
2.11.6.3 Link with other panels

2.11.6.1 Change display mode
Display mode can be changed to the purpose when clicking the buttons below in the toolbar.
Note that these buttons are disabled while the tracer is running.
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Table 2.13  Display Modes of Trace Panel

Button Display Mode Displayed Content
Mixed display mode Displays the instruction (disassemble results), labels, source text (corre-

sponding source line), point trace results [IECUBE][Simulator], reset
causes [IECUBE], and break causes (default).

Disassemble display mode | Displays the instruction (disassemble results), labels, point trace results
[IECUBE][Simulator], reset causes [IECUBE], and break causes.

Source display mode Displays the source text (corresponding source line), reset causes
[IECUBE], and break causes.

However, when a place where no debugging information is present is exe-
cuted, "<No Debug Information>" is displayed.

Figure 2.79 Example of Source Display Mode View (Trace Panel)
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2.11.6.2 Change display format of values

The display format of the [Line Number/Address], [Address] [[ECUBE][Simulator] and [Data] [[IECUBE][Simulator]
area can be changed using buttons below on the toolbar.
Note that these buttons are disabled while the tracer is running.

Notation The following buttons to change the notation of a data value are displayed.
. Hexadecimal Displays values on this panel in hexadecimal number (default).
. Decimal Displays values on this panel in decimal number.
Octal Displays values on this panel in octal number.
Binary Displays values on this panel in binary number.

2.11.6.3 Link with other panels

Items in the trace panel can be linked to other panels using the currently selected line address as a pointer (window
focus will not move).

Click the button on the toolbar to start linking to the Editor panel. Click the button on the toolbar to start linking
to the Disassemble panel.

If the button is clicked again, the link is disconnected.

Remark The Editor panel/Disassemble panel opens when selecting the [Jump to Source]/[Jump to Disassemble]
from the context menu with moving the caret to the source line/address corresponding to the address of
the currently selected line (focus is moved).
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2.11.7 Clear the trace memory

To clear the collected trace data contents, click the button on the toolbar.
Note that this button is disabled while a tracer is running.

Remark 1. [IECUBE][Simulator]
When [Yes] is specified in the [Clear trace memory before running] property in the [Trace] category on the

[Debug Tool Settings] tab of the Property panel, the trace memory is cleared each time a program is exe-
cuted.

Remark 2. [E1][E20][EZ Emulator][COM Port]
The trace memory is cleared each time a program is executed (fixed).

2.11.8 Search the trace data

To search the collected trace data, click the button to open the Trace Search dialog box (note that the search is dis-
abled during execution of a program).

In this dialog box, follow the steps below.

When the tab on the tab selection area is selected, the trace data can be searched in instruction level/source level.

Note however, that if you search the trace data at the instruction level, the display mode must be set in the Trace panel
to the Mixed display mode or Disassemble display mode.

When searching at the source level, the mode must be set to the Mixed display mode or Source display mode.

Figure 2.80 Search Trace Data (Trace Search Dialog Box)
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This section describes the following.
2.11.8.1 Search in the instruction level
2.11.8.2 Search in the source level
2.11.8.1 Search in the instruction level
Search the trace data in the instruction level.
Select the [Instruction Level] tab and then follow the steps below.
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Figure 2.81 Search Trace Data in Instruction Level
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(1) Specify [Fetch Address]
Specify the fetch address if it is a required search parameter.
You can either type address expressions directly into the text boxes, or select it from the input history via the drop-
down list (up to 10 items).
The fetch address can also be specified as a range. In this case, specify a range by specifying address expres-
sions in both the left and right text boxes.
If the right-hand text box is blank or contains the text [(Input when range is specified)], then the fixed address
specified in the left-hand text box will be searched.
Note that if an address value greater than the microcontroller address space is specified, the high-order address
value is masked.
An address value greater than the value expressed within 32 bits cannot be specified.

(2) Specify [Mnemonic]
Specify the mnemonic if it is a required search parameter.
The specified character strings in this area is searched within the [Source/Disassemble] area of the Trace panel.
You can either type a mnemonic directly into the text boxes, or select one from the input history via the drop-down
list (up to 10 items).
Searches are case-insensitive, and partial matches are also allowed.

(3) Specify [Access Address] [IECUBE][Simulator]
Specify the access address if it is a required search parameter.
You can either type the address value directly into the text boxes (in hexadecimal number), or select it from the
input history via the drop-down list (up to 10 items).
The access address can also be specified as a range. In this case, specify a range by specifying address expres-
sions in both the left and right text boxes.
If the right-hand text box is blank or contains the text [(Input when range is specified)], then the fixed address
specified in the left-hand text box will be searched.
Note that if an address value greater than the microcontroller address space is specified, the high-order address
value is masked.
An address value greater than the value expressed within 32 bits cannot be specified.

(4) Specify [Access Status] [IECUBE][Simulator]
This item is only enable if a value for Specify [Access Address] [I[ECUBE][Simulator] is specified.
Select the access type (Read/Write, Read, Write, Vector Read and DMA) from drop-down list.
Select [(No Specification)] if you do not wish to limit access types.
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Specify [Data] [IECUBE][Simulator]

This item is only enable if a value for Specify [Access Address] [[IECUBE][Simulator] is specified.

Specify the access data.

You can either type the data directly into the text boxes (in hexadecimal number), or select it from the input history
via the drop-down list (up to 10 items).

The data can also be specified as a range. In this case, specify a range by specifying data in both the left and right
text boxes.

If the right-hand text box is blank or contains the text [(Input when range is specified)], then the fixed data specified
in the left-hand text box will be searched.

Specify [Number]

Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace
panel.

Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number" are
specified by default).

You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input his-
tory via the drop-down list (up to 10 items).

If the left-hand text box is left blank, it is treated as if "0" were specified.

If the right-hand text box is left blank, it is treated as if the last number were specified.

Click the [Search Backward]/[Search Forward] button

When the [Search Backward] button is clicked, search is taken place in the order from the large number to small
and the search results are shown selected in the Trace panel.

When the [Search Backward] button is clicked, search is taken place in the order from the small number to large
and the search results are shown selected in the Trace panel.

2.11.8.2 Search in the source level

Search the trace data in the source level.
Select the [Source Level] tab.

Figure 2.82 Search Trace Data in Source Level
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Search with specifying the source line (default)
Select the [The execution part is retrieved specifying the source line] item in the [Search object] area and then fol-
low the operation below.
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Specify [Source and Line]

The specified character strings in this area is searched within the [Line/Address] area of the Trace panel.
You can either type the character strings of the source line to be find directly into the text box, or select them
from the input history via the drop-down list (up to 10 items).

Searches are case-insensitive, and partial matches are also allowed.

Example 1.  main.c#40
Example 2.  main.c
Example 3. main

Specify [Number]

Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace
panel.

Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number"
are specified by default).

You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input
history via the drop-down list (up to 10 items).

If the left-hand text box is left blank, it is treated as if "0" were specified.

If the right-hand text box is left blank, it is treated as if the last number were specified.

Click the [Search Backward]/[Search Forward] button

When the [Search Backward] button is clicked, search is taken place in the order from the large number to small
and the search results are shown selected in the Trace panel.

When the [Search Backward] button is clicked, search is taken place in the order from the small number to large
and the search results are shown selected in the Trace panel.

Search with specifying the function name

Select the [The execution part is retrieved specifying the function] item in the [Search object] area and then fol-
low the operation below.

Specify [Function Name]

You can either type the function name to be find directly into the text box, or select it from the input history via
the drop-down list (up to 10 items).

Searches are case-insensitive, and only complete matches are retrieved.

Specify [Number]

Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace
panel.

Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number"
are specified by default).

You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input
history via the drop-down list (up to 10 items).

If the left-hand text box is left blank, it is treated as if "0" were specified.

If the right-hand text box is left blank, it is treated as if the last number were specified.

Click the [Search Backward]/[Search Forward] button

When the [Search Backward] button is clicked, search is taken place in the order from the large number to small
and the search results are shown selected in the Trace panel.

When the [Search Backward] button is clicked, search is taken place in the order from the small number to large
and the search results are shown selected in the Trace panel.

Search with specifying the global variable [[ECUBE][Simulator]

Select the [The execution part is retrieved specifying the global variable] item in the [Search object] area and
then follow the operation below.

Specify [Variable Name]

You can either type the variable name to be find directly into the text box, or select it from the input history via
the drop-down list (up to 10 items).

Searches are case-insensitive, and only complete matches are retrieved.

Specify [Kind]
Select the access type ([Reference/Substitution], [Reference], or [Substitution]) from the drop-down list.

Specify [Value]

You can either type the accessed variable value directly into the text box, or select one from the input history via
the drop-down list (up to 10 items).

The variable value can also be specified as a range. In this case, specify a range by specifying variable values
in both the left and right text boxes.
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If the right-hand text box is blank, then access locations with the fixed variable values specified in the left-hand
text box will be searched for.

(d) Specify [Number]

Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace
panel.

Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number"
are specified by default).

You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input
history via the drop-down list (up to 10 items).

If the left-hand text box is left blank, it is treated as if "0" were specified.

If the right-hand text box is left blank, it is treated as if the last number were specified.

(e) Click the [Search Backward]/[Search Forward] button

When the [Search Backward] button is clicked, search is taken place in the order from the large number to small
and the search results are shown selected in the Trace panel.
When the [Search Backward] button is clicked, search is taken place in the order from the small number to large
and the search results are shown selected in the Trace panel.

2.11.9 Save the contents of execution history

Contents of the collected trace data can be saved with range selection in text files (*.txt)/CSV files (*.csv).

When saving to the file, the latest information is acquired from the debug tool, and it is saved in accordance with the dis-
play format on this panel.

The following Data Save dialog box can be opened by selecting the [File] menu >> [Save Trace Data As...].

In this dialog box, follow the steps below.

Figure 2.83 Save Execution History (Data Save Dialog Box)
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(1) Specify [File Name]
Specify the name of the file to save.
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history
via the drop-down list (up to 10 items).
You can also specify the file by clicking the [...] button, and selecting a file via the Select Data Save File dialog box.
(2) Specify [File Type]
Select the format in which to save the file from the following drop-down list.
The following file formats can be selected.
List Item Format
Text files (*.txt) Text format (default)
CSV (Comma-Separated Variables)(*.csv) CSV formatNote
Note The data is saved with entries separated by commas (,).
If the data contains commas, each entry is surrounded by double quotes " in order to avoid illegal
formatting.
(3) Specify [Save Range Number]
Specify the range of the number to save via "start number" and "end number".
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Directly enter decimal number in each text box or select from the input history displayed in the drop-down list (up
to 10 items).
When saving all the trace data, select the [All Trace Data] item in the drop-down list at the left (the right text box

becomes invalid).
If a range is selected in the panel, that range is specified as the default. If there is no selection, then the range
currently visible in the panel is specified.

(4) Click the [Save] button
Trace data is saved in the specified file with the specified format.

Figure 2.84 Output Example of Trace Data

Number Time Line Number/Address Source/Disassemble Address Data
Number Time Line Number/Address Source/Disassemble Address Data
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2.12 Measure Execution Time of Programs

This section describes how to measure the execution time of the program.

2.12.1 Configure the timer operation

Before the timer function can be used, it is necessary to make settings relating to the operation of a timer.
Note that the method on how to set differs depending on the debug tool used.

2.12.1.1 [IECUBE]
2.12.1.2 [Simulator]

2.12.1.1 [IECUBE]

This timer operation can be configured in the [Trace] category on the [Debug Tool Settings] tab in the Property panel.

Figure 2.85 [Timer] Category [IECUBE]

4 Timer
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(1) [Rate of frequency division of timer]
Select the frequency division ratio of the timer counter (120 MHz) used for timer measurement (default: [1/1(8ns/
0.6min)]).

Caution Itis not possible to divide the timer counter for the Run-Break time (see "2.12.2 Measure execution
time until stop of the execution™).

2.12.1.2 [Simulator]
This timer operation can be configured in the [Trace] category on the [Debug Tool Settings] tab in the Property panel.

Figure 2.86 [Timer] Category [Simulator]
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(1) [Use timer function]

Select whether to use the timer function.
Select [Yes] to use the timer function (default: [No]).

2.12.2 Measure execution time until stop of the execution

In the debug tool, there is a function to measure the program execution time (Run-Break time) from the start to the stop.
Therefore, when the program starts its execution, the execution time is automatically measured.
You can check the result of the measurement by either one of the following.

Caution 1.  [COM Port]
This function is not supported.

Caution 2.  The execution time cannot be measured when Step In or Step Over is performed.

Remark This function is operated by a Run-Break Timer event, which is one of the built-in events set by default in
the debug tool. The Run-Break timer event is always Valid state (settings not changeable).

(1) Check in the status bar

After the program is stopped, the result of the measurement is displayed in the status bar on the Main window
(when measurements have not been performed yet, "Not measured" is displayed).
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Figure 2.87 Example of Result of Run-Break Timer Event (Status Bar)
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(2) Check on the Events panel
After the program is stopped, the result of the measurement is displayed in the Events panel that is opened by
selecting the [View] menu >> [Event], in event type as "Run-Break Timer".

Figure 2.88 Example of Result of Run-Break Timer Event (Events Panel)
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2.12.3 Measure execution time in a section [IECUBE][Simulator]

In the program execution process, the execution time in a section can be measured by setting Timer Result event. This
Timer Result event consists of a timer start event and a timer end event.
To use this function, follow the procedure described below.

2.12.3.1 Set a Timer Result event
2.12.3.2 Execute the program
2.12.3.3 Edit a Timer Result event
2.12.3.4 Delete a Timer Result event

Caution 1.  [E1][E20][EZ Emulator][COM Port]
Timer Result event is not supported.

Caution 2.  Also see "2.15.7 Notes for setting events" for details on Timer Result events (e.g. limits on the number of
enabled events).

2.12.3.1 Set a Timer Result event

To set a Timer Result event, set a timer start event and a timer end event that starts/stops a timer measurement.
Use one of the following methods to set a timer start event and a timer end event.

(1) For execution-related events
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is dis-
played.
Follow the operation listed below from the context menu, in accordance with your desired event type, after moving
the caret to the target line that has a valid address.

Event Type Operation
Timer start Select [Timer Settings] >> [Start Timer]
Timer end Select [Timer Settings] >> [Stop Timer]
Caution [Simulator]

Simulator will not include the time for a timer end event in the measurement results. For this rea-
son, set a timer end event to one line below the range for which you wish to measure the run time.

A timer start event or a timer end event is set to the instruction at the start address corresponding to the line of the
caret position.
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Once a timer start event or a timer end event is set, the following event mark is displayed in the event area of the

line that an event is set.

Table 2.14 Event Marks of Timer Start Event/Timer End Event
Event Type Event mark
Timer start &)
Timer end ._*,_ﬂf,?'
Figure 2.89 Timer Start and Timer End Events Setting Example (Disassemble Panel)
Event area
Indicates that a timer i for(i=0: i<1000:
start event has been set.,_{'_f:- o420 [+3 fE CLRW
00421 (+a 16 MOy
Indicates that a timer 00422 +b 17 MOV
end event has been set. = 00423 |+ 442803 CHPH
Ma 00426 [+f delf BHWC
i NOPE ) :

(2) For access-related events
In this product version, this function is not supported.

When a timer start event and a timer end event are set, they are managed collectively on the Events panel as one
instance of a Timer Result event (see "2.15 Manage Events"). When you click the "+" mark at a Timer Result event item,
detailed information on the timer start event and the timer end event you have set is displayed.

Figure 2.90 Example of Timer Start and Timer End Events (Execution Type) in Events Panel

Events ]
x ||m|m|&|@]a]=] x = @
Marme o [Dhetail Coopntrent
=2 Run-Break. Timer Todal: 179281 ne
é;‘fj‘ Timer Fesult Mot measured \
Tatal Pazs Count  fyerags felae feliny

| Haot measued |N|‘.‘-1. messired |H|:n1 fessured |h||:-l tessured | Mot pessuwred |

Detail

|SLarl: Execution r_mainckBd Dx1d1 /

End Execution r_omainc$aD 0xlel

Hame Dbl
W= Unconditional Trace -

Commen

Remark
invalid)").

Event marks differ depending on the event state (see "2.15.1 Change the state of set events (valid/

When an event is set at the point which other event is already set, the event mark ( Hﬁ ) is displayed

meaning more than one event is set at the point.

2.12.3.2 Execute the program

Execute the program (see "2.7 Execute Programs").

When an instruction for which a timer start event or a timer end event has been set is executed, a timer measurement is

started or finished.

After the program is stopped, the result of the measurement is displayed in the Events panel that is opened by selecting

the [View] menu >> [Event], in event type as "Timer Result".
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This Timer Result is a particular type of event that is displayed on only the Events panel when either a timer start event
or a timer end event has been set.

Figure 2.91 Example of Result of Timer Result Event (Timer Start Event/Timer End Event)

Events ]
L El [ El EIRE S
Mame o Datail Ciprnpmaznt
W) =% Fun-Brezk, Timer Total 40174231 ns
] [ Timer Ragult Total : 36652468 ne Start/End:2
Tatal Fazs Gownt  fyverags felae feliry
|2&552dﬁ3n: |395 |E'|'2I3ng |63625ns~ |fi'.'1ﬁﬁns |
Detail
Start Exscwlion r_maincElY 0= 141
End Exccution romain o5 0=le]
Hame o Detal Commen
F] = Unconditional Trace -

2.12.3.3 Edit a Timer Result event

It is possible to edit a timer start event or a timer end event you have set.
For details on how to do it, see "2.15.4.1 Edit execution-related events".

2.12.3.4 Delete a Timer Result event

To delete a Timer Result event you have set, on the Editor panel/Disassemble panel, right-click the event mark in the
event area and select [Delete Event] from the context menu that is displayed.

Also, there is another way to delete a set event. Select the Timer Result event you want to delete on the Events panel,
and then click the button in the toolbar (see "2.15.5 Delete events").

Caution It is not possible to delete only a timer start event or a timer end event (i.e. if either a timer start event or
a timer end event is deleted from the event marks on the event area, all of the corresponding event
marks are deleted).

2.12.4 Measurable time ranges

The scope of time that can be measured via timers using Run-Break Timer events (see "2.12.2 Measure execution time
until stop of the execution” for details) or Timer Result events (see "2.12.3 Measure execution time in a section
[[ECUBE][Simulator]" for details) is shown below.

If the maximum measurable length of time is exceeded, a timer-over break is generated, and program execution stops.

Table 2.15 Measurable Time Ranges

Debug Tool Run-Break Timer Event Timer Result Event
IECUBE Min. | 8ns Min. | 8 ns
Max. | Approx. 40 hours 43 min Max. | Approx. 40 hours 43 min (time for 4K
Overflow detection included cycles)
Maximum pass count: 4294967295 times
Overflow detection included

E1/E20 Min. | 100 ps -
EZ Emulator

Max. | Approx. 119 hours 18 min
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Debug Tool Run-Break Timer Event Timer Result Event

Simulator Depends on the clock frequency for timer/ Depends on the clock frequency for timer/trace
trace

2.13 Measure Coverage [[ECUBE][Simulator]

This section describes coverage measurements that are conducted using the coverage function.

There are several kinds of coverage measurement methods. Of these, CS+ performs, in areas designated below, a
code coverage measurement of fetch-related operations on source lines and functions (CO coverage) and a data cover-
age measurement of access-related operations on variables.

The area in which CS+ performs coverage measurements are as follows:

Table 2.16  Subject Areas of Coverage Measurement

Debug Tool Code Coverage Measurement Area
IECUBE Internal ROM/RAM, DataFlash, Target memory
Simulator Internal ROM/RAM, Emulation ROM/RAM, Target memory
Caution [E1][E20][EZ Emulator][COM Port]

The coverage function is not supported.

Remark CO coverage: Instruction coverage (statement coverage)
For example, if all instructions (statements) in code are executed at least once, then CO = 100%.

2.13.1 Configure the coverage measurement

You need to configure the code coverage measurement before using the coverage function.
The setting method differs depending on the debug tool used.

2.13.1.1 [IECUBE]
2.13.1.2 [Simulator]

2.13.1.1 [IECUBE]

You can configure the coverage measurement in the [Coverage] category on the [Debug Tool Settings] tab of the Prop-
erty panel as follows:

Figure 2.92 [Coverage] Category [I[ECUBE]

4 Goverags
Reuse coweraze resull Ho

(1) [Reuse coverage result]
The currently obtained results of code coverage measurements are automatically saved when CS+ is discon-
nected from the debug tool. The next time it is connected to the debug tool, specify from the drop-down list
whether or not you want to reproduce the contents of saved measurement results.
Select [Yes] to reproduce the contents of previously obtained code coverage measurement results (default: [No]).
The file that saves results of code coverage measurements (raw.csr.cv) will be created in the folder where the load
module file currently being downloaded exists.

2.13.1.2 [Simulator]

You can configure the coverage measurement function in the [Coverage] category on the [Debug Tool Settings] tab of
the Property panel as follows:
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Figure 2.93 [Coverage] Category [Simulator]

4 Coverage
Lze coverage function Yz
Rauze coverage result Ma

(1) [Use coverage function]
Select whether to use the coverage function.
Select [Yes] to use the coverage function (default: [No]).
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(2) [Reuse coverage result]
This property appears only when the [Use coverage function] property is set to [Yes].
The currently obtained results of code coverage measurements are automatically saved when CS+ is discon-
nected from the debug tool. The next time it is connected to the debug tool, select whether or not you want to
reproduce the contents of saved measurement results.
Select [Yes] to reproduce the contents of previously obtained code coverage measurement results (default: [No]).

2.13.2 Display the coverage measurement result

When the program starts running, a coverage measurement is automatically begun, and when the program stops run-
ning, the coverage measurement is terminated at the same time.

(1) Code coverage rates

(a) Display of code coverage rates for source text lines and disassembled text lines
The code coverage rates are indicated on the Editor panel/Disassemble panel that is displaying the target pro-
gram.
On each panel, the target source text lines and disassembled result lines are shown in color-coded background
(see "Table 2.18") according to their code coverage rate that was calculated based on the formula described in
"Table 2.17".
Note that the results are not shown when disconnected from the debug tool or during the program execution.
Selecting [Clear coverage information] from the context menu in the Editor panel/Disassemble panel will reset
all the coverage information acquired, including the color-coded display on each panel.

Table 2.17 Method for Calculating Code Coverage Rates for Source Lines and Disassemble Lines

Panel Calculation Method

Editor panel "Number of bytes of code executed in the address range corresponding to the source
text line" / "Total number of bytes of code in the address range corresponding to the
source text line"

Disassemble panel "Number of bytes of code executed in the address range corresponding to the disas-
sembled text line" / "Total number of bytes of code in the address range correspond-
ing to the disassembled text line"

Table 2.18 View of Code Coverage Measurement Result (Default)

Code Coverage Background Color
100 % Source text/disassembled text
1t0 99 % Source text/disassembled text
0 % (not yet executed) Source text/disassembled text

Remark 1. The code coverage measurement result displayed on each panel is automatically updated at
every program break.

Remark 2. The above background colors depend on the configuration in the [General - Font and Color] cat-
egory of the Option dialog box.

Remark 3. The above background colors do not apply to the lines that are outside of the subject area (see
"Table 2.16 Subject Areas of Coverage Measurement”).

Remark 4. If the downloaded lode module file is older than the source file currently being open, the display-
ing of the code coverage measurement result is not performed in the Editor panel.
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Figure 2.94 View of Code Coverage Measurement Result (Editor Panel)
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Figure 2.95 View of Code Coverage Measurement Result (Disassemble Panel)
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(b) Display of code coverage rates for each function
Code coverage rates of each function can be checked via the [Code Coverage[%]] item in the Function List
panel of the analyze tool. For details on "the code coverage rates of the function”, see "CS+ Integrated Devel-
opment Environment User's Manual: Analysis".

(2) Data coverage rates
Data coverage rates of each variable can be checked via the [Data Coverage[%]] item in the Variable List panel of
the analyze tool. For details on "the data coverage rates of the variable", see "CS+ Integrated Development Envi-
ronment User's Manual: Analysis".
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2.14 Set an Action into Programs

This section describes how to set the specified action into the program.

2.14.1 Inset printf

By setting a Printf event that is one of "action events", the value of the specified variable expression can be output to the

Output panel by executing a printf command after temporarily stopping the program in execution at an arbitrary position.
To use this function, follow the steps below.

Caution 1.  Also see "2.15.7 Notes for setting events" for details on action events (e.g. limits on the number of
enabled events).

Caution 2. No action events occur during step execution ( / / ) or execution ignoring break-related
events ( ).

Caution 3. [Simulator]
When [Yes] is specified with the [Execute instruction at breakpoint when break] property in the [Break]
category on the [Debug Tool Settings] tab in the Property panel, all of action events currently being set
are handled as Hardware Break events (i.e. no Printf events occur).

(1) Seta Printf event

Set a Printf event to the position where you want to execute the printf command in the Editor panel/Disassemble
panel.

On each panel, select [Register Action Event...] from the context menu after moving the caret to the line that has a
valid address to open the Action Events dialog box below.
In this dialog box, follow the steps below.

Figure 2.96 Set Printf Event (Action Events Dialog Box: [Printf event] tab)

[ Action Events

Frintf ewent |

Cudput string: Example) Sample:

Marwable expressione Example) asa, bbb, cec
{Input wariable exprezszions hare)
[l b

{lrpurt the address here )

Exarmple for Cutput panal)
Sample: aaa = 10, bbb = 30 oz = 20

Carcel | | Hel

(a) Specify [Output string]
Directly enter from the keyboard the characters to add when output to the Output panel.
Characters must be in one line (spaces allowed).

(b) Specify [Variable expression]
Specify the variable expression for the Printf event to take place.
Type a variable expression directly into the text box (up to 1024 characters).
You can specify up to 10 variable expressions for a single Printf event by separating them with commas ","

R20UT4857EJ0100 Rev.1.00 RENESAS Page 103 of 391
Nov 01, 2020



CS+Vv8.05.00 2. FUNCTIONS

If this dialog box opens with a variable expression selected in the Editor panel/Disassemble panel, the selected
variable expression appears as the default.

For the basic input format that can be specified as variable expressions and the values output by Printf event,
see "Table A.13 Relationship between Variable Expressions and Output Value (Printf Event)".

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] +
[Space] key in this text box (see "2.19.2 Symbol name completion function").

(c) Specify [Address]
Specify the address at which to set the Printf event.
The address of the location currently being specified is displayed by default.
If you want to edit this area, you can either type an address expression directly into the text box (up to 1024
characters), or select them from the input history via the drop-down list (up to 10 items).

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] +
[Space] key in this text box (see "2.19.2 Symbol name completion function").

(d) Click the [OK] button
Set the Printf event to the line/address at the caret position in the Editor panel/Disassemble panel.
When the Printf event is set, the % mark is displayed in the event area on the Editor panel/Disassemble panel,
and the set Printf event is managed in the Events panel (see "2.15 Manage Events").

(2) Execute the program
Execute the program (see "2.7 Execute Programs").
By executing the program, the program momentarily stops immediately before executing the instruction at the
location where this event is set, and the value of the variable expression specified in this dialog box is output to the
Output panel.

(3) Check the output result
The output result format from the Printf event in the [Debug Tool] tab of the Output panel are as follows (see "Fig-
ure A.23 Output Result Format of Printf Event").

Figure 2.97 Example of Output Result of Printf Event

Output =

Savple= global_a=101(0xn], 1

stoeped by user cperotion., [Output string]: Sample=

[ECF [Variable expression]: global_a
The result of the specification above

\ All Messages | “Debug Tool / -

(4) Edit the Printf event
You can edit the Print event that has been set once.
To do this, on the Events panel, select [Edit Condition...] from the context menu after selecting the Printf event to
be edited. On the Action Events dialog box opened automatically, edit the items, and then click the [OK] button.
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2.15 Manage Events

An event represents a certain status of the target system when debugging such as "Address 0x1000 is fetched" and
"Data is written to address 0x2000".

In CS+, these events are used as the action trigger of the debug function such as breakpoint, start/stop the tracing, and
start/stop the timer.

This section describes how to manage those events.

Select the [View] menu >> [Event].

Events are all managed in the Events panel. In the Events panel, you can confirm the details of the currently set events
in a list, and they can be deleted and changed enable/disable status.

For details on the contents and function in each area, see the section for the Events panel.

Figure 2.98 Manage Events (Events Panel)
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(2): [Detail Information] area
(3): [Comment] area

Remark For details on how to set various events, see the section below:
- Set a breakpoint
- Set a break event (execution type)
- Set a break event (access type)
- Set a Trace event
- Set a Point Trace event

- Set a Timer Result event

2.15.1 Change the state of set events (valid/invalid)

By changing the check on the check box of the event name, the setting state of the event can be changed (the Event
mark is changed depending on the setting state of the event).
The following are types of the setting state of the event.

Figure 2.99 Event Name Check Box

B
!
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B Hardware Bresk0001

@ ©)
(2): Check box
(2): Event mark
(3): Event name
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Table 2.19  Setting State of Event

Valid state Event occurs when the specified condition is met.
It is possible to set the event to an invalid state by removing the check.

[] | Invalid state Event does not occur when the specified condition is met.
It is possible to set the event to a valid state by removing the check.

Suspended State | The conditions that have been specified cannot be set with the program of the debug-
ging target. Itis not possible to operate the check box.

Remark 1. Both of the timer start event and the timer end event is must be set for the Timer Result event. There-
fore, it is not possible to set a particular event to a valid state by only the setting of one of these (at the
same time as both events are set, they are treated as grouped events as a Timer Result).

Remark 2. It is not possible to set the Run-Break Timer event to an invalid/suspended state.

Remark 3. The setting state of the event can be changed from the menu displayed by right clicking on the Event
mark in the Editor panel/Disassemble panel.

Remark 4. The setting of the Unconditional Trace event and the Trace event to valid or invalid state is exclusively
controlled. Therefore, the Unconditional Trace event, which is a built-in event, is valid state by default,
but if either a trace start event/trace end event is set, it automatically becomes invalid state, and the
Trace event, which is a event name that is collectively called with a trace start event and a trace end
event, becomes valid state. Conversely, if the set Trace event is invalid state, the Unconditional Trace
event automatically becomes valid state.

2.15.2 Display only particular event types

Click on the toolbar button to display only the particular event type.

Displays events related to the Hardware Break.

Displays events related to the Software Break.

(except [Simulator])

Displays events related to the traceN°®,

Displays events related to the timer.

[IECUBE][Simulator]

Displays events related to the action event (Printf event).

Displays the built-in events (Unconditional Trace event and Run-Break Timer event).
Note [E1][E20][EZ Emulator][COM Port]

This button is available only when the selected microcontroller incorporates the OCD trace function.

2.15.3 Jump to the event address

Clicking the following buttons jumps to each panel which selected events address exist.
Note however, that when a Trace event/Timer Result event/ Unconditional Trace event/ Run-Break Timer event is
selected, these buttons are disabled.

Opens the Editor panel and jumps to the source line corresponding to the address
where the selected event is being set.

Opens the Disassemble panel and jumps to the disassemble results corresponding to
the address where the selected event is being set.

Opens the Memory panel and jumps to the source line corresponding to the address
where the selected event is being set.
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2.15.4 Edit detailed settings of events

This section describes how to edit detailed settings of various events.

2.15.4.1 Edit execution-related events
2.15.4.2 Edit access-related events
2.15.4.3 Edit combination conditions of events [E1] [E20]

Remark For information on editing of action events (Printf events and interrupt events), see "2.14 Set an Action
into Programs".

2.15.4.1 Edit execution-related events

The address condition and pass count condition [IECUBE][Simulator] for execution-related events you have set can be
edited.

Perform this operation in the Detail dialog box (for execution events) that is opened by selecting [Edit Condition...] from
the context menu after moving the caret to an execution-related eventN°®® you want to edit on the Events panel.

Note An execution-related event refers to any one of the following events in the Events panel.
- Hardware Break event (execution type)
- Execution-related break event in detailed information on Combination Break event [E1][E20]
- Execution-related event as start and end condition in detailed information on Trace event
- Execution-related event as start and end condition in detailed information on Timer Result event

[IECUBE][Simulator]

Figure 2.100 Example of Detail Dialog Box (for Execution Events) [Simulator]
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(1) Editing [Address Condition]
You can edit the address condition for an execution-related event in this area.

Figure 2.101 [Address Condition] [[ECUBE]

# Agddress condition
Compare condtion Specfied address (==}
Addrass main.cl_mans1

Figure 2.102 [Address Condition] [E1][E20][EZ Emulator][COM Port]

Address man. cd_man+1
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Figure 2.103 [Address Condition] [Simulator]
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- For [IECUBE][Simulator]
From the [Compare condition] drop-down list, select the type of condition for address comparison.
After that, specify the address for use with the selected type of condition in the field displayed under the list.

List of [Compare condition] Setting Method
Specified address (==) After selecting any of these conditions, directly enter an address
expression as the address value in the [Address] field displayed under
Greater than or equal to (>=) the list for selection of the type of comparison.

Less than or equal to (<=)

Inside the range (<=Values<=) After selecting any of these conditions, directly enter an address
) expression as the address range in the [Start address] and [End
Outside the range !(<=Values<=) address] field displayed under the list for selection of the type of com-
parison.

It is possible to specify the value of an address mask for the specified address value [Simulator].
In this case, specify [Yes] in the [Use the address mask], and specify the mask value in the [Mask value] field
under the list by directly entering a hexadecimal address.

- For [E1][E20][EZ Emulator][COM Port]
In [Address], the address at which the execution-related event is currently set is displayed.
To edit this address, directly enter an address expression for the address value at which you want to set the

event.

(2) Editing [Pass Count] [IECUBE][Simulator]
You can edit the pass count condition for an execution-related event in this area.
Directly enter a pass count value in decimal notation between 1 and 65535.

Figure 2.104 [Pass Count]
4 Pass count
Fass count 1

Caution [IECUBE]
A value other than "1" cannot be specified as the pass count condition for an execution-related

event (before execution).

2.15.4.2 Edit access-related events

The address condition, data condition and pass count condition [IECUBE][Simulator] for access-related events you

have set can be edited.
Perform this operation in the Detail dialog box (for access events) that is opened by selecting [Edit Condition...] from the
context menu after moving the caret to an access-related event'Noe you want to edit on the Events panel.

Note An access-related event refers to any one of the following events in the Events panel.
- Hardware Break event (access type)
- Access-related break event in detailed information on Combination Break event [E1][E20]

- Access-related event as start and end condition [E1][E20][COM Port] in detailed information on Trace
event

- Access-related event in detailed information on Point Trace event
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(1) Editing [Address Condition]
You can edit the address condition for an execution-related event in this area.
Figure 2.106 [Address Condition] [[ECUBE]
2 Address condition
Compans condticon Specfied address (==}
Address madn.cH_mains1
Figure 2.107 [Address Condition] [E1][E20][EZ Emulator][COM Port]
4 Address condiion
Address man.cH_man-=1
Figure 2.108 [Address Condition] [Simulator]
4 Addrezs condition
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lask walus [fen] FFFFF
- For [IECUBE][Simulator]
From the [Compare condition] drop-down list, select the type of condition for address comparison.
After that, specify the address for use with the selected type of condition in the field displayed under the list.
List of [Compare condition] Setting Method
Specified address (==) After selecting any of these conditions, directly enter an address
expression as the address value in the [Address] field displayed under
Greater than or equal to (>=) the list for selection of the type of comparison.
Less than or equal to (<=)
Inside the range (<=Values<=) After selecting any of these conditions, directly enter an address
) expression as the address range in the [Start address] and [End
Outside the range !(<=Values<=) address] field displayed under the list for selection of the type of com-
parison.
It is possible to specify the value of an address mask for the specified address value [Simulator].
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In this case, specify [Yes] in the [Use the address mask], and specify the mask value in the [Mask value] field
under the list by directly entering a hexadecimal address.

- For [E1][E20][EZ Emulator][COM Port]
In [Address], the address at which the access-related event is currently set is displayed.
To edit this address, directly enter an address expression for the address value at which you want to set the
event.

(2) Editing [Data Condition]
You can edit the data condition for an access-related event in this area.

Figure 2.109 [Data Condition]
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(&) Specify an access type
In [Access type], select an access type from the following drop-down list.

Read When a read access occurs, the condition holds true.
Write When a write access occurs, the condition holds true.
Read/Wrote When a read or write access occurs, the condition holds true.

(b) Specify an access size
In [Access size], select an access size from the following drop-down list.

No conditions When an access in any size occurs, the condition holds true.
lbyte When an access in 1-byte size occurs, the condition holds true.
2byte When an access in 2-byte size occurs, the condition holds true.

(c) Specify a data comparison condition
From the [Compare condition] drop-down list, select the type of condition for data comparison.
After that, specify the value of data for use with the selected type of condition in the field displayed under the list.

- For [IECUBE][Simulator]

No conditions Comparison data is not specified.

Specified value (==) After selecting any of these conditions, directly enter a value in hexa-
decimal number in the [Data] field displayed under the list for selection

Any other value (!=) of the type of comparison.

Greater than or equal to (>=)

Less than or equal to (<=)

Inside the range (<=Values<=) After selecting any of these conditions, directly enter values in hexa-
- decimal number for the data range in the [Data] field displayed under
Outside the range !(<=Values<=) | the |ist for selection of the type of comparison.

For [E1][E20][EZ Emulator][COM Port]

No conditions Comparison data is not specified.

Specified value (== After selecting this, directly enter a value in hexadecimal number in the
[Data] field displayed under this field.
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(d) Specify a data mask
Select [Yes] in the [Use the data mask] field to specify a mask value for the matching of data values. When [Yes]
is selected, a [Mask value] field appears below the [Use a data mask] field. Specify a hexadecimal value with no
more than five digits for the data mask by directly entering it in the [Mask value] field.

(3) Editing [Pass Count] [IECUBE][Simulator]
You can edit the pass count condition for an access-related event in this area.
Directly enter a pass count value in decimal notation between 1 and 65535.

Figure 2.110 [Pass Count]
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2.15.4.3 Edit combination conditions of events [E1] [E20]

Edit the combination condition for a combination break event comprised of multiple events set.

Caution This function is enabled only when the selected microcontroller supports combination break events.

Perform this operation in the Combination Condition dialog box [E1][E20] that is opened by selecting [Edit Condition...]
from the context menu after moving the caret to a combination break event you want to edit on the Events panel.

Figure 2.111 Example of Combination Condition Dialog Box
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(1) Editing [Combination] area
Select the combination condition from the following drop-down list.

OR The condition is satisfied when one of the set events is encountered (default).
Sequential The condition is satisfied when the set events are encountered in the specified sequence.
Caution When [OR] is selected, up to two break events can be specified.

When [Sequential] is selected, break event can be specified for the 1st to the 2nd position.

(2) Editing [Object event] area
This area displays details on the break event set as a combination break event.
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When [Sequential] is specified in the [Combination] area, the order of display here corresponds to the order in
which the conditions are to be satisfied. To change the order, select a target event and click on the [Up] or [Down]
buttons.

(3) Editing [Reset event] area
Reset events are always enabled.

2.15.5 Delete events

To delete any event and event condition you have set, select the event and click the button on the toolbar.
Note that it is not possible to delete the built-in events (Unconditional Trace event and Run-Break Timer event).

Remark 1. For the Break event of execution type, it is possible to delete the set event to click the event mark dis-
played in the Editor panel/Disassemble panel.

Remark 2. To delete all of the events and event conditions you have set at a time, select [Select All] from the context
menu, then click the button (note, however, that it is not possible to delete the built-in events).

2.15.6 Write comment to events

The user can write comments for each event that has been set.

To input comments, click the [Comment] area after selecting the event to input comments, then input directly the desired
text from the keyboard (the edit mode is cancelled by pressing the [Esc] key).

After editing the comments, complete the editing by pressing the [Enter] key or moving the focus to outside the edit
region.

Up to 256 characters can be inputted for the comments, and this is saved as the settings of the user during use.

2.15.7 Notes for setting events

This section describes notes for setting each type of event.

2.15.7.1 Maximum number of enabled events
2.15.7.2 Event types that can be set and deleted during execution
2.15.7.3 Other notes

2.15.7.1 Maximum number of enabled events

The number of events that can be set to Valid state simultaneously are subject to the following limitations.

Therefore, if this limit is exceeded when you set one or more new valid state events, some of the events that are already
set need to be Invalid state before you can set a new one.

The meaning of numbers in the table below is as follows:

X+y "Hardware Break (after execution): x" + "Hardware Break (access): y"

Table 2.20 Maximum Number of Enabled Events

Event Type Debug Tool to Use
IECUBE E1/E20/EZ Emulator/COM Port Simulator
Without OCD Trace Function With OCD
- i - Trace Function
8-bit bus width Except for 8-bit
products bus width products
Hardware Break 4 to gNote 1 0 0 0 paNote 4
(before execution)
Hardware Break 8 2 Note 2 2Note 3
(after execution)
Hardware Break 8 0
(access)
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Event Type Debug Tool to Use
IECUBE E1/E20/EZ Emulator/COM Port Simulator
Without OCD Trace Function With OCD
- i - Trace Function
8-bit bus width Except for 8-bit
products bus width products
Software Break 2000 0 2000 -
Trace 4+ 4N0te 5 _ _ 2N0te 3 32N0te 5
(trace start/trace end)
Point Trace 8 + ghote 6 - } 0 gaNote 6
Timer Result 4 + 4Note 5 R - - 1
(timer start/timer end)
Action (Printf) 100Note 7 0 100Note 7 p4Note 8
Note 1. Depending on the address and instruction to which the event is set (however, Hardware Break (before
execution) cannot be used in RAM area).
Note 2. A Hardware Break (after execution) and a Software Break are combined use.
Note 3. A Hardware Break and a Trace are exclusive of each other (i.e. if one is set, then the other will become
invalid). Total of 2 events (a trace start and a trace end) are available for a Trace.
Note 4. The before break/after break can be specified in the Property panel.
Note 5. In this version, only one group can be set (however, two or more Start/Stop events can be set).
Note 6. In this version, only one can be set (however, two or more conditions for this event can be set).
Note 7. Combination with Software Break events (however, up to 100 can be set regardless of their valid/invalid
state).
Note 8. Combination with Hardware Break events (before execution) (however, up to 64 can be set regardless of

their valid/invalid state).

2.15.7.2 Event types that can be set and deleted during execution

Types of events that can be set or removed during execution of the program or during execution of the tracer/timer are

described below.

The meaning of each mark in the table below is as follows:

i Possible
Iy Possible, if the program execution is allowed to pause for events
(Property panel >> [Debug Tool Settings] tab >> [Set Event While Running] category >> [Set
event by stopping execution momentarily] property >> [Yes])
A Impossible while tracer or timer is executing
- Impossible, or not supported
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Table 2.21

Event Types That Can be Set and Deleted during Execution

Event Type

Debug Tool to Use

IECUBE

E1/E20/EZ Emulator/COM Port

Without OCD Trace Function

8-bit bus width
products

Except for 8-bit
bus width products

With OCD
Trace Function

Simulator

Hardware Break
(before execution)

Hardware Break
(after execution)

O

Hardware Break
(access)

o O 0O

Software Break

Trace
(trace start/trace end)

Point Trace

Timer Result
(timer start/timer end)

Qo Ok

Action (Printf)

[

2.15.7.3 Other notes

- No events can be set to local variables.

- Events do not occur during step execution (including return execution) and program execution by selecting [Go to
Here] from the context menu.

- If the location set for an existing event changes to midway in an instruction because the program to debug has been
downloaded again, re-set the event using the following method.

- If debugging information is available:

The location setting of events is always moved to the beginning of the source text line.

- If debugging information is not available:
Depends on the [Automatic change method of event setting position] property in the [Download] category on the
[Download File Settings] tab of the Property panel.

- If a change to internal ROM/RAM changes the location the event is set to a hon-mapped area, then set events will not
occur (they will also not change to Invalid state /Suspended State on the Events panel).

- If you differentiate function or variable names by leading underscores, then CS+ may misrecognize them, and convert
symbols or make break event settings invalid. This applies for cases like when you have two functions, one named

_reset" and the other named "__reset".

- If there is code (text sections) to be ROMified, any software break event set for that code will be deleted during copy
to RAM. For this reason, no break will occur.

- For other than [Simulator]
Use a hardware break event.

- [Simulator]

Execution will not break even if a hardware break event is used, but it will break if the trace function or the timer
function is valid (on the [Debug Tool Settings] tab of the Property panel, specify [Yes] with the [Use trace func-
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tion]/[Use timer function] property on the [Trace]/[Timer] category).

- For other than [IECUBE]
If a software break event is set in a boot-swap area, then a break instruction will be written to the flash ROM.
For this reason, a break instruction will remain after the boot swap.

- [E1][E20][EZ Emulator][COM Port]
Use a hardware break event in a boot-swap area if you wish to.

- [Simulator]
Do not use a break event in a boot-swap area.

- For other than [Simulator]
Hardware Break events with access conditions and Point Trace events [IECUBE] cannot be set for 32-bit (4-byte)

variables.
Additionally, Hardware Break events with access conditions and Point Trace events [I[ECUBE] cannot be detected if a

single byte of a 16-bit (2-byte) variable is accessed.
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2.16 Use Hook Function

This section describes how to set hooks in the debug tool by using the hook function.

By setting a hook transaction, you can automatically change the values of the SFR/CPU register before and after down-
loading a load module or after resetting the CPU.

Configure the hook transaction in the [Hook Transaction Settings] category on the [Hook Transaction Settings] tab of the
Property panel.

Remark By setting a SFR by using the [Before download] property, for example, downloading can be executed at
high speeds. Downloading to the external RAM is also facilitated by using this function.

Figure 2.112 [Hook Transaction Settings] Category
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Table 2.22  Properties in [Hook Transaction Settings] Category

Property Description
Before download Perform the specified process immediately before downloading the load module
file.
After download Perform the specified process immediately after downloading the load module file.

After CPU reset under breaking | Perform the specified process immediately after resetting the CPU under breaking.

Before running Perform the specified process immediately before starting program execution.

After breaking Perform the specified process immediately after breaking program execution.

The properties in the [Hook Transaction Settings] category indicate the timing with which the hook process will be per-
formed. "[]" indicates the current number of specified processes (no hook processes are configured by default).
Specify the target process in the property for which you want the hook process to be performed.

To specify a process, select the target property, then open the Text Edit dialog box by clicking the [...] button that
appears on the right edge of the field.

Figure 2.113 Opening Text Edit Dialog Box
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Figure 2.114 Use Hook Function (Text Edit Dialog Box)
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In this dialog box, directly enter the desired process from the key board.
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The format for specifying processes is as follows:

[Process 1]:
Automatically overwrites the value of SFR with Value.
Specification format:

SFR-name Value

[Process 2]:

Automatically overwrites the value of CPU register with Value.
Specification format:

CPU-register-name Value

[Process 3]:

Automatically executes a script file which is specified with Python script path (absolute path or relative path from the
project folder).

Specification format:

Source Python-script-path

Caution You can use the following commands when you execute the Python script in the Hook process of the

debugger. Note that if you want to use other Python command, please use Hook command in the Python
console.

- debugger.Register.GetValue

- debugger.Register.SetValue

- debugger.Memory.GetValue

- debugger.Memory.SetValue
Remark 1. When specifying hook processes, lines starting with a hash mark "#" will be treated as comments.
Remark 2. A tab character can be used instead of the space character.

Up to 64 characters for one process, and up to 128 processes for each property can be set (one line in the [Text] area in
the Text Edit dialog box is equivalent to one processing).

After the specification of the process is complete, click the [OK] button to set the process to the Property panel.

Figure 2.115 Example of Hook Transaction

Text Edit
Teat:
DMGCO 000 .
4 |
[ ok |[ cmcal |[ Bemp
R20UT4857EJ0100 Rev.1.00 RENESAS Page 117 of 391

Nov 01, 2020



CS+Vv8.05.00 2. FUNCTIONS

2.17 Measuring Current Consumption [E2][Simulator]

Measurement of current consumption refers to measuring the amount of current consumption by a whole system to be
debugged [EZ2] or peripheral modules of within the MCU [Simulator].

Remark Measuring current consumption by the simulator is only available for devices that have peripheral
function simulations. Check which products are supported on the Renesas Web site.

[How to use]
The target for measurement differs between the use of the E2 emulator and the simulator.
The following explains the usage in both cases.

- With the E2 emulator

- With the simulator

- With the E2 emulator
In using the E2 emulator to measure current consumption, the current values in the target system as a whole are
measured.
For measurement of current consumption, the facility for supplying power to the target by the E2 emulator and the E2
expansion interface are used.
Accordingly, to use this facility, be sure to specify [Yes] for the [Power target from the emulator (MAX 200mA)]
property and [Use supplied power from the emulator] for the [Interface for supplying the power] property on the
[Connect Settings] tab in the Property panel before connecting the debug tool.

(1) Open the Measuring Current Consumption panel
Select [RL78 E2] as the debug tool, open the Solution List panel, and click on the [GO] button for measuring
current consumption. The Measuring Current Consumption panel [E2][Simulator] will open.

Figure 2.116 Measuring Current Consumption Panel [E2]
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(2) Setthe conditions (measurement conditions, trigger conditions, and monitoring points)
In measuring current consumption, you can acquire the pattern of transitions for the current value to be detected
by setting conditions in advance. The main settings that can be made in advance are measurement conditions,
trigger conditions, and monitoring points.

Remark Conditions are set as follows by default.
Operation after record memory is full: Overwrite to the record memory and continue execution
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Sampling time: 10us
Acquisition condition: All

No external trigger is used.
No monitoring points are set.

If you only want to measure the current as a trial, start the procedure from "(3) Start measurement”.

(@) Setthe measurement conditions
Set conditions regarding the recording of the measured current values in the Current Consumption
Measurement Condition Setting dialog box [E2] which is displayed by clicking on _'{'j | on the toolbar in the
Measuring Current Consumption panel [E2][Simulator]. )

Figure 2.117 Current Consumption Measurement Condition Setting Dialog Box

Measurerment Conditicn Settings *
Operation after racord memony (& full: | Stap program o
Sampling time: 10w o
Arquistion condition
Londtion: Al ot
Charnel:

Exdernal trigoer input bype:

Maritar points rengs -

i

<1>

<2>

<3>

Select the operation after recording memory becomes full
Select any operation from among the following after the memory used to record the current values in the E2
emulator becomes full.

- Overwrite to the record memory and continue execution
- Stop recording (continue to execute the program)
- Stop program

Select the sampling time
Select the sampling time for use in measurement from among the following.
1us, 2us, 5us, 10us, 20us, 50us, 100us, 200us, 500us, 1ms

Select the acquisition condition

An acquisition condition for recording the current values in the memory of the E2 emulator can be set so that
recording only starts when the specific condition has been satisfied.

The condition can be selected as one of the following.

- All
Record all current values that have been sampled after starting measurement without specifying specific
conditions.

- During detecting an external trigger input
This item selects recording in memory in response to the external trigger input facility of the E2 expansion
interface only while the specified signal is being detected.
When this is specified, the channel for input of the external trigger to be detected and the level of the signal
to be detected must be specified.
In addition, the external trigger input must have been correctly set before the debug tool is connected.

Remark For details on setting the external trigger input facility of the E2 expansion interface, refer to
the Application Note on the Current Consumption Tuning Solution (E2 Emulator, CS+).

- During monitor points
Specify the monitoring point to serve as the start condition in the left entry field and that to serve as the end
condition in the right entry field against [Monitor points range].
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The current values will be recorded from detection of the monitoring point specified as the start condition
until detection of the monitoring point specified as the end condition.
For details on the monitoring points, refer to "(c) Set monitoring points".

(b) Set the trigger condition
The E2 emulator is able to stop the program or output an external trigger signal in response to the value for
current being measured satisfying a specific condition.
Set the trigger condition in the Current Consumption Measurement Trigger Condition Setting dialog box [E2],
which is displayed by clicking on on the toolbar in the Measuring Current Consumption panel
[E2][Simulator].

Figure 2.118 Current Consumption Measurement Trigger Condition Setting Dialog Box
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<1> Specify whether to use the trigger facility
Select the checkbox for [Use trigger function] to use the trigger facility.
This checkbox is de-selected by default.

<2> Set the trigger action
Select the operation when a trigger is detected as either of the following.

- Stop program
Stop execution of the program.

- Output external trigger signal

R20UT4857EJ0100 Rev.1.00 RENESAS Page 120 of 391
Nov 01, 2020



CS+Vv8.05.00 2. FUNCTIONS

Output an external trigger through the E2 expansion interface.

Also make the following settings if an external trigger is to be output.

- Select a channel
Specify the channel for output of the external trigger through the E2 expansion interface.

- Select the type of signal to be output
Select whether a high pulse is to be output in response to the condition being satisfied or output of the high
level is to continue as long as the condition is being satisfied.
When a high pulse is to be output, also specify the pulse width.

Remark For details on the external trigger output facility, refer to the Application Note on the Current
Consumption Tuning Solution (E2 Emulator, CS+).

<3> Set the trigger condition
Select the trigger condition for the current value as [Over Threshold], [Under Threshold], [In Range], or [Out of
Range].
Specify the current value or range of current values to be detected as the trigger.

Caution For a range of current values, the value entered in the left field for entry must be lower than
that in the right field.

As well as the condition for the current value, a sub-condition (condition for the detection width) regarding the
time over which the condition is satisfied can be set. Specifying a width for detection can eliminate the
detection of noise that temporarily satisfies the condition.

The condition for the detection width is selectable as [Over threshold] (detecting the current value when the
condition continues to be satisfied for more than a specified time) or [In range] (detecting the current value
when the condition is satisfied over a time within the specified range).

Specify a multiple of the sampling time as the detection width.
Note that the actual time for detection also depends on the sampling time.

(c) Set monitoring points
A monitoring point is a facility for recording a timestamp when a specified line of source code is run.
When monitoring points are set, transitions of the execution time and the current values at the monitoring points
can be confirmed on a graph for measuring current consumption.
The monitoring points are indicated by colored vertical lines on the graph.

Remark Monitoring points are not supported for RL78/G10 devices.

Figure 2.119 Monitoring Point
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Monitoring points are set from [Monitor Point Setting] in the context menu after placing the cursor on the line of
the target source code that was opened in the Editor panel.

Figure 2.120 Context Menu in the Editor Panel
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A list of the monitoring points that are currently set is displayed under the Measuring Current Consumption

panel [E2][Simulator].

The monitoring points that have been set are enabled or disabled by the leftmost checkbox in this list or from the

context menu of the Editor panel.

Figure 2.121 List of Monitoring Points
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Monitoring points must be set at the addresses of NOP instructions. An attempt to set monitoring points at other
instructions or the debug tool not being able to detect the NOP instruction even if it is set as a monitoring point
leads to the monitoring points being forcibly disabled when measurement is started.

However, when the compiler in use for the project is V1.05.00 or later of CC-RL and when the source file is reg-
istered in the active project, the NOP instructions can be automatically inserted at the addresses where the
monitoring points are set before measurement, rebuilding and downloading are enabled. In this case,
monitoring points that have been set at any addresses are enabled. However, when the [CPU Reset after down-
load] property in the [Download] category on the [Download File Settings] tab in the Property panel is set to
[Yes], note that the monitoring points are forcibly reset by rebuilding and downloading.

(3) Start measurement
Start measuring current consumption by the target system by using the facilities of the E2 emulator.
Click on .,,.'._ or g on the toolbar in the Measuring Current Consumption panel [E2][Simulator].

Figure 2.122 Toolbar in the Measuring Current Consumption panel [E2]
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Caution Current consumption is not measured by clicking on | ﬁ.u in the Main window.

(a) Clickingon ' ¥
The project is rebuilt and downloaded before measurement starts.
However, if the device does not support monitoring points or the compiler used in the active project is a version
of CC-RL earlier than V1.05.00, rebuilding and downloading do not proceed.
When [Hold the build options for monitor point specified when measuring] in the Measuring Current
Consumption panel [E2][Simulator] is selected, the options which are specified for rebuilding and downloading
before measurement are reflected in the [Parameters of NOP instruction insertion for measuring current con-
sumption] property of the build tool.

(b) Clicking on * #p
The project is not rebuilt and downloaded before measurement starts.
Select this button when you want to measure current consumption without resets due to rebuilding and
downloading.
Note that this button is not displayed if the device does not support monitoring points or the compiler used in the
active project is a version of CC-RL earlier than V1.05.00.

(4) End measurement
Measurement ends at the same time as execution of the program is stopped.
Execution of the program can be stopped by setting a breakpoint or a trigger condition, or by clicking on @

(5) Display a graph
At the same time as measurement ends, a graph of current values showing the results of measurement is
displayed in the graph display area of the Measuring Current Consumption panel [E2][Simulator].
Check that the current values that are shown are as intended.

In the panel, dragging a cursor (the red vertical line) shows the time and the current value at the cursor location in
the information display area.

When the search facility is used, since the cursor is moved to the location where the search condition was
satisfied, the time and the current value at that location can be confirmed.

Markers A and B (green vertical dashed lines) can also be dragged to confirm the average current and maximum
current between the markers.

When a monitoring point is the target of the search, the location where processing to be confirmed was executed
can be identified immediately.

- With the simulator
When current consumption is measured on the simulator, the current values in the MCU are simulated and displayed.

(1) Open the Measuring Current Consumption panel
Select [RL78 Simulator] as the debug tool, open the Solution List panel, and click on the [GO] button for
measuring current consumption. The Measuring Current Consumption panel [E2][Simulator] will open.
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Figure 2.123 Measuring Current Consumption Panel [Simulator]
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Enable measurement of the current consumption

The facility for measuring current consumption is enabled or disabled by clicking on {!} on the toolbar in the
Measuring Current Consumption panel [E2][Simulator].

Enabling the facility simulates the current values when the program is executed.

Figure 2.124 Toolbar in the Measuring Current Consumption Panel [Simulator]
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Remark The facility for measuring current consumption is disabled immediately after the debug tool is

connected.

Start measurement
After the facility for measuring current consumption is enabled, measurement proceeds during normal execution
of the debugger initiated by, for example, clicking on | [g| Or [ [ on the toolbar in the Main window.

Remark Furthermore, measurement also proceeds in response to operations that place the debug tool in

the execution state, e.g. source-level step execution.

End measurement
Measurement ends at the same time as execution of the program is stopped.
Execution of the program can be stopped by setting a breakpoint, or by clicking on @

Display a graph

At the same time as measurement ends, a graph of current values showing the results of measurement is
displayed in the graph display area of the Measuring Current Consumption panel [E2][Simulator].

Check that the current values that are shown are as intended.

In the panel, dragging a cursor (the red vertical line) shows the time and the current value at the cursor location in
the information display area.

When the search facility is used, since the cursor is moved to the location where the search condition was
satisfied, the time and the current value at that location can be confirmed.

Markers A and B (green vertical dashed lines) can also be dragged to confirm the average current and maximum
current between the markers.

In addition, hovering the mouse cursor over a point on the graph displays a pop-up window showing the current
value in each peripheral module at that point. This makes it possible to confirm that the intended modules have
been enabled.

2. FUNCTIONS
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Figure 2.125 Displaying the Values for Current Consumption by Individual Modules
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2.18 Use the Simulator GUI [Simulator]

This section describes how to use the Simulator GUI.
Note that the function of the Simulator GUI described in this section is only supported when a microcontroller whose

Simulator supports peripheral function simulations is selected. Control the Simulator GUI via the Simulator GUI window
below.

This window appears automatically by default after connecting to the debug tool when a microcontroller whose Simula-
tor supports peripheral function simulations is selected and [Simulator] is selected as the debug tool to use.

Remark The Simulator GUI window and windows opened from it cannot be docked to the CS+ Main window.

Figure 2.126 Using Simulator GUI (Simulator GUI Window)
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The setting of the display of the Simulator GUI window can be configured in the [Simulator GUI] category on the [Debug
Tool Settings] tab of the Property panel as follows:

Configure the appropriate settings.

Caution After connecting to the debug tool, all the properties in this category will become invalid if a microcon-

troller whose Simulator does not support peripheral function simulations (instruction simulation version)
is selected.

Figure 2.127 [Simulator GUI] Category
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(1) [Display Simulator GUI]
Specify whether to display the Simulator GUI window from the drop-down list.
Select [Yes] to use the function of the Simulator GUI (default).
When you do not need to use the Simulator GUI, select [N0] to close the Simulator GUI window.

(2) [Display Simulator GUI on top of other windows]
This property appears only when the [Display Simulator GUI] property is set to [Yes].

Specify whether to display the Simulator GUI window in the forefront when program execution starts. Select [Yes]
to display it in the forefront (default).

2.18.1 Check the I/O waveform of the microcontroller

It is possible to check the /0 waveform of the microcontroller by clicking the [ button on the Simulator GUI window's
toolbar and opening the Timing Chart window (shown below).

This window displays a timing chart of the input and output signals of the microcontroller's pins.

See the section on the Timing Chart window for details about controlling the window.
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Figure 2.128 Checking 1/0 Waveform of Microcontroller (Timing Chart Window)
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2.18.2 Input signals to the pins

To configure the input signal to a pin, click the A on the Simulator GUI window's toolbar. The following Signal Data
Editor window opens.

You can use this window to set the input signal data for the input pin to a numerical value, to be input at an arbitrary
time.

See the section on the Signal Data Editor window for details about controlling the window.

Figure 2.129 Configuring Input Signal to Pin (Signal Data Editor Window)
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2.18.3 Perform serial communication

To configure serial communication, click the ﬂ] on the Simulator GUI window's toolbar. The following Serial window
opens.

This window provides serial I/0 features for communicating with the CPU's built-in serial interface. This enables you to
input data to the microcontroller's serial receiver pin, and acquire output data from its serial transmitter pin.

See the section on the Serial window for details about controlling the window.
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Figure 2.130 Performing Serial Communication (Serial Window)
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2.18.4 Use buttons, LEDs, level gauges, and other components

The Simulator GUI allows input manipulation and output display simulation by providing standard connected parts (but-
tons, LEDs, level gauges, etc.) in which the I/O block for peripheral I/O designed as a GUI interface.

To configure connected parts, click the E-E on the Simulator GUI window's toolbar. The following I/O Panel window
opens.

This window enables you to configure the various connected parts, building a dummy target system.

See the section on the /O Panel window for details about controlling the window.

Figure 2.131 Configuring Connected Parts (/O Panel Window)
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2.19 About Input Value

This section describes consideration to take when inputting values in each panel and dialog box.

2.19.1 Inputrule

Following is the rules for input to each panel/dialog box.

(1) Character set

Character sets that are allowed to input are as follows:

Table 2.23  List of Character Set

Character Set Outline

ASCII 1- byte alphabets, numbers, symbols

Shift-JIS 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji and 1-byte Katakana.

EUC-JP 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji and 1-byte Katakana.

UTF-8 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji (include Chinese charac-
ters) and 1-byte Katakana.

UTF-16 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji (include Chinese charac-
ters) and 1-byte Katakana.

(2) Escape sequence

Escape sequences that are allowed to input are as follows:

Table 2.24  Escape Sequence List

Escape Sequence Value Outline
\O0 0x00 null character
\a 0x07 Alert
\b 0x08 Backspace
\t 0x09 Horizontal tab
\n O0x0A New line
\v 0x0B Vertical tab
\f 0xoC Form feed
\r 0x0D Carriage return
\" 0x22 Double-quotation mark
\' 0x27 Single-quotation mark
\? Ox3F Question mark handled as a question mark if ? is entered.
\\ 0x5C Backslash
(3) Number

Notations allowed when entering numbers are as follows:

Table 2.25 Notation List

Notation

Outline

Binary number

Start with Ob and continues with the numbers from 0 to 1.
(Case insensitive for alphabets)
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Notation Outline
Octal number Start with 0 and continues with the numbers from O to 7.
Decimal Start without 0 and continues with the numbers from 0 to 9.
Hexadecimal number Start with Ox and continues with the numbers from 0 to 9 and alphabets a to f.
(Case insensitive for alphabets)
In the input area with the mark, prefix Ox is not needed.

(4)

(@)

Expression and operator

Expression represents constants, register name, SFR name and symbols and those connected with operators.
An expression comes in two types: an address expression and a watch-expression. The expression that requires
the address of a symbol is referred to as an address expression, and the one that requires the value of a symbol is

referred to as a watch-expression.

An address expression and operators

With an address expression, the address of a symbol is used to perform operations. Only when a CPU register
name is written, the value of the symbol is used to perform operations.
The basic input formats of address expressions are as follows:

Table 2.26  Basic Input Format of Address Expressions

Expression

Description

Name of a C language variableNot 1.2

Address of a C language variable

Expression [ExpressionN°'® 3]

Address of an array

Expression.Member name

Address of a structure/union/class member

Expression->Member name

Address of a structure/union/class member that is pointed to

Name of a CPU register

Value of the CPU register

Name of a SFR

Address of the SFR

Label nameN°® 4 EQU symbol nameNot 4
and [immediate value]

Address of a label, a value of an EQU symbol, and an immedi-
ate address

Integer constant Address
Note 1. It represents C language (C89/C99) variables.
Note 2. If the register is assigned the value of a C variable, an error results.
Note 3. The expression that is input as an index to an array is parsed as a watch-expression.
Note 4. If the label name or EQU symbol name includes a "$", be sure to enclose the name in "{ }" (e.g.

{$Label}).

When you specify the CPU register name "I", add ":REG" (e.g. I:REG) to distinguish it from the
keyword "I" that indicates an imaginary number.

From "2.19.2 Symbol name completion function”, the following expressions with operator can be constructed.

Table 2.27  Construction of Expressions with Operators

Expression Description
(Expression) Value of the parenthetical watch-expression
! Expression Inverts symbol
- Expression Logical negation
~ Expression Bit inversion
Expression * ExpressionN°t Multiplication
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(b)

Expression

Description

Expression / ExpressionN°®

Division

Expression % ExpressionNOte Remainder calculation
Expression + Expression™Note Addition
Expression . ExpressionN°® Subtraction

Expression & ExpressionNot

Logical multiplication by bits

Expression ~ Expression™N° Exclusive disjunction by bits
Expression | ExpressionN°® Logical sum by bits
Note Variables and functions can be combined by an operator only with variables, functions and inte-

ger constants.

Example: C variable name + SFR name

Watch-expression and operator

With watch-expression, the value of a symbol is used to perform operations. Only when the value does not
exist, the address of the symbol is used to perform operations (e.g. main( ) + 1).
The basic input formats of watch-expressions are as follows:

Table 2.28

Basic Input Format of Watch-expressions

Expression

Description

Name of a C language variableN°® 1

Address of a C language variable

Expression [Expression

Element of an array

Expression.Member name

Value of a structure/union/class member

Expression->Member name

Value of a structure/union/class member that is pointed to

*Expression

Value of pointer variable

&Expression

Location address

Name of a CPU register

Value of the CPU register

Name of a SFR

Value of the SFR

Label nameN°® 2, EQU symbol name
and [immediate value]

Note 2
ate address

Values of a label, a value of an EQU symbol, and an immedi-

Integer constant

Integer constant value

Floating constant

Floating point constant value

Character constant

Character constant value

Note 1.

Note 2.
{$Label}).

It represents C language (C89/C99) variables.

If the label name or EQU symbol name includes a "$", be sure to enclose the name in "{ }" (e.g.

Any imaginary number must be multiplied by an uppercase "I" (e.g. 1.0 + 2.0*l). When you spec-
ify the CPU register name "I", add ":REG" (e.g. :REG) to distinguish it from the keyword "I" that
indicates an imaginary number.

From "Table 2.28 Basic Input Format of Watch-expressions"”, the following watch-expressions with operator can
be constructed. For the operators listed in the table below, the expression is parsed according to C language

specifications.
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Table 2.29

Construction of Expressions with Operators

Expression

Description

(Expression)

Specifies the order in which operations are performed

! Expression Inverts symbol

- Expression Logical negation
Expression * ExpressionN°® Multiplication
Expression / ExpressionN°® Division

Expression % ExpressionNOte Remainder calculation
Expression + ExpressionNot® Addition

Expression . ExpressionN°® Subtraction

Expression & ExpressionNote Logical multiplication by bits

Expression ~ ExpressionN° Exclusive disjunction by bits

Note

Expression | Expression Logical sum by bits

Note Variables and functions can be combined by an operator only with variables, functions and inte-
ger constants.
Example: C variable name + SFR name
Caution 1.  When a char-type one-dimensional array is assigned to multiple locations in registers or memory as

shown below, no character string will be displayed in the value column of the Watch panel or Local Vari-
ables panel even after the array "array" has been registered with the panel.
char array[5] = "ABCD";

Caution 2.  When the selection for [Scope] in the Local Variables panel is not [Current], the values of variables
assigned to registers are not displayed correctly. Editing these values is also not possible.
Caution 3. When a defined variable satisfies both of the conditions given below, the Watch panel and Local Vari-

ables panel indicate the location of the entire variable rather than the location of its member variables.
[Conditions]

<1> The variable is assigned to two or more addresses or registers (i.e. two or more addresses or registers are
displayed in the address column).

<2> A structure-, class-, array-, or union-type member is defined in the variable.

[Example]

struct Mem {
long m_base;

}:
struct Sample {
long m_a;
struct Mem m_b; <- Condition <2>
};
main O {
struct Sample obj;
}

Display in the Watch and Local Variables panels:

obj* - { R1:REG, R2:REG } (struct Sample)
L ma 0x00000000 { R1:REG } (long)
L mb - { R1:REG, R2:REG } (struct Base)
L m_base 0x00000000 { R2:REG } (long)
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Caution 4.

panel.

2.19.2 Symbol name completion function

In case of a variable with the size beyond 0x10000, Value, Style and Address indicate "?" in the Watch

This function helps users input data by selecting one of the listed symbol names that exist in the program, when specify-
ing an address expression and so on.
The list of symbol names appears by pressing the [Ctrl] + [Space] keys when a part of the target symbol name is being

input in the text box that supports this function.

In this list, double-click the target symbol name (or press the [Space]/

[Enter] key after selecting it by using the [Up]/[Down] key) to complement the symbol name currently being input.
At this time, if a key other than the [Space]/[Enter] key is pressed or the focus moves to outside the panel/dialog box cur-
rently being operated, then the list of symbol names will disappear (the symbol name completion will not be performed).

Caution 1.

Caution 2.

Remark

symbol names will not appear.

If there are no character strings in the text box or there are no candidates of the symbol, then the list of

Since the information for use by the symbol name completion function is generated while symbols are

being downloaded, the time taken for downloading and the memory usage on the host machine will
increase when this function is enabled. Therefore, if you do not intend to use the symbol name comple-
tion function, we recommend invalidating this function by selecting [No] in the [Generate the information
for input completion] item in the Download Files dialog box ([Yes] is selected by default).

See the explanation of the corresponding panel/dialog box as to whether this function can be used or not

when inputting a symbol name.

Figure 2.132 Symbol Name Completion Function
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2.19.3 Icons for invalid input

In some of the dialogs in CS+, the »,) icon will appear at a point where incorrect characters are entered as a warning

sign.
Remark Placing the cursor over the ».’,] icon will pop up the information that indicates the characters to be
entered.
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A. WINDOW REFERENCE

Appendix A provides detailed explanations of windows/panels/dialog boxes used for debugging with CS+.

A.1 Description

Windows/panels/dialog boxes for debugging are listed below.

Table A.1

Window/Panel/Dialog Box List

Window/Panel/Dialog Box Name

Description

Main window

Controls the program execution. Various windows, panels and dialogs
can be opened from this window.

Project Tree panel

Selects the debug tool to use.

Property panel

Displays detailed information on the debug tool currently selected in the
Project Tree panel, and enables the settings of the tool to be changed.

Memory panel

Displays and modifies memory values.

Disassemble panel

Displays the results of memory value disassemble and is used to execute
line assemble and instruction level debug.

CPU Register panel

Displays the contents of CPU registers, and modifies register values.

SFR panel

Displays and modifies SFR values.

Local Variables panel

Displays and modifies local variables.

Watch panel

Displays and modifies registered watch-expression values.

Call Stack panel

Displays call stack information on function calls.

Trace panel

Displays trace data acquired from the debug tool.

Events panel

Displays detailed information on set events, switches the events between
enabled and disabled, or deletes them.

Output panel

Displays messages output from the build tool/debug tool/plug-ins, or the
results of batch searches carried out using the Find and Replace dialog
box.

Memory Mapping dialog box

Sets the memory mapping.

Download Files dialog box

Selects files to be downloaded and sets the download conditions.

Action Events dialog box

Sets action events.

Column Number Settings dialog box

Specifies the number of view columns of memory values on the Memory
panel.

Address Offset Settings dialog box

Specifies an offset value for the address display on the Memory panel.

Memory Initialize dialog box

Initializes memory.

Memory Search dialog box

Searches memory.

Print Address Range Settings dialog box

Sets the address range to print the contents of the Disassemble panel.

Trace Search dialog box

Searches trace data.

Combination Condition dialog box
[E1][E20]

Displays and modifies detailed information on a Combination Break event

Detail dialog box (for execution events)

Displays and modifies detailed information on an execution-related event.

Detail dialog box (for access events)

Displays and modifies detailed information on an access-related event.
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Window/Panel/Dialog Box Name

Description

Scroll Range Settings dialog box

Sets the scroll range for the Memory panel/Disassemble panel.

Go to the Location dialog box

Moves the caret to the specified position.

Data Save dialog box

Saves the settings and other data displayed in the respective windows/
panels/dialogs or saves upload data.

Specified Section dialog box

Specifies the range for skipping step execution.

Functions and Variables Access Table
panel

Displays the functions that access variables in the form of an orthogonal
table.

Measuring Current Consumption panel
[E2][Simulator]

This panel is central to the functionality of the solution for measuring cur-
rent consumption.

Current Consumption Measurement
Condition Setting dialog box [E2]

This dialog box is used to set measurement conditions in the Measuring
Current Consumption panel [E2][Simulator].

Current Consumption Measurement
Trigger Condition Setting dialog box [E2]

This dialog box is used to set trigger conditions in the Measuring Current
Consumption panel [E2][Simulator].

Current Consumption Measurement
Search dialog box [E2][Simulator]

This dialog box is used to specify and search the detailed conditions in
the Measuring Current Consumption panel [E2][Simulator].

Save Current Values dialog box [E2]

This dialog box is used to save the values for current in the Measuring
Current Consumption panel [E2][Simulator].

Virtual Board panel [Simulator]

This panel is used to configure the virtual target system and operate the
virtual components.

Table A.2

Simulator GUI Block-Dedicated Window/Dialog Box List

Window/Dialog Box Name

Description

Simulator GUI window

Opens and controls various simulator GUI's windows and dialog boxes.

Customize dialog box

Setting of window colors and fonts

Signal Data Editor window

Setting of input signal data

Loop dialog box

Setting of loop information for the Signal Data Editor window

Select Pin dialog box

Selection of display pins in the Signal Data Editor window and Timing
Chart window

Timing Chart window

Timing chart display of input and output signals

Search Data dialog box

Detailed search of the Timing Chart window

I/0 Panel window

Creation of dummy target system

Parts Button Properties dialog box

Setting of button pin connection information

Analog Button Properties dialog box

Setting of analog button pin connection information

Parts Key Properties dialog box

Setting of key matrix LED pin information

Parts Level Gauge Properties dialog box

Setting of level gauge pin connection information

Parts Led Properties dialog box

Setting of key matrix LED pin information

Parts Segment LED Properties dialog
box

Setting of 7/14-segment LED pin connection information

Parts Matrix Led Properties dialog box

Setting of matrix LED pin connection information
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Window/Dialog Box Name

Description

Parts Buzzer Properties dialog box

Setting of buzzer pin connection information

Pull up/Pull down dialog box

Setting of pull-up/pull-down resistor pin connection information

Object Properties dialog box

Setting of connection information for figure, character, and bitmap pins

Parts List dialog box

List display of object pin connection status in the 1/0O Panel window

Serial window

Serial interface communication window

Format (UART) dialog box

Setting of serial format (UART)

Format (CSI) dialog box

Setting of serial format (CSI)

Format (lIC) dialog box

Setting of serial format (1ICA)
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Main window

This window is automatically opened when CS+ is started up.
In this window, you can control the program execution and open panels for the debugging process.

Figure A.1  Main Window
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This section describes the following.
- [How to open]

- [Description of each area]

[How to open]

- From the Windows [Start] menu, select [All Programs] >> [Renesas Electronics CS+] >> [CS+ for CC].

In Windows 8.1, select [CS+ for CC (RL78,RX,RH850)] on the start screen.
In Windows 10, select Windows [Start] menu >> [All apps] >> [Renesas Electronics CS+] >> [CS+ for CC
(RL78,RX,RH850)].

Remark

[Description of each area]

(1) Menubar
Menu items related to the debugging are as follows:
Remark The items that can be selected in each menu can be customized using the User Setting dialog box.
(@) [View]

The [View] menu provides the following items and functions (default).

The following cascade menus are displayed to open the Watch panel.
These items are disabled when disconnected from the debug tool.

Watch

R20UT4857EJ0100 Rev.1.00 Page 137 of 391

Nov 01, 2020

RENESAS



CS+Vv8.05.00

A. WINDOW REFERENCE

Watchl Opens the Watch panel (Watchl).
Watch2 Opens the Watch panel (Watch?2).
Watch3 Opens the Watch panel (Watch3).
Watch4 Opens the Watch panel (Watch4).

Local Variable

Opens the Local Variables panel.

Call Stack Opens the Call Stack panel.
Memory The following cascade menus are displayed to open the Memory panel.
These items are disabled when disconnected from the debug tool.
Memoryl Opens the Memory panel (Memory1l).
Memory2 Opens the Memory panel (Memory2).
Memory3 Opens the Memory panel (Memory3).
Memory4 Opens the Memory panel (Memory4).
SFR Opens the SFR panel.

This item is disabled when disconnected from the debug tool.

CPU Register

Opens the CPU Register panel.
This item is disabled when disconnected from the debug tool.

Trace Opens the Trace panelNot,
This item is disabled when disconnected from the debug tool.
Disassemble The following cascade menus are displayed to open the Disassemble panel.

These items are disabled when disconnected from the debug tool.

Disassemblel

Opens the Disassemble panel (Disassemblel).

Disassemble2

Opens the Disassemble panel (Disassemble?2).

Disassemble3

Opens the Disassemble panel (Disassemble3).

Disassemble4

Opens the Disassemble panel (Disassemble4).

Event

Opens the Events panel.
This item is disabled when disconnected from the debug tool.

Virtual Board
[Simulator]

Opens the Virtual Board panel [Simulator].

This item is disabled when disconnected from the debug tool.

This item is also disabled even if a device for which the debug tool for the active proj-
ect does not support peripheral function simulations is currently connected to the
debug tool.

Show Current PC
Location

Displays the current PC position in the Editor panel.
This item is disabled when disconnected from the debug tool.

Back to Last Cursor
Position

Goes back to the position before jumping (see "2.6.2.4 Move to the symbol defined
location") to the defined location.
This item is disabled when disconnected from the debug tool.

Forward to Next Cur-
sor Position

Forwards to the position before operating [Back to Last Cursor Position].

Tag Jump

Jumps to the corresponding line/column in the corresponding file if the information of
a file name/line number/column number exists in the line at the caret position on the
Editor panel/Output panel (see "CS+ Integrated Development Environment User's
Manual: Editor").
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Note

[E1][E20][EZ Emulator][COM Port]

This item is available only when the selected microcontroller incorporates the OCD trace func-

tion.

[Debug]

The [Debug] menu provides the following items and functions (default).

Download

Downloads the specified file(s) into the debug tool currently selected in the active
project.

If CS+ is disconnected from the debug tool at this time, it is automatically connected
to the debug tool before a download is executed.

This item is disabled during program execution/build (not including rapid build) exe-
cution.

Build & Download

Builds a project and executes a download to the debug tool currently selected in the
active project after the build is complete. If CS+ is disconnected from the debug tool
at this time, it is automatically connected to the debug tool before a download is exe-
cuted.

This item is disabled during program execution/build (not including rapid build) exe-
cution.

When the build has failed, download will not be executed.

Rebuild & Download

Rebuilds a project and executes a download to the debug tool currently selected in
the active project after the rebuild is complete. If CS+ is disconnected from the
debug tool at this time, it is automatically connected to the debug tool before a down-
load is executed.

This item is disabled during program execution/build (not including rapid build) exe-
cution.

When the rebuild has failed, download will not be executed.

Connect to Debug
Tool

Connects to the debug tool currently selected in the active project.

This item is disabled while connected to the debug tool, during build (not including
rapid build) execution or if the version of compiler being used is not supported by
CS+.

Hot Plug-in Connects to the debug tool currently selected in the active project via the hot plug-in
[E1][E20] function, in order to debug the target system currently running (see "2.4.3 Connect
to the debug tool using hot plug-in [E1][E20]").
This item is disabled while connected to the debug tool.
Upload... Opens the Data Save dialog box to save the memory contents.

This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool.

Disconnect from
Debug Tool

Disconnects from the currently connected debug tool.
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool.

Using Debug Tool

The following cascade menus are displayed to select the debug tool to use.
This item is disabled while connected to the debug tool.

RL78 IECUBE Uses IECUBE as the debug tool.
RL78 E2 Uses E2 as the debug tool.
RL78 E2 Lite Uses E2 Lite as the debug tool.

RL78 E1(Serial)

Uses E1 with serial communication method as the debug tool.

RL78 E20(Serial)

Uses E20 with serial communication method as the debug tool.

RL78 EZ Emulator

Uses EZ Emulator with an evaluation kit and so on.

RL78 COM Port

Uses COM Port as the debug tool.

RL78 Simulator

Uses Simulator as the debug tool.
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Stop Forcibly stops the program currently being executed.
This item is disabled when the program is already halted or disconnected from the
debug tool.

Go Executes the program from the current PC position.

Execution of the program will be stopped when the condition of a set break event is
met.

This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool.

Ignore break and go

Executes the program from the current PC position.

Execution of the program continues, ignoring set break events and action events.
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool.

Step In Executes the program step by stepN°® from the current PC position (Step in execu-
tion).
However, in the case of a function call, the program is stopped at the beginning of the
function having been called.
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool.

Step Over Executes the program step by stepNOte from the current PC position (Step over exe-
cution).
In the case of a function call by the CALL instruction, all the source lines/instructions
in the function are treated as one step and executed until the position where execu-
tion returns from the function (step-by-step execution will continue until the same
nest is formed as when the CALL instruction has been executed).
In the case of an instruction other than CALL, operation is the same as when [Step
In] is selected.
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool.

Return Out Executes the program until execution returns from the current function (or returns to
the calling function)N°®(Return out execution).
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool.

CPU Reset Resets the CPU (does not execute a program)
This item is disabled during build (not including rapid build) execution or when dis-
connected from the debug tool.

Restart Resets the CPU and then executes the program from the reset address.

This item is disabled during build (not including rapid build) execution or when dis-
connected from the debug tool.

Rewind debug tool
state

Rewinds the debug tool to the last state that was automatically saved.

Note that the data to be rewound is limited to memory and register values that can be
read or written.

To use this debugging function, it has to be set so in the Option dialog box.

Save debug tool state

The following menus are relevant to saving and restoring of the state of the debug
tool.

Note that the data to be saved is limited to memory and register values that can be
read or written.

Restore debug tool
state n

Restores the state of the debug tool from the n-th data file.

Save debug tool
state n

Saves the current state of the debug tool in a file as the n-th data.

Note

Step execution can be carried out either in units of source lines or in units of instructions.

For details, see "2.7.3 Execute programs in steps".

Debug toolbar
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The debug toolbar includes the buttons that control the execution of programs.
The debug toolbar provides the following buttons and functions (default).

Remark 1. The buttons on the toolbar can be customized using the User Setting dialog box. Furthermore, a
new toolbar can be created using the same dialog box.

Remark 2. A Group of toolbar displayed can be selected with the context menu that is displayed by right-click-
ing on the toolbar.

Executes the build of a project and downloads the file into the debug tool currently selected in the
active project. If CS+ is disconnected from the debug tool at this time, it is automatically con-
nected to the debug tool before a download is executed.

This item is disabled during program execution/build (not including rapid build) execution.

When the build has failed, download will not be executed.

The function of this item is the same as that of [Build & Download] in the [Debug] menu.

= Downloads the specified file(s) into the debug tool currently selected in the active project.

If CS+ is disconnected from the debug tool at this time, it is automatically connected to the debug
tool before a download is executed.

This item is disabled during program execution/build (not including rapid build) execution.

The function of this item is the same as that of [Download] in the [Debug] menu.

Resets the CPU (does not execute a program)

This item is disabled during build (not including rapid build) execution or when disconnected from
the debug tool.

The function of this item is the same as that of [CPU Reset] in the [Debug] menu.

Forcibly stops the program currently being executed.
This item is disabled when the program is already halted or disconnected from the debug tool.
The function of this item is the same as that of [Stop] in the [Debug] menu.

Executes the program from the current PC position.

Execution of the program will be stopped when the condition of a set break event is met.

This item is disabled during program execution/build (not including rapid build) execution or when
disconnected from the debug tool.

The function of this item is the same as that of [G0] in the [Debug] menu.

Executes the program from the current PC position.

Execution of the program continues, ignoring set break events and action events.

This item is disabled during program execution/build (not including rapid build) execution or when
disconnected from the debug tool.

The function of this item is the same as that of [Ignore break and go] in the [Debug] menu.

Resets the CPU and then executes the program from the reset address.

This item is disabled during build (not including rapid build) execution or when disconnected from
the debug tool.

The function of this item is the same as that of [Restart] in the [Debug] menu.

&= Executes the program step by stepNOte from the current PC position (Step in execution).
However, in the case of a function call, the program is stopped at the beginning of the function
having been called.

This item is disabled during program execution/build (not including rapid build) execution or when
disconnected from the debug tool.

The function of this item is the same as that of [Step In] in the [Debug] menu.

7= Executes the program step by stepNOte from the current PC position (Step over execution).

In the case of a function call by the CALL instruction, all the source lines/instructions in the func-
tion are treated as one step and executed until the position where execution returns from the
function (step-by-step execution will continue until the same nest is formed as when the CALL
instruction has been executed).

In the case of an instruction other than CALL, operation is the same as when the button is
clicked.

This item is disabled during program execution/build (not including rapid build) execution or when
disconnected from the debug tool.

The function of this item is the same as that of [Step Over] in the [Debug] menu.
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&= Executes the program until execution returns from the current function (or returns to the calling
function)N°®® (Return out execution).

This item is disabled during program execution/build (not including rapid build) execution or when
disconnected from the debug tool.

The function of this item is the same as that of [Return Out] in the [Debug] menu.

Disconnects from the currently connected debug tool.
This item is disabled during program execution/build (not including rapid build) execution or when

disconnected from the debug tool.
The function of this item is the same as that of [Disconnect from Debug Tool] in the [Debug]

menu.

Note Step execution can be carried out either in units of source lines or in units of instructions.
For details, see "2.7.3 Execute programs in steps".

(3) Panel display area
This area displays the various panels.
For details on the display content, see the sections describing the individual panels.

(4) Statusbar
Statusbar displays the following items of information.

Figure A.2  Statusbar

Eceotes CPU resst, _maine(x2 (m]BREAK Pow OF [ DxO0ibe |ooRL7S IECUBE () 178.281p (W [[3E] |
| | | | | | i |
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(a) Status message
This area displays the following messages and other information.

- A brief explanation of the selected menu item
- A message reporting that an invalid value has been input in the panel/dialog

- A message reporting that the specified character string has not been found as a result of a search using the
Find and Replace dialog box

- A statement of the cause of the break when a break has occurred (see "2.8 Stop Programs (Break)")

(b) Focus panel status information
This area displays status information on the panel currently having the focus.
Note that nothing is displayed here for a panel that has no status information.

() Running state
This area displays the state of the program with the following icons and character strings.
Note that nothing is displayed here when the debug tool is not connected.

State of Program Displayed Content
Under execution IEI RUN
Now halted [m] BREAK
Step execution in progress IEI STEP

(d) CPU status
This area displays the current CPU status of the debug tool. When there is the possibility that the CPU is in two

or more statuses, the corresponding display contents are displayed separated by "&".
Note that nothing is displayed here when the debug tool is not connected.
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Debug Tool Displayed Content CPU Status

IECUBE Halt In HALT mode
Stop In STOP mode
Wait In wait state
Reset In reset state
Pow Off Power not supplied to the target

E1/E20 Reset In reset state

EZ Emulator

COM Port Pow Off Power not supplied to the target

Simulator Halt In HALT mode
Stop In STOP mode
Reset In reset state

Remark Nothing is displayed here when the CPU is in status other than those listed above.
(e) Current PC position

(f)

This area displays the current PC position with a hexadecimal value. When this area is clicked, the caret moves
to the current PC position on the Editor panel.

In addition, when the mouse pointer is placed over this area, a pop-up window appears to display the following
information. Note, however, that nothing is displayed here when the debug tool is not connected.

- Current PC: Ox current PC value (source name#line countNOte)

Note "symbol name+offset value" is displayed when acquisition of information is impossible.
Remark "Running" is displayed in this area during execution of a program.

Connection state
This area displays the current state of connection with the debug tool using the following icons and character
strings.

Connection State Displayed Content

Connected =3 Debug tool name

Disconnected 12 DISCONNECTED

(9) Run-Break Timer measurement result
This area displays the result of measurement by the Run-Break Timer event (the unit of value used differs
depending on the measurement amount). See "2.12.2 Measure execution time until stop of the execution".
Note that nothing is displayed here when the debug tool is not connected.
Condition Displayed Content
Un-measuring Not measured
Under measurement Measuring
When a timer measurement overflow has OVERFLOW
occurred
(h) Debug tool state [[ECUBE][Simulator]

This area displays the current state of debug tool's functions using the following icons and character strings.
When a function is stopped, clicking the appropriate icon enables the state to be switched between "Use" and
"Not use"Note,

Note that nothing is displayed here when the debug tool is not connected.

Function Being Executed Stopped (Use) Not Use

Trace By ¥y
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Function Being Executed Stopped (Use) Not Use
Timer 4] D £
Coverage A a1
Note [IECUBE]

Switching is impossible because the trace function, the timer function and the coverage function
are always used (the icon for "Not use" is not displayed).

[Simulator]

The result of switching will be reflected in the setting of the [Use trace function]/[Use timer func-
tion]/[Use coverage function] property in the [Trace]/[Timer]/[Coverage] category on the [Debug

Tool Settings] tab of the Property panel.
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Project Tree panel

This panel is used to display the project components (microcontroller, build tool, debug tool, etc.) in a tree structure.
On this panel, you can select or change the debug tool to use.

Figure A.3  Project Tree Panel
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The following items are explained here.
- [How to open]
- [Description of each area]

- [Context menu]

[How to open]

- From the [View] menu, select [Project Tree].

[Description of each area]

(1) Project tree area
Project components are displayed in tree view with the following given node.

Node Description

RL78 Debug tool name (Debug tool) Debug tool name:

The debug tool (IECUBE, E2, E2 Lite, E1(Serial), E20(Serial),
EZ Emulator, COM Port or Simulator) currently being used in
the project is displayed.

[Simulator] is selected by default.

Select the debug tool node to configure with the Property panel. If the Property panel is not being opened, double-
click the node to open the corresponding Property panel.
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[Context menu]

Using Debug Tool The following cascade menus are displayed to select the debug tool to use.
RL78 IECUBE Uses IECUBE as the debug tool.
RL78 E2 Uses E2 as the debug tool.
RL78 E2 Lite Uses E2 Lite as the debug tool.
RL78 E1(Serial) Uses E1 with serial communication method as the debug tool.
RL78 E20(Serial) Uses E20 with serial communication method as the debug tool.
RL78 EZ Emulator Uses EZ Emulator with an evaluation kit and so on.
RL78 COM Port Uses COM Port as the debug tool.
RL78 Simulator Uses Simulator as the debug tool.
Property Displays the selected category node's property in the Property panel.
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Property panel

This panel is used to display and set the debug tool operation environment that is selected in the Project Tree panel.

Figure A.4  Property Panel (When IECUBE Is Selected)
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This section describes the following.

- [How to open]

- [Description of each area]

- [[Edit] menu (Property panel-dedicated items)]

- [Context menu]

[How to open]

- On the Project Tree panel, select the [RL78 Debug tool name (Debug Tool)] node to use, and then select [Property] from
the [View] menu or the context menu.

- On the Project Tree panel, double-click the [RL78 Debug tool name (Debug Tool)] node to use.

Remark If this panel has been opened, the detailed information on the debug tool is displayed by selecting the
[RL78 Debug tool name (Debug Tool)] node on the Project Tree panel.

[Description of each area]

(1) Detailed information display/change area
In this area, the detailed information on the debug tool that is selected in Project Tree panel is displayed by cate-
gory in the list. Also, you can directly change its settings.
The [E] mark is indicates all the items in the category are expanded. The [# mark indicates all the items are col-
lapsed. You can expand/collapse the items by clicking these marks or double-clicking the category name.
Note that only the hexadecimal number is allowed in the text box if the mark is displayed in the property con-
figuration area.
For details on the information/how to setup in the category and property items contained in it, see the section
explaining the corresponding tab.

(2) Tab selection area
Categories for the display of the detailed information are changed when each tab is selected.
In this panel, following tabs are contained (see the section explaining each tab for details on the display/setting on
the tab).
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Connect Settings] tab
Debug Tool Settings] tab

DataFlash Emulation Settings] tab [[ECUBE]

[
[
- [Flash Self Emulation Settings] tab [[ECUBE]
[
[Download File Settings] tab

[

Hook Transaction Settings] tab

[[Edit] menu (Property panel-dedicated items)]

Undo Undoes the latest property value editing being done.

Cut Deletes the selected character string(s) and copies them to the clipboard while editing the
property value.

Copy Copies the contents of the selected range to the clipboard as character string(s).

Paste Pastes the contents of the clipboard to the property value while editing the property value.
Delete Deletes the selected character string(s) while editing the property value.

Select All Selects all the character strings in the selected property while editing the property value.

[Context menu]

[While not editing the property value]

Reset to Default Restores the selected setting of the property item to default value.

Reset All to Default Restores all the selected settings of the property items on the tab to default value.

[While editing the property value]

Undo Undoes the latest property value editing being done.

Cut Deletes the selected character string(s) and copies them to the clipboard while editing the
property value.

Copy Copies the contents of the selected range to the clipboard as character string(s).

Paste Pastes the contents of the clipboard to the property value while editing the property value.

Delete Deletes the selected character string(s) while editing the property value.

Select All Selects all the character strings in the selected property while editing the property value.
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[Connect Settings] tab

This tab is used to display the detailed information categorized by the following and the configuration can be changed.

(1) [Internal ROM/RAM]

(2) [Clock]

(3) [Connection with Emulator] [E1] [E20]

(4) [Connection with Target Board] [[ECUBE][E1][EZ Emulator][COM Port]
(5) [E2 Expansion Interface] [E2]

(6) [Flash] [E1][E20][EZ Emulator][COM Port]

(7) [Hot Plug-in] [E1][E20]

(8) [Configuration] [Simulator]

[Description of each category]

(1) [Internal ROM/RAM]
The detailed information on internal ROM/RAM is displayed and its configuration can be changed.

Caution You should be careful not to overlap the area with other memory mapping area.
Size of internal Display and change the internal ROM size of the selected microcontroller.
ROM[KBytes] - -

Default Internal ROM size of the selected microcontroller
Modifying | [IECUBE][Simulator]
Select from the drop-down list.
[E1][E20][EZ Emulator][COM Port]
Changes not allowed
Available | Depends on the selected microcontroller.
values
Size of internal Display and change the internal RAM size of the selected microcontroller.
RAM[Bytes] ) .
Default Internal RAM size of the selected microcontroller
Modifying | [IECUBE][Simulator]
Select from the drop-down list.
[E1][E20][EZ Emulator][COM Port]
Changes not allowed
Available | Depends on the selected microcontroller.
values
Size of DataFlash Displays the size of the data flash memory area of the selected microcontroller.
memory[KBytes] ) .
(except [Simulator]) | Default Data flash memory size of the selected microcontroller
Modifying | Changes not allowed
(2) [Clock]

The detailed information on clocks is displayed and its configuration can be changed.
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Main clock source Select the main clock source to input to the CPU.
[IECUBE]

Default Generate by emulator

Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug
tool.

Available | Generate by emulator | Uses a clock generated inside IECUBE.

values -
External Uses a main clock (square wave) on the target
board.
Clock socket Uses a clock of the transmitter on the clock
socket.

Main clock frequency | Specify the main clock frequency in MHz unit. Not 1

[MHz] [[ECUBE]

This property appears only when the [Main clock source] property is set to [Generate
by emulator].

Default [IECUBE][Simulator]
4.00

[E1][E20][EZ Emulator][COM Port]
Using internal clock

Modifying | Select from the drop-down list or directly enter from the keyboard.

Available | [IECUBE]

values - Either one of the following from the drop-down listN°® 2

1.00, 2.00, 3.00, 3.57, 4.00, 4.19, 4.91, 5.00, 6.00, 8.00, 8.38, 10.00,
12.00, 16.00, 20.00 (unit: MHz)
[E1][E20][EZ Emulator][COM Port]Note 3

- Either one of the following from the drop-down list
Using internal clock, 2.00, 3.00, 3.57, 4.00, 4.19, 4.91, 5.00, 6.00, 8.00,
8.38, 10.00, 12.00, 16.00, 20.00 (unit: MHz)

- Directly enter the numbers ranged below
0.001 to 99.999 (unit: MHz)
[Simulator]

- Either one of the following from the drop-down list
2.00, 3.00, 3.57, 4.00, 4.19, 4.91, 5.00, 6.00, 8.00, 8.38, 10.00, 12.00,
16.00, 20.00 (unit: MHz)

- Directly enter the numbers ranged below
0.001 to 99.999 (unit: MHz)

Sub clock source Select the sub clock source to input to the CPU and peripheral microcontrollers.
[IECUBE]

Default Generate by emulator

Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug
tool.

Available | Generate by emulator | Uses a clock generated inside IECUBE.
values

External Uses a main clock (square wave) on the target
board.
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Sub clock fre- Specify the sub clock frequency in kHz unit. Not€ 1

quency[kHz] [IECUBE]

This property appears only when the [Sub clock source] property is set to [Generate
by emulator].

Default [IECUBE][Simulator]
32.768

[E1][E20][EZ Emulator][COM Port]
Using internal clock

Modifying | Select from the drop-down list or directly enter from the keyboard.

Available | [IECUBE]
values 32.768 or 38.40 (unit: kHz)
[E1][E20][EZ Emulator][COM Port]

- Either one of the following from the drop-down list
Using internal clock, 32.768, 38.40 (unit: kHz)

- Directly enter the numbers ranged below
0.001 to 99.999 (unit: kHz)
[Simulator]

- Either one of the following from the drop-down list
32.768 or 38.40 (unit: kHz)

- Directly enter the numbers ranged below
0.001 to 99.999 (unit: kHz)

Monitor clock Select a clock for monitor programs to operate while the program is stopped.
[E1][E20]
[EZ Emula- Default System

tor][COM Port] Modifying | Select from the drop-down list.

Available | System Operates with main clock.
values . ;
User Operates with the clock that the program speci-
fied.

Select Timer/Trace Select the clock frequency for using timer/trace function.

clock frequency
[Simulator] Default CPU clock frequency

Modifying | Select from the drop-down list.

Available | CPU clock frequency | Uses the CPU clock frequency.

values
Specify clock fre- Specifies an arbitrary frequency (property items to
quency specify become valid in the lower area).
Unit of Timer/Trace Select the unit of the clock frequency for timer/trace.
clock frequency This property appears only when the [Select Timer/Trace clock frequency] property is
[Simulator] set to [Specify clock frequency].

Default MHz

Modifying | Select from the drop-down list.

Available | MHz The unit of the frequency is in MHz.
values
kHz The unit of the frequency is in kHz.
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Timer/Trace clock The operation of this property differs depending on the specification with the [Select
frequency Timer/Trace clock frequency] property.

[Simulator] - When [Specify clock frequency] is specified
Specify the clock frequency for timer/trace.
- When [CPU clock frequency] is specified, displays the following (changes not
allowed)
While disconnected from the debug tool:  [---_---]
While connected to the debug tool: [CPU clock frequency]
Default 4.00
Modifying | Directly enter from the keyboard.
Available | 1 kHz to 99.999 MHz
values Unit is depending on the specification with the [Unit of Timer/Trace clock
frequency] property.
Note 1. [E1][E20][EZ Emulator][COM Port]
This clock frequency is used to synchronize the communication between emulator and the host
machine. This specification is not for the frequency of the CPU operation.
Note 2. You can also select the frequency greater than 20.00 MHz, depending on the selected microcon-
troller.
Note 3. When using X1/X2 oscillation, specify the clock frequency.

When using an external clock oscillation with the embedded PLL circuit, specify the frequency of
the transmitter/resonator (the frequency before the setting of the PLL clock).

(3) [Connection with Emulator] [E1] [E20]

Emulator serial No. Select the serial No. of the emulator to be connected.N°®

Default Blank
How to By selecting from the drop-down list
change However, changeable only when disconnected from the debug tool

Specifiable | Depends on the emulator used.
value

Note

If an attempt is made to connect the emulator when this category is blank, the serial number of the
emulator that is found first by search will be automatically selected and connection is made. The
serial number of the emulator that is automatically selected in such a case will not be saved in the
project information.

(4) [Connection with Target Board] [[ECUBE][E1][EZ Emulator][COM Port]
The detailed information on the connection to the target board is displayed and its configuration can be changed.
Note that this category does not appear if no property displayed exists according to the type of the selected micro-

controller.
Communication port | Select the communications port.
[COM Port] The drop-down list is updated every time drop down.
Default Blank
Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug
tool.
Available | Depends on the host machine used.
values
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Reset control pin Select the reset control pin.
[COM Port]

Default DTR

Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug
tool.

Available | DTR Use DTR.
values

RTS Use RTS.

Connecting with tar- | Select if the target board is connected to IECUBE or not.

get board
[IECUBE] Default No
Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug
tool.
Available | Yes Target board is connected.
values )
No Target board is not connected.
Low voltage OCD Select whether to use a low voltage OCD board.
board This property appears only when the selected microcontroller supports a low voltage
[E1] OCD board.
[EZ Emulator]
Default No

Modifying | Select from the drop-down list.

Available | Yes Uses a low voltage OCD board.
values
No Does not use a low voltage OCD board.

Power target from Select whether to supply power to the target board from E1.
the emulator (MAX This property appears only when the [Low voltage OCD board] property is set to [No] if
200mA) it is displayed.
(E1]

Default No

Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug

tool.
Available | Yes Supplies power to the target board.
values
No Does not supply power to the target board.

Interface for supply- | Select the interface for supplying the power to the target board from the emulator.

ing the power
[E2] Default USER I/F

Modifying | Select from the drop-down list.

Available | USER I/F Uses the user interface.
values

E2 expansion I/F Uses the E2 expansion interface.
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Supply voltage Select the power voltage supplied to the target board.
[E1] This property appears only when the [Power target from the emulator (MAX 200mA)]

®)

(6)

property is set to [Yes].

Default 3.3V

Modifying | [E1]
Select from the drop-down list.
[E2]

Select from the drop-down list or directly enter from the keyboard.

Available
values

[E1]
3.3,5.0
[E2 Lite]
3.3
[E2]

- Either one of the following from the drop-down list
3.3,50

- Directly enter the numbers ranged below
1.8t0 5.0, or 0 (unit: V)

The detailed information

[E2 Expansion Interface] [E2]

on the E2 expansion interface is displayed and its configuration can be changed.

Interface for supply-

Select whether to use the E2 expansion interface.

ing the power
[E2]

Default No use

Modifying | Select from the drop-down list.

Available | No use Does not use the E2 expansion interface.
values

Use the power sup-
plied from the target

Uses the E2 expansion interface by the power
supplied to the target.

Use supplied power
from the emulator

Uses the E2 expansion interface by the supplied
power from the emulator.

[Flash] [E1][E20][EZ Emulator][COM Port]

The detailed information

on the flash memory writing is displayed and its configuration can be changed.

Security ID

Specify a security ID for reading codes in the internal ROM or internal flash memo-
Note
ry "o,

This property appears only when the selected microcontroller supports the ROM secu-
rity function (security ID) for flash memory.

Default 00000000000000000000

Modifying | Directly enter from the keyboard.
Note that changes can be made only when disconnected from the debug
tool.

Available | 0x0 to OxFFFFFFFFFFFFFFFFFFFE in hexadecimal number

values

Permit flash pro-

Select whether to enable flash rewrite.

rammin
9 9 Default Yes

Modifying | Select from the drop-down list.

Available | Yes Enables flash rewrite.

values

No Disables flash rewrite.
The flash memory area cannot be rewritten at all from the debug
tool.
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Use wide voltage
mode

Select whether to rewrite the flash memory with the wide voltage mode.
This property appears only when the selected microcontroller supports the wide voltage
mode for the flash memory rewriting.

Default Yes

Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug
tool.

Available | Yes Rewrites the flash memory with the wide voltage mode.

values
No Rewrites the flash memory with the normal mode.

Erase flash ROM
when starting

Select whether to erase flash ROM when connecting to the debug tool.
This property appears only when the [Permit flash programming] property is set to [Yes].

[E1][E20]

When conducting hot plug-in connection, the setting of this property will be ignored
and flash ROM will not be erased.

Default No
Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug
tool.
Available | Yes Erases the flash ROM when connecting to the debug tool.
values Note that after connecting to the debug tool, this property auto-
matically selects [No].
No Does not erase flash ROM when connecting to the debug tool.
Note For details on the on-chip debug security ID, see User's Manual of the emulator.

(7) [Hot Plug-in] [E1][E20]

The detailed information on hot plug-in connection is displayed and its configuration can be changed.
Note that this category appears only when the selected microcontroller incorporates the hot plug-in function.

Retrying interval[ms]

Specify the interval in 1-ms units for retrying connection in the case of hot plug-in con-
nection when the emulator fails to communicate with the microcontroller on the target

board.
Default 1000
Modifying | Directly enter from the keyboard.
Note that changes can be made only when disconnected from the debug
tool.
Available | 0 to 60000 in decimal number
values
Number of times of Specify the number of times for retrying connection in the case of hot plug-in connection
retrying when the emulator fails to communicate with the microcontroller on the target board.
Default 3
Modifying | Directly enter from the keyboard.
Note that changes can be made only when disconnected from the debug
tool.
Available | 0 to 3 in decimal number
values

(8) [Configuration] [Simulator]
The detailed information when customizing the simulator is displayed and its configuration can be changed.
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Use simulator config-
uration file

Select whether to use the simulator configuration file to perform user customization
(adding of user models) of the simulator.

Default No

Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug
tool.

Available | Yes Uses the simulator configuration file.

values i ) —
No Does not use the simulator configuration file.

Simulator configura-
tion file

Specify the simulator configuration file to be use.
This property appears only when the [Use simulator configuration file] property is set to

[Yes].
Default Blank
Modifying | Directly enter from the keyboard, or specify with the Select Simulator Con-

figuration File dialog box that is opened by clicking the [...] button.
Note that changes can be made only when disconnected from the debug
tool.
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[Debug Tool Settings] tab

This tab is used to display the detailed information categorized by the following and the configuration can be changed.

(1) [Memory]

(2) [Access Memory While Running]

(3) [Set Event While Running] [IECUBE]
(4) [E2 Expansion Interface] [E2]

(5) [Break]

(6) [Fail-safe Break] [[ECUBE]

(7) [Trace]

(8) [Timer] [IECUBE][Simulator]

(9) [Coverage] [[ECUBE][Simulator]
(10) [Mask for Input Signal] (except [Simulator])
(11) [Virtual Board] [Simulator]

(12) [Simulator GUI] [Simulator]

(13) [Step function]

[Description of each category]

(1) [Memory]
The detailed information on memories is displayed and its configuration can be changed.

Memory mappings Current memory mapping status is displayed by the types of memory areaNo®©,

Default [Sum total by microcontroller's inherent type of memory mapped area]

Modifying | Changes not allowed

Displayed | Displays the memory mapping status by the types of memory area.
Content The following detailed information is displayed by clicking the "+" mark of
each memory type.

- Memory type
- Start address

- End address

- Access width[bits]
Verify on writing to Select whether to perform a verify check when the memory value is initialized.
memory
(except [Simulator]) | Default Yes
Modifying | Select from the drop-down list.
Available | Yes Executes the verify check.
values -
No Does not execute the verify check.
Note The type is of the memory mapping area registered in the device file.

(2) [Access Memory While Running]
The detailed information on memory accesses while executing a program (real-time display update function: see

"2.9.1.4 Display/modify the memory contents during program execution") is displayed and its configuration can be
changed.
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®)

(4)

Access by stopping
execution
(except [Simulator])

[[ECUBE]
For a memory area not accessible during execution of a program, select whether
access to the area is permitted (target memory area/SFR area/CPU registers).
[E1][E20][EZ Emulator][COM Port]
Select whether to allow access to the memory area while executing a program

Default No

Modifying | Select from the drop-down list.

Available | Yes Temporarily stops execution and reads/writes.

values No Does not access to the memory during execution of a program.

Update display dur-
ing the execution

Select whether to update the display in the Memory panel/Watch panel during a pro-
gram execution.

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Updates the display during program execution.

values No Does not update the display during program execution.

Display update inter-
val[ms]

Specify the interval in 100ms unit to update the contents in the Memory panel/Watch
panel display while executing a program.

This property appears only when the [Update display during the execution] property is
set to [Yes].

Default except [COM Port]
500
[COM Port]

10000

Modifying | Directly enter from the keyboard.

Available
values

except [COM Port]
Integer number between 100 and 65500 (rounding up the fractions less
than 100 ms).

[COM Port]
Integer number between 5000 and 65500 (rounding up the fractions less
than 100 ms).

[Set Event While Running] [IECUBE]

The detailed information
uration can be changed.

on the function of the event setting during program execution is displayed and its config-

Set event by stop-
ping execution
momentarily

Select whether to forcibly pause the execution for events that cannot be set while exe-
cuting the program.

For details on the event types that are affected by this property, see "2.15.7.2 Event
types that can be set and deleted during execution”.

Default No
Modifying | Select from the drop-down list.
Available | Yes Sets these events by stopping the program execution momen-
values tarily.
No Does not allow to set these events during program execution.

[E2 Expansion Interface] [E2]

The detailed information

on the E2 expansion interface is displayed and its configuration can be changed.

External trigger input

Set the settings related to the external trigger input.
You can select different actions for each channel.
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Channel number The channel number is displayed.
(Subproperty)

Default Oorl

Modifying | Changes not allowed

Use Specify whether to use the external trigger input for this channel number.
(Subproperty)

Default No

Modifying | Select from the drop-down list.

Available | Yes Uses the external trigger signal input through the selected chan-
values nel.
No Does not use the external trigger signal input through the
selected channel.

Input signal Specify the input signal.
(Subproperty)

Default Rising Edge

Modifying | Select from the drop-down list.

Available | Rising Edge Detects rising edges of the external trigger signal input
values through the selected channel.
Falling Edge Detects falling edges of the external trigger signal input

through the selected channel.

Both Edges Detects both rising and falling edges of the external
trigger signal input through the selected channel.

High Detects the high level of the external trigger signal
input through the selected channel.

Low Detects the low level of the external trigger signal input
through the selected channel.

Action when input- The action when inputting the external trigger is displayed.
ting the external trig-

ger Default Stop program

(Subproperty) Modifying | Changes not allowed

External trigger out- | Set the settings related to the external trigger output.

put You can select different actions for each channel.

Channel number The channel number is displayed.

(Subproperty)

Default Oorl

Modifying | Changes not allowed

Use Specify whether to use the external trigger output for this channel number.
(Subproperty)

Default No

Modifying | Select from the drop-down list.

Available | Yes Uses the external trigger signal output through the selected chan-
values nel.
No Does not use the external trigger signal output through the
selected channel.
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®)

Output timing

The output timing is displayed.

(Subproperty) Default Stop program
Modifying | Changes not allowed

Output signal The output signal is displayed.

(Subproperty) Default High Pulse
Modifying | Changes not allowed

Pulse width [us] Specify the pulse width.

(Subproperty) Default 1
Modifying | Directly enter from the keyboard.
Available | Integer number between 1 and 65535
values

[Break]

The detailed information

on break functions is displayed and its configuration can be changed.

First using type of
breakpoint
(except [Simulator])

Select the type of the breakpoint to use with priority when setting it at the source line or
the execution address with a one click operation of the mouse in the Editor panel/Disas-

semble panel.

This property does not appear when the selected microcontroller supports only one

breakpoint type.

Default Software break

Modifying | Select from the drop-down list.

Available | Software break Sets software breakpoint with priority.
values

Hardware break

Sets hardware breakpoint with priority.

Stop emulation of
timer group when

Select whether to terminate the peripheral emulation of timers while stopping the pro-

gram execution (Peripheral Break).

stopping
(except [Simulator])

Default No

Modifying | Select from the drop-down list.

Available | Yes Terminates the peripheral emulation of timersNo® 1,
values No Does not terminate the peripheral emulation of timers.

Stop emulation of
serial group when

stopping

Select whether to terminate the peripheral emulation of serials while stopping the pro-

gram execution (Peripheral Break).

This property appears only when the selected microcontroller supports this function.

(except [Simulator])

Default No

Modifying | Select from the drop-down list.

Available | Yes Terminates the peripheral emulation of serials.

values - - i )
No Does not terminate the peripheral emulation of serials.
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(6)

Use open break
function
[IECUBE]

Select whether to use the open break function.

This property appears only when the selected microcontroller supports the open break

function.
Default Depends on the selected microcontroller.
Modifying | Select from the drop-down list.
Available | Yes(Hi-2) The open break target pin becomes the Hi-Z state after
values the CPU is stopped.
No(Output sig- The open break target pin outputs the signal even after
nal) the CPU is stopped.

Restore the break-
point when pin reset
occurs

[E1][E20]

[EZ Emulator]

Select whether to restore the breakpoints when a pin reset occurs.

This property appears only when the selected microcontroller supports this function,

and [Yes] is specified for the [Permit flash programming] property.

Default Yes

Modifying | Select from the drop-down list.
Available | Yes The CPU is briefly halted for restoration of the breakpoints after a
values pin reset.

No The breakpoints are ignored and not restored after a pin reset,

but are restored when the program is stopped.

Execute instruction
at breakpoint when
break

[Simulator]

Select the timing to stop the program execution by breakpoints either after or before the

execution of the instruction at the breakpoint.

Default No

Modifying | Select from the drop-down list.

Note 2

Available | Yes Breaks after executing the instruction

values

No Breaks before executing the instruction.

Note 1.

[E1][E20][EZ Emulator][COM Port]

In the case of the selected microcontroller that provides the open break function, when this property
is set to [Yes], the open break target pin becomes the Hi-Z state after the CPU is stopped (when
this property is set to [No], the open break target pin outputs the signal even after the CPU is

stopped).

Note 2.

events (see "2.14 Set an Action into Programs").

[Fail-safe Break] [[ECUBE]
The detailed information on fail-safe break functions is displayed and its configuration can be changed.

When [Yes] is selected, all of action events currently being set are handled as Hardware Break

Stop when fetched
from fetch protected
area

Select whether to stop the execution right after fetching from the fetch protected area.

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Stops right after fetching.

values i
No Does not stop even after fetching.

Stop when wrote to
write protected area

Select whether to stop the execution right after writing to the write protected area.

Default Yes
Modifying | Select from the drop-down list.
Available | Yes Stops right after writing.
values
No Does not stop even after writing.
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Stop when read from | Select whether to stop the execution right after reading from the read protected SFR.
read protected SFR

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Stops right after reading.
values

No Does not stop even after reading.

Stop when wrote to Select whether to stop the execution right after writing to the write protected SFR.
write protected SFR

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Stops right after writing.
values -
No Does not stop even after writing.
Stop when over- Select whether to stop the execution right after the user stack overflow occurs.
flowed user stack
Default No

Modifying | Select from the drop-down list.

Available | Yes Stops right after the occurrence.
values
No Does not stop even after the occurrence.
Stop when under- Select whether to stop the execution right after the user stack underflow occurs.
flowed user stack
Default No

Modifying | Select from the drop-down list.

Available | Yes Stops right after the occurrence.
values
No Does not stop even after the occurrence.
User stack section Specify the section of the user stack.
Default .stack_bss

Modifying | Directly enter from the keyboard.

Available | Address expression from O to the "end address of the address space”.
values

Stop when operated | Select whether to stop the execution right after the operation of the stack pointer that is
uninitialized stack not initialized.
pointer

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Stops right after the operation.
values

No Does not stop even after the operation.

Stop when read from | Select whether to stop the execution right after reading from the RAM that is not initial-
uninitialized RAM ized.

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Stops right after reading.
values
No Does not stop even after reading.
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Stop when accessed
to non-mapping area

Select whether to stop the execution right after accessing to the areas where are not
memory mapped in the [Memory Mappings] property in the [Memory] category.

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Stops right after accessing.

values i
No Does not stop even after accessing.

Stop when word
miss-align accessed

Select whether to stop the execution right after accessing to the odd humber address by

the word width.

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Stops right after accessing.

values .
No Does not stop even after accessing.

Stop when received
fail safe from periph-

Select whether to stop the execution right after the fail safe from the peripheral occurs.

Caution

eral Default Yes
Modifying | Select from the drop-down list.
Available | Yes Stops right after the occurrence.
values
No Does not stop even after the occurrence.
Stop when occurred | Select whether to stop the execution right after the flash illegal occurs.
flash illegal
Default Yes
Modifying | Select from the drop-down list.
Available | Yes Stops right after the occurrence.
values
No Does not stop even after the occurrence.
[Trace]

The detailed information on trace functions is displayed and its configuration can be changed.
[E1]E20][EZ Emulator][COM Port]

This category appears only when the selected microcontroller incorporates the OCD trace function.

Use trace function
[E1][E20]

[EZ Emula-
tor][COM Port]
[Simulator]

Select whether to use the trace functionNote 1,
Default No
Modifying | Select from the drop-down list.
Available | Yes Uses trace functions.
values .

No Does not use trace functions.

Clear trace memory
before running
[IECUBE]
[Simulator]

Select whether to clear the trace memory before executing.

Default Yes
Modifying | Select from the drop-down list.
Available | Yes Clears the trace memory.
values
No Does not clear the trace memory.
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Operation after trace

Select the operation after the trace memory is full with the collected trace data.

memory is full

Default Non stop and overwrite to trace memory

Modifying | Select from the drop-down list.

Available | Non stop and over- Continues overwriting trace data even after trace
values write to trace memory | memory is used up.

Stop trace Stops overwriting trace data when trace memory
is used up (the program execution will not be
stopped).

Stop Stops running the program and overwriting trace

[IECUBE] data when trace memory is used up.

[Simulator]

Rate of frequency

Select the frequency division ratio of the counter to be used for time tag display.

division of trace time

tag Default 1/1(4ns/0.3min)

[IECUBE] Modifying | Select from the drop-down list.
Available | 1/1(4ns/0.3min)1/2(8ns/0.6min)1/4(17ns/1.2min)
values 1/8(33ns/2.4min)1/16(67ns/4.8min)1/32(133ns/9.5min)

1/64(267ns/19.1min)1/128(533ns/38.2min)1/256(1067ns/1.3h)
1/512(2133ns/2.5h)1/1024(4267ns/5.1h)1/2048(8533ns/10.2h)
1/4096(17067ns/20.4h)

(Values in "()" indicate the resolution and the maximum measurement
time.)

Accumulate trace

Select whether to display the accumulated tracing time in the Trace panel.

time
[Simulator] Default No
Modifying | Select from the drop-down list.
Available | Yes Displays the accumulated tracing time.
values i - — )
No Displays the trace time with differential value.

Trace memory

Select the size of memory that stores trace data by the number of trace frames

Note 2, 3

size[frames]

[E1][E20] Default [E1][E20][EZ Emulator][COM Port]
[EZ Emula- Depends on the selected microcontroller.
tor][COM Port] [Simulator]
[Simulator] 4K
Modifying | [E1][E20][EZ Emulator][COM Port]
Changes not allowed
[Simulator]
Select from the drop-down list.
Available | [Simulator]
values 4K, 8K, 12K, 16K, 20K, 24K, 28K,32K, 36K, 40K, 44K, 48K, 52K,56K,
60K, 64K, 128K, 192K, 256K, 320K, 384K, 448K, 512K, 576K, 640K,
704K, 768K, 832K, 896K, 960K, 1M, 2M, 3M
Note 1. This property is automatically set to [Yes] when selecting [Start Tracing]/[Stop Tracing] from the
context menu in the Editor panel/Disassemble panel.
[E1]E20][EZ Emulator][COM Port]
This property is automatically changed in accordance with the property setting of the build tool
used.
Note 2. The trace frame is a unit of trace data. Each fetch/write/read uses one trace frame.
Note 3. [Simulator]

The trace memory is cleared when you change the setting of this property.
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(8) [Timer] [IECUBE][Simulator]
The detailed information on timer functions is displayed and its configuration can be changed.

Rate of frequency Select the frequency division ratio of the timer counter (120 MHz) used for timer mea-
division of timer surementNote,
[IECUBE]

Default 1/2(17ns/1.2min) (Resolution/maximum measurement time are displayed
in II()II).
Modifying | Select from the drop-down list.

Available | 1/1(8ns/0.6min),1/2(17ns/1.2min),1/4(33ns/2.4min),

values 1/8(67ns/4.8min),1/16(133ns/9.5min),1/32(267ns/19.1min),
1/64(533ns/38.2min),1/128(1067ns/1.3h),1/256(2133ns/2.5h),
1/512(4267ns/5.1h),1/1024(8533ns/10.2h),1/2048(17067ns/20.4h),

1/4096(34133ns/40.7h
Use timer function Select whether to use the timer function.
[Simulator]
Default No
Modifying | Select from the drop-down list.
Available | Yes Uses timer functions.
values - )
No Does not use timer functions.
Note It is not possible to divide the timer counter for the Run-Break time.

(9) [Coverage] [IECUBE][Simulator]
The detailed information on coverage functions is displayed and its configuration can be changed.

Use coverage func- Select whether to use the coverage function.

tion
[Simulator] Default | No

Modifying | Select from the drop-down list.

Available | Yes Uses coverage functions

values -

No Does not use coverage functions

Reuse coverage Select whether to load/save the coverage measurement result when connecting to or
result disconnecting from the debug tool.

[Simulator]

This property appears only when the [Use coverage function] property is set to [Yes].

Default No

Modifying | Select from the drop-down list.

Available | Yes Loads/saves the coverage measurement result.
values

No Does not load/save the coverage measurement result.

(10) [Mask for Input Signal] (except [Simulator])
The detailed information on the masking input signal is displayed and its configuration can be changed.

Caution 1.  [E1][E20]
The properties in this category are disabled in the case of a hot plug-in connection.
That is, the program operates as if the specification for the properties is [No] (the properties
become enabled again after reconnection with CS+).

Caution 2.  [E1][E20][COM Port]
Maskable signals differ depending on the selected microcontroller type (a signal that cannot be
masked will be hidden).
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Mask WAIT signal Select whether to mask WAIT signal to prevent the signal input to emulators.
[IECUBE]

Default NoNote

Modifying | Select from the drop-down list.

Available | Yes Masks WAIT signal.
values

No Does not mask WAIT signal.
Mask TARGET Select whether to mask TARGET RESET signal to prevent the signal input to emula-
RESET signal tors.
Default NoNote

Modifying | Select from the drop-down list.

Available | Yes Masks TARGET RESET signal.

values -
No Does not mask TARGET RESET signal.
Mask INTERNAL Select whether to mask INTERNAL RESET signal to prevent the signal input to emula-
RESET signal tors.
Default No
Modifying | Select from the drop-down list.
Available | Yes Masks INTERNAL RESET signal.
values
No Does not mask INTERNAL RESET signal.
Mask NMI signal Select whether to mask NMI signal to prevent the signal input to emulators.
[IECUBE]
Default No
Modifying | Select from the drop-down list.
Available | Yes Masks NMI signal.
values
No Does not mask NMI signal.
Note [IECUBE]

When the [Connecting with target board] property in the [Connection with Target Board]
[[ECUBE][E1][EZ Emulator][COM Port] category on the [Connect Settings] tab is set to [No], this
property is fixed to [Yes] automatically after connecting to the debug tool (changes not allowed).

(11) [Virtual Board] [Simulator]
The detailed information on the virtual board is displayed and its configuration can be changed.

Caution After connecting to the debug tool, all the properties in this category will become invalid when a
microcontroller whose Simulator does not support peripheral function simulations (instruction simu-
lation version) is selected.

Use the same virtual | Select whether to use the same virtual board as the web simulator.
board as the web See "Virtual Board panel [Simulator]" for details on the function of the virtual board.
simulator

Default No

Modifying | Select from the drop-down list.
(Changes not allowed during connecting to the debug tool.)

Available | Yes Uses the same virtual board as the web simulator.
values

No Does not use the same virtual board as the web simulator.

(12) [Simulator GUI] [Simulator]
The detailed information on the Simulator GUI is displayed and its configuration can be changed.
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Caution After connecting to the debug tool, all the properties in this category will become invalid when a
microcontroller whose Simulator does not support peripheral function simulations (instruction simu-
lation version) is selected.

Display Simulator Select whether to display the Simulator GUI window to use the Simulator GUI.
GUI

Default Yes

Modifying | Select from the drop-down list.
(Changes not allowed during execution of a program.)

Available | Yes Uses the function of the Simulator GUI.
values
No Does not use the function of the Simulator GUI.
Display Simulator Select whether to display the Simulator GUI window in the forefront when program exe-
GUI on top of other cution starts.
windows This property appears only when the [Display Simulator GUI] property is set to [Yes].
Default Yes

Modifying | Select from the drop-down list.

Available | Yes Displays it in the forefront.
values

No Does not display it in the forefront.

(13) [Step function]
The detailed information on the control method of step execution is displayed and its configuration can be

changed.
Skip target section Select whether to skip the target section.
Default No
Modifying | Select from the drop-down list.
Available | Yes Skips the target section.
values
No Does not skip the target section.
Target section Specify the target section.
This property appears only when the [Skip target section] property is set to [Yes].
Default [Number of sections to skip]
Modifying | Specify with the Specified Section dialog box.
The Specified Section dialog box is opened by clicking the [...] button that
appears at right edge of this field when you select this property (The sec-
tions to be skipped cannot be specified from this panel.).
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[Flash Self Emulation Settings] tab [IECUBE]

This tab is used to display the detailed information categorized by the following and the configuration can be changed.
Note that this tab appears only when the selected microcontroller incorporates the flash memory.

(1) [Flash Self Emulation]

(2) [Writing Time/Erasing Time]
(3) [Macro Service Error]

(4) [Setting Flash shield window]
(5) [Security Flag Emulation]

[Description of each category]

(1) [Flash Self Emulation]
The detailed information on flash self programming emulation functions is displayed and its configuration can be
changed.

Flash self-program- Select whether to use the flash self programming emulation function.
ming

Default No

Modifying | Select from the drop-down list.

Available | Yes Uses the flash self programming emulation function.
values

No Does not use the flash self programming emulation function.

(2) [Writing Time/Erasing Time]
The detailed information on the time for writing to and erasing the flash memory is displayed and its configuration
can be changed.

Writing time Select the value to simulate the delay time for writing to the flash memory.

Default Typical number of times that is assumed by flash macro specifications

Modifying | Select from the drop-down list.

Available | No retry Specifies "0" as the number of times of retry.
values The delay time is 0 (the writing speed is fast-
est).

Typical number of times Specifies the typical number of times that is

that is assumed by flash assumed by flash macro specifications.
macro specifications

Maximum number of Specifies the maximum number of times that
times that is assumed by | is assumed by flash macro specifications.
flash macro specifications

Retries for the maximum Specifies the maximum number of times of
number of times specified | retry.
The delay time is maximum (the writing speed

is longest).
Address for writing Specify the target address at which to simulate the delay time for writing.
fime Default 0
Modifying | Directly enter from the keyboard.
Available | 0x0 to OXFFFFF in hexadecimal number
values
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Address mask value

Specify a mask value for the address for writing time.

for writing time

Default 0x3

Modifying | Directly enter from the keyboard.

Available | 0x0 to OXFFFFF in hexadecimal numberNote 1
values

Erasing time

Select the value to simulate the delay time for erasing the flash memory.

Default Typical number of times that is assumed by flash macro specifications

Modifying | Select from the drop-down list.

Available | No retry Specifies "0" as the number of times of retry.

values The delay time is O (the erasing speed is fast-
est).

Typical number of times Specifies the typical number of times that is
that is assumed by flash assumed by flash macro specifications.
macro specifications

Maximum number of Specifies the maximum number of times that
times that is assumed by | is assumed by flash macro specifications.
flash macro specifications

Retries for the maximum Specifies the maximum number of times of
number of times specified | retry.

The delay time is maximum (the erasing
speed is longest).

Address for erasing

Specify the target address at which to simulate the delay time for erasing.

time

Default 0

Modifying | Directly enter from the keyboard.
Available | 0x0 to OXFFFFF in hexadecimal number
values

Address mask value

Specify a mask value for the address for erasing time.

for erasing time

Default Ox3FF
Modifying | Directly enter from the keyboard.
Available | 0x0 to OXFFFFF in hexadecimal numberNote 2
values
Note 1. The flash library writes to the code flash memory in 4-byte units, so fix the lowest and second-low-

est order bits of the address mask to 1.

Note 2. The flash library erases the code flash memory in block units, so fix the lower-order 10 bits of the
address mask to 1.

(3) [Macro Service Error]

The detailed information on the flash macro service is displayed and its configuration can be changed.
The error values that are not returned during normal emulation can be forcibly returned by setting the properties of

this category.

Macro Service Errors

Specify the error to generate in the flash macro service to emulate.
Up to three types of errors to generate ([0]/[1])/[2]) can be specified with subproperties
for this property.
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Generate error Select the type of error to generate.
(Subproperty) Default None
Modifying | Select from the drop-down list.
Available | None
values
Generate FlashErase Error (Erase)
Generate FlashBlankCheck Error (BlankCheck)
Generate FlashWrite Error (Write)
Generate FlashlVerify Error (IVerify)
Generate FlashSetSecurity / FlashSetFSW Error (Erase)
Generate FlashSetSecurity / FlashSetFSW Error (Write)
Generate FlashSetSecurity / FlashSetFSW Error (1Verify)
Address for error Specify an address at which the error is to be generated, within the flash memory area.
(Subproperty) This property appears only when the [Generate error] subproperty is set to [Generate

erase error for FlashErase]/[Generate write error for FlashWrite]/[Generate |Verify error
for FlashlVerify]/[Generate BlankCheck error for FlashBlankCheck].

Default 0

Modifying | Directly enter from the keyboard.

Available | 0x0 to OxFFFFF in hexadecimal number
values

Address mask value | Specify a mask value for the address, at which the error is to be generated.

for error This property appears only when the [Generate error] subproperty is set to [Generate
(Subproperty) erase error for FlashErase]/[Generate write error for FlashWrite]/[Generate |Verify error
for FlashlVerify]/[Generate BlankCheck error for FlashBlankCheck].

Default 0

Modifying | Directly enter from the keyboard.

Available | 0x0 to OXFFFFF in hexadecimal numberN°t®
values
Note In the [Generate error] subproperty, when [Generate FlashWrite Error (Write)] is selected, fix the

lowest and second-lowest order bits of the mask value to 1, because the flash library writes to the

code flash memory in 4-byte units.

Also, when [Generate FlashErase Error (Erase)], [Generate FlashBlankCheck Error (BlankCheck)]
or [Generate FlashlVerify Error (IVerify)] is selected, fix the lower-order 10 bits of the mask value to
1, because erasure of the code flash memory, blank checking, and internal verification proceed in

block units.

(4) [Setting Flash shield window]
The detailed information on the flash shield window function is displayed and its configuration can be changed.

Caution Settings of this category are applied after CPU reset is generated.
If you changed these settings, execute the program after reset the CPU.

Flash shield window | Specify the start block of the area that can be written to and erased by flash self pro-
start block gramming.

Default 0

Modifying | Directly enter from the keyboard.

Available | 0x0 to OxFFFF in hexadecimal number
values
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Flash shield window
end block

Specify the end block of the area that can be written to and erased by flash self pro-

gramming.

Default FFFF

Modifying | Directly enter from the keyboard.

Available | 0x0 to OxFFFF in hexadecimal number
values

(5) [Security Flag Emulation]
The detailed information on the security flag emulation function is displayed and its configuration can be changed.

Caution Settings of this category are applied after CPU reset is generated.
If you changed these settings, execute the program after reset the CPU.

Disable block erase

Select whether to emulate to disable block erase.

Default No

Modifying | Select from the drop-down list.

Available | Yes Emulates to disable block erase.

values -
No Does not emulate to disable block erase.

Disable program

Select whether to emulate to disable writing.

Default No

Modifying | Select from the drop-down list.

Available | Yes Emulates to disable writing.

values i —
No Does not emulate to disable writing.

Disable boot block

Select whether to emulate to disable rewrite boot area.

cluster reprogram

Default No

Modifying | Select from the drop-down list.

Available | Yes Emulates to disable rewrite boot area.
values
No Does not emulate to disable rewrite boot area.
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[DataFlash Emulation Settings] tab [IECUBE]

This tab is used to display the detailed information categorized by the following and the configuration can be changed.
Note that this tab appears only when the selected microcontroller incorporates the data flash memory.

(1) [DataFlash Emulation]
(2) [Writing Time]
(3) [Macro Service Error]

[Description of each category]

1)

)

[DataFlash Emulation]

The detailed information on the data flash emulation functions is displayed and its configuration can be changed.

DataFlash emulation

Select whether to use the data flash emulation function.

Default No
Modifying | Select from the drop-down list.
Available Yes Uses data flash emulation functions.
values - )
No Does not use data flash emulation functions.

[Writing Time]

The detailed information on the time for writing to the data flash memory is displayed and its configuration can be

changed.

Writing time

Select the value to simulate the delay time for writing to the data flash memory.

Default Typical number of times that is assumed by flash macro specifications
Modifying | Select from the drop-down list.

Available | No retry Specifies "0" as the number of times of retry.
values The delay time is 0 (the writing speed is fastest).

Typical number of times
that is assumed by flash
macro specifications

Specifies the typical number of times that is
assumed by flash macro specifications.

Maximum number of
times that is assumed
by flash macro specifi-
cations

Specifies the maximum number of times that is
assumed by flash macro specifications.

Retries for the maximum
number of times speci-
fied

Specifies the maximum number of times of retry.
The delay time is maximum (the writing speed is
longest).

Address for writing

Specify the target address at which to simulate the delay time for writing.

time

Default F1000

Modifying | Directly enter from the keyboard.

Available | 0xF1000 to OxFFFFF in hexadecimal number
values

Address mask value

Specify a mask value for the address for writing time.

for writing time

Default 0

Modifying | Directly enter from the keyboard.
Available | 0x0 to OxFFFFF in hexadecimal number
values
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(3) [Macro Service Error]
The detailed information on the data flash macro service is displayed and its configuration can be changed.
The error values that are not returned during normal emulation can be forcibly returned by setting the properties of
this category.

Macro Service Errors | Specify the error to generate in the data flash macro service to emulate.
Up to four types of errors to generate ([0]/[1])/[2)/[3]) can be specified with subproperties
for this property.

Generate error Select the type of error to generate.
(Subproperty)

Default None

Modifying | Select from the drop-down list.

Available | None

values
Generate FlashBlankCheck Error (BlankCheck)
Generate FlashWrite Error (Write)
Generate FlashlVerify Error (IVerify)
Address for error Specify an address at which the error is to be generated, within the flash memory area.
(Subproperty) This property appears only when the [Generate error] subproperty is set to the value

other than [None].

Default F1000

Modifying | Directly enter from the keyboard.

Available | 0xF1000 to OxFFFFF in hexadecimal number
values

Address mask value | Specify a mask value for the address, at which the error is to be generated.

for error This property appears only when the [Generate error] subproperty is set to the value
(Subproperty) other than [None].
Default 0

Modifying | Directly enter from the keyboard.

Available | 0x0 to OXFFFFF in hexadecimal number
values
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[Download File Settings] tab

This tab is used to display the detailed information categorized by the following and the configuration can be changed.
For details on the download function, see "2.5 Download/Upload Programs".

(1) [Download]
(2) [Debug Information]

[Description of each category]

(1) [Download]
The detailed information on download is displayed and its configuration can be changed.

Download files Specify the file to downloadN® -
The names of files to be downloaded and the download conditions are listed in the
lower area.

Default [Number of files to download]

Modifying | Specify with the Download Files dialog box.

The Download Files dialog box is opened by clicking the [...] button that
appears at right edge of this field when you select this property (you cannot
specify the file to download on this panel).

CPU Reset after Select whether to reset the CPU after downloading.
download This property does not appear when the selected microcontroller always resets the
CPU after downloading.

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Resets the CPU after downloading.
values

No Does not reset the CPU after downloading.

Download Mode Select the download mode for downloading to the flash ROM.
(except [Simulator])

Default Speed priority

Modifying | Select from the drop-down list.

Available | Speed priority Fills free space between the first data and the final
values data with FFH.

Download speed will be faster because the writing
data is reduced (default).

Data priority Retains the previous value in free space.
Download speed will be very slow because data in
free space are read once.

Erase flash ROM Select whether to erase the flash ROM before downloading.
before download
(except [Simulator]) | Default | No

Modifying | Select from the drop-down list.
Note that changes cannot be made when the [Download Mode] property is
set to [Data priority].

Available | Yes Erases the flash ROM before downloading.
values
No Does not erase the flash ROM before downloading.
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Automatic change Select how to perform the setting again if the file is downloaded again, and the location
method of event set- | (address) set for the currently set event changes to midway in the instructionN°®® 2,
ting position

Default Suspend event

Modifying | Select from the drop-down list.

Available | Move to the head | Sets the event to the top address of the instruction.
values of instruction

Suspend event Disables the event (suspended state).

Check reserved area | Select whether to output a message when overwriting to an area reserved for use by

overwriting when the emulator is attempted at the time of downloading.
downloading

[E1][E20] Default Yes

[EZ Emula-

tor][COM Port] Modifying | Select from the drop-down list.

Available | Yes Outputs a message when overwriting to an area reserved is
values attempted.

No Does not output a message when overwriting to an area reserved
is attempted.

Note 1. Files specified as build targets in a main project or sub-project cannot be deleted from the target
files to download (These files are automatically registered as download files by default).
See "Table 2.1 Downloadable File Formats" for downloadable file format.

Note 2. This property setting works only for the location setting of events without the debug information.
The location setting of events with the debug information is always moved to the beginning of the
source text line.

(2) [Debug Information]
The detailed information on debugging is displayed and its configuration can be changed.

Execute to the speci- | Select whether to execute the program to the specified symbol position after CPU reset.
fied symbol after

CPU Reset Default Yes
Modifying | Select from the drop-down list.
Available | Yes Executes the program to the specified symbol position after CPU
values reset.
No Does not execute the program after CPU reset.
Specified symbol Specify the position at which the program is stop after CPU reset.

This property appears only when the [Execute to the specified symbol after CPU Reset]
property is set to [Yes].

Default _main

Modifying | Directly enter from the keyboard.

Available | Address expression from 0 to the "end address of the address space”.
values

The upper limit size Specify the memory size to be used for reading the debug informationNOte.

of the memory usage
[Mbytes] Default 500

Modifying | Directly enter from the keyboard.

Available | Decimal number between 100 and 1000
values

Note In some cases, lowering the upper limit may lead to poorer responsiveness since it leads to more
frequent discarding and re-reading of debug information.
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[Hook Transaction Settings] tab

This tab is used to display the detailed information categorized by the following and the configuration can be changed.
For details on the hook transaction, see "2.16 Use Hook Function".

(1) [Hook Transaction Settings]

[Description of each category]

(1) [Hook Transaction Settings]
The detailed information on the hook transaction is displayed and its configuration can be changed.
Note that the properties on this tab can be specified via the Text Edit dialog box, which is opened by clicking the

[...] button that appears at right edge of a field when you select each property (you cannot specify the process
directly on this panel).

Caution Up to 64 characters for one process, and up to 128 processes for each property can be set (one
line in the [Text] area in the Text Edit dialog box is equivalent to one processing).
Before download Specify the process to proceed right before downloading the load module file.

Default Before download[0] ("[]" is the current number of specified processes.)

Modifying | Specify with the Text Edit dialog box.

Format Either one of the following
- SFR name + space + Value
[Process] Automatically overwrites the value of SFR with Value.
- CPU register name + space + Value
[Process] Automatically overwrites the value of CPU register with Value.

- Source + space + Python script path

[Process] Automatically executes a script file specified with Python
script path.

After download Specify the process to proceed right after downloading the load module file.

Default After download[0] ("[]" is the current number of specified processes.)

Modifying | Specify with the Text Edit dialog box.

Format Either one of the following

- SFR name + space + Value
[Process] Automatically overwrites the value of SFR with Value.

- CPU register name + space + Value
[Process] Automatically overwrites the value of CPU register with Value.

- Source + space + Python script path

[Process] Automatically executes a script file specified with Python
script path.
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After CPU reset

Specify the process to proceed right after CPU reset during break.
under breaking

Default

After CPU reset under breaking[0] ("[]" is the current number of specified
processes.)

Modifying | Specify with the Text Edit dialog box.

Format Either one of the following

- SFR name + space + Value

[Process] Automatically overwrites the value of SFR with Value.
- CPU register name + space + Value

[Process] Automatically overwrites the value of CPU register with Value.

- Source + space + Python script path

[Process] Automatically executes a script file specified with Python
script path.

Before running Specify the process to proceed right before the execution of the program.

Default

Before running[0] ("[]" is the current number of specified processes.)

Modifying | Specify with the Text Edit dialog box.

Format Either one of the following

- SFR name + space + Value

[Process] Automatically overwrites the value of SFR with Value.
- CPU register name + space + Value

[Process] Automatically overwrites the value of CPU register with Value.
- Source + space + Python script path

[Process] Automatically executes a script file specified with Python
script path.

After breaking Specify the process to proceed right after the program break.

Default After breaking[0] ("[]" is the current number of specified processes.)

Modifying | Specify with the Text Edit dialog box.

Format Either one of the following

- SFR name + space + Value

[Process] Automatically overwrites the value of SFR with Value.

- CPU register name + space + Value

[Process] Automatically overwrites the value of CPU register with Value.
- Source + space + Python script path

[Process] Automatically executes a script file specified with Python
script path.
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Memory panel

This panel is used to display the contents of the memory and change the memory value (see "2.9.1 Display/change the
memory").

Furthermore, the contents of data flash memory can be displayed and changed when the selected microcontroller incor-
porates the data flash memory.

Up to a maximum of four of these panels can be opened. Each panel is identified by the names "Memory1", "Memory2",
"Memory3", and "Memory4" on the titlebar.

The display contents are automatically updated when the value of the memory changes after a program is executed
(when the execution is done in steps, the display is updated after each step).

In addition, by enabling the Real-time display update function, it is also possible to update the display contents in real-
time even while a program is being executed.

This panel appears only when connected to the debug tool.

Remark 1. You can set the scroll range of the vertical scroll bar on this panel via the Scroll Range Settings dialog
box which is opened by clicking the button from [View] on the toolbar.

Remark 2. This panel can be zoomed in and out by |1 nox -| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.

Figure A5 Memory Panel
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00220 | E§ FO 02 F5)78 00 07 71|78 Fa FC 1102 00 71 T 1. 0x.19i0%.. a2
00230 | FA D7 F5 ADJFF 71 74 A1|71 4B a4 71|64 &1 OF F3 M1 taztak i1t -
[ ! [ 1 I 1 I I
2 (3) (4)

This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (Memory panel-dedicated items)]
- [[Edit] menu (Memory panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Memory] >> [Memoryl1-4].

[Description of each area]

(1) Display position specification area
It is possible to specify the display start position of the memory contents by specifying an address expression.
Specify the following items.
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Specify an address expression

Directly input the address expression of the memory value address to display in the text box. You can specify an
input expression with up to 1024 characters. The result of the expression is treated as the display start position
address.

Note that if an address value greater than the microcontroller address space is specified, the high-order address
value is masked.

In addition, an address value greater than the value expressed within 32 bits cannot be specified.

Remark 1. A symbol name at the current caret position can be complemented by pressing the [Ctrl] +
[Space] key in this text box (see "2.19.2 Symbol name completion function").

Remark 2. If the specified address expression is the symbol and its size can be recognized, everything from
the start address to the end address of that symbol is displayed selected.

Specify automatic/manual evaluation of the address expression
The timing to change the display start position can be determined by specifying in the [Move when Stop] check
box and the [Move] button.

A. WINDOW REFERENCE

[Move when Stop] The caret is moved to the address which is automatically calculated from the
address expression after the program is stopped.

[] | The address expression is not automatically evaluated after the program is
stopped.
Click the [Move] button to manually evaluate the address expression.

[Move] button When the [Move when Stop] check box is not checked, click this button to evalu-
ate the address expression and move the caret to the result address of the evalu-
ation.

Address area

The address of the memory is displayed (hexadecimal number notation fixing).

The display starts from address 0x0 by default. However, an offset value of the start address can be set via the
Address Offset Settings dialog box that is opened by selecting [Address Offset Value Settings...] from the context
menu.

The address width corresponds to the one in memory space of the specified microcontroller in the project.

This area cannot be edited.

Caution The offset value that have been set is automatically changed in accordance with the number of
view columns in the Memory value area.

Memory value area

The value of the memory is displayed and changed.

Specification of the display notation, display width of memory values or the number of view columns is performed
by selecting the buttons on the toolbar or [Notation]/[Size Notation]/[View] from the context menu (see "2.9.1.2
Change display format of values").

The meanings of the marks and colors displayed as memory values are as follows (character colors and back-
ground colors depend on the configuration in the [General - Font and Color] category of the Option dialog box):

Display Example (Default) Description

an Character color Blue Memory value that the user is changing
Press the [Enter] key to write to the target memory.

Background color | Standard color

oo Character color Standard color | Memory value of the address whose symbol has been
(Under line) defined (Registering watch-expression can be per-

Background color | Standard color formed).

o Character color Brown Memory value that has been changed because of the exe-
cution of a programN°te
Background color | Cream To reset the highlighting, select the button on the tool-
bar.
(]| Character color Pink Memory value for which the Real-time display update

function is being operated
Background color | Standard color
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Display Example (Default) Description
i Character color Standard color | Read/ Current access condition of the memory
Fetch value when the Real-time display update
Background color | Palegreen function is being operated
oo Character color Standard color | Write
Background color | Orange
(i Character color Standard color | Read and
- Write
Background color | Paleturquoise
i Character color Gray Memory value of the read-protected area
Background color | Standard color
7 Character color Gray Areas not memory-mapped
Background color | Standard color
-- Character color Gray Areas not rewritable (e.g. SFR area/l/O protection area) or
when acquisition of memory values failed
Background color | Standard color
*x Character color Standard color | When display is specified for other than the real-time dis-
play update area during program execution or when
Background color | Standard color | acquisition of memory values failed
Note Just before execution of a program, only the memory value in the address range for which the
Memory panel had been displayed becomes the target.
In addition, the value is not highlighted if it is same for before and after the execution of the pro-
gram.
Caution The number of view columns is automatically changed in accordance with the set value of [Size

Notation] of the context menu.

This area is provided with the following functions.

(&) Pop-up display
The following contents are pop-up displayed based on the nearest existing symbol forward from the address the
mouse is designating when hovering the mouse cursor over the memory value.
Note that if there is no symbol information (the underlining is non-display), no pop-up display is done.
variable + 0x14
Symbol name Offset value
Symbol name Indicates the name of the symbol.
Offset value When a symbol has not been defined for the addresses, the offset value from the nearest
symbol exists forward is displayed (hexadecimal number notation fixing).
(b) Real-time display update function

Using the real-time display update function allows you to display/modify the value of the memory contents not
only while the program is stopped, but also in execution.

See "2.9.1.4 Display/modify the memory contents during program execution" for details on the real-time display
update function.

(©

Changing memory values

Directly edit from the keyboard after moving the caret to the memory value to be edited.

The color of the memory value changes when it is in editing. Press the [Enter] key to write the edited value to
the target memory (if the [Esc] key is pressed before the [Enter] key is pressed, the editing is cancelled).

See "2.9.1.3 Modify the memory contents" for details on the method for changing the memory value.
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(d) Searching/initializing memory value
The Memory Search dialog box is opened to search the memory contents in the specified address range by
selecting [Find...] from the context menu (see "2.9.1.5 Search the memory contents").
In addition, the Memory Initialize dialog box is opened to change the memory contents collectively in the speci-
fied address range by selecting [Fill...] from the context menu (see "2.9.1.6 Modify the memory contents in
batch (initialize)").

(e) Copying and pasting
By selecting a range of memory values with the mouse, the contents of the range can be copied to the clipboard
as a character string, and these contents can be pasted to the caret position.
These operations are performed by selecting from the context menu or selecting from the [Edit] menu.
However, the paste operation is possible only when the character string to be pasted and the display notation
(radix and size) of the area match.
If the display notation does not match, a message is displayed.
The character codes and character strings that can be handled by this area are as follows.
If character strings other than these are pasted, a message is displayed.

Character code ASCII

Character string | 0,1,2,3,4,5,6,7,8,9,a,b,¢,d,e,f,A,B,C,D,E, F

(H  Registering watch-expression
A memory value with underline indicates that a symbol has been defined in the address, and its symbol can be
registered as a watch-expression.
After selecting the memory value or placing the caret on the memory value, the symbol name of the address is
registered in the Watch panel (Watchl) as a watch-expression by selecting [Register to Watch1] from the con-
text menu.

Caution A memory value without underline cannot be registered as a watch-expression.

(g) Saving the contents of memory values
The Data Save dialog box can be opened by selecting the [File] menu >> [Save Memory Data As...], and the
contents of this panel can be saved in a text file (*.txt) or CSV file (*.csv).
See "2.9.1.7 Save the memory contents" for details on the method for saving the contents of memory values.

(4) Character strings area
Memory values converted into character code are displayed.
The character code can be specified by selecting [Encoding] from the toolbar or context menu (ASCII code is
selected by default).
Furthermore, in this area, memory values converted into a floating-point value can be displayed as character
strings. To do this, select the following item from [Encoding] of the context menu.

ltem Display Format Size
Half-Precision Half-precision floating-point value 16-bit
Float Numeric value | <sign><mantissa>e<sign><exponent>
Infinite number | Inf, and -Inf
Not a number NaN
Example +1.234e+1
Float Single-precision floating-point value 32-bit
Numeric value | <sign><mantissa>e<sign><exponent>
Infinite number | Inf, and -Inf
Not a number NaN
Example + 1.234567e+123
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Item Display Format Size

Double Double-precision floating-point value 64-bit

Numeric value | <sign><mantissa>e<sign><exponent>

Infinite number | Inf, and -Inf

Not a number NaN

Example + 1.2345678901234e+123

Float Complex Complex number of single-precision floating-point 64-bit

<Single-precision floating-point value> <Single-precision floating-point
value> * |

Double Complex Complex number of double-precision floating-point 128-bit

<Double-precision floating-point value> <Double-precision floating-point
value> * |

Float Imaginary Imaginary number of single-precision floating-point 32-bit

<Single-precision floating-point value> * |

Double Imaginary | Imaginary number of double-precision floating-point 64-bit

<Double-precision floating-point value> * |

Caution Nothing is displayed when the minimum size of a character code or a floating-point value is greater
than "the number of bytes of display width of memory values" x "the number of bytes of the number
of view columns".

This area is provided with the following functions.

(@) Changing character strings
Directly edit from the keyboard after moving the caret to the character string to be edited.
The color of the character string changes when it is in editing. Press the [Enter] key to write the edited value to
the target memory (if the [Esc] key is pressed before the [Enter] key is pressed, the editing is cancelled).

Caution Character strings displayed as floating-point values cannot be searched.

(b) Searching character strings
The Memory Search dialog box is opened to search for character strings by selecting [Find...] from the context
menu (see "2.9.1.5 Search the memory contents").

(c) Copying and pasting
By selecting a range of character strings with the mouse, the contents of the range can be copied to the clip-
board as a character string, and these contents can be pasted to the caret position.
These operations are performed by the selecting from the context menu or selecting from the [Edit] menu.
However, the paste operation is possible only when [ASCII] has been selected as the character code. If other
than [ASCII] is selected, a message is displayed.

[Toolbar]
&l Acquires the latest data from the debug tool, and updates the contents of this panel.
Resets highlighting of values that have been changed by executing a program.
This item is disabled during execution of a program.
Notation The following buttons to change the notation of memory values are displayed.
The items below is disabled during execution of a program.
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. Hexadecimal Displays memory values in hexadecimal number (default).

Signed Decimal Displays memory values in signed decimal number.

Unsigned Decimal Displays memory values in unsigned decimal number.

H Octal Displays memory values in octal number.

Binary Displays memory values in binary number.

Size Notation The following buttons to change the notation of sizes of memory values are dis-

played.
The items below is disabled during execution of a program.

4 Bits Displays memory values in 4-bit width.

1 Byte Displays memory values in 8-bit width (default).

2 Bytes Displays memory values in 16-hit width.
Values are converted depending on the endian of the target memory area.

E 4 Bytes Displays memory values in 32-bit width.
Values are converted depending on the endian of the target memory area.

8 Bytes Displays memory values in 64-bit width.
Values are converted depending on the endian of the target memory area.

Encoding The following buttons to change the encoding of character strings are displayed.

The items below is disabled during execution of a program.

ASCII Displays character strings in ASCII code (default).

Shift_JIS Displays character strings in Shift_JIS code.

. EUC-JP Displays character strings in EUC-JP code.

. UTF-8 Displays character strings in UTF-8 code.

UTF-16 Displays character strings in UTF-16 code.

rrd| Half-Precision Float Displays character strings as a half-precision floating-point value.

Fol| Float Displays character strings as a single-precision floating-point value.

Double Displays character strings as a double-precision floating-point value.

Float Complex Displays character strings as a complex humber of single-precision floating-point.

ol Double Complex Displays character strings as a complex number of double-precision floating-point.

Float Imaginary Displays character strings as an imaginary number of single-precision floating-
point.

Double Imaginary Displays character strings as an imaginary number of double-precision floating-
point.

I View The following buttons to change the display format are displayed.

Settings Scroll Range... | Opens the Scroll Range Settings dialog box to set the scroll range for this panel.

Column Number Settings... | Opens the Column Number Settings dialog box to set the number of view columns
in the Memory value area.

Address Offset Value Set- Opens the Address Offset Settings dialog box to set an offset value for addresses
tings... displayed in the Address area.

[[File] menu (Memory panel-dedicated items)]

The following items are exclusive for the [File] menu in the Memory panel (other items are common to all the panels).
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Note that all these items are disabled during execution of a program.

Save Memory Data Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file
(*.csv) (see "(g) Saving the contents of memory values").

Note that when the file has never been saved or the file is write disabled, the same oper-
ation is applied as the selection in [Save Memory Data As...].

Save Memory Data As... | Opens the Data Save dialog box to newly save the contents of this panel to the specified
text file (*.txt)/CSV file (*.csv) (see "(g) Saving the contents of memory values").

[[Edit] menu (Memory panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Memory panel (all other items are disabled).
Note that all these items are disabled during execution of a program.

Copy Copies the contents of the selected range to the clipboard as character string(s).
Paste Pastes the character string(s) copied in the clipboard to the caret position.
- To the memory value area: See "(e) Copying and pasting".

- To the character strings area: See "(c) Copying and pasting".

Find... Opens the Memory Search dialog box.
The search is operated either in the Memory value area or the Character strings area, in
which a caret is.

[Context menu]

Register to Watchl Registers the symbol at the caret to the Watch panel (Watchl).

At this time, since it is registered as a variable name, the symbol hame that is displayed
changes depending on the scope.

Note that this item is disabled when no symbol has been defined in the address corre-
sponding to the memory value at the caret position (see "(f) Registering watch-expres-
sion").

Find... Opens the Memory Search dialog box.

The search is operated either in the Memory value area or the Character strings area
(unless the floating-point value display is selected), in which a caret is.

This item is disabled during execution of a program.

Fill... Opens the Memory Initialize dialog box.
Refresh Acquires the latest data from the debug tool, and updates the contents of this panel.
Copy Copies the contents of the selected range to the clipboard as character string(s).

This item is disabled during execution of a program.

Paste Pasts the character string(s) copied in the clipboard to the caret position.
This item is disabled during execution of a program.

- To the memory value area: See "(e) Copying and pasting".

- To the character strings area: See "(c) Copying and pasting".

Notation The following cascade menus are displayed to specify the notation of memory values.
Hexadecimal Displays memory values in hexadecimal number (default).
Signed Decimal Displays memory values in signed decimal number.
Unsigned Decimal Displays memory values in unsigned decimal number.
Octal Displays memory values in octal number.
Binary Displays memory values in binary number.
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Size Notation

The following cascade menus are displayed to specify the notation of sizes of memory val-
ues.

4 Bits Displays memory values in 4-bit width.
1 Byte Displays memory values in 8-bit width (default).
2 Bytes Displays memory values in 16-bit width.
Values are converted depending on the endian of the target memory area.
4 Bytes Displays memory values in 32-bit width.
Values are converted depending on the endian of the target memory area.
8 Bytes Displays memory values in 64-bit width.
Values are converted depending on the endian of the target memory area.
Encoding The following cascade menus are displayed to specify the display format in the character
strings area.
ASCII Displays character strings in ASCII code (default).
Shift_JIS Displays character strings in Shift_JIS code.
EUC-JP Displays character strings in EUC-JP code.
UTF-8 Displays character strings in UTF-8 code.
UTF-16 Displays character strings in UTF-16 code.
Half-Precision Float Displays character strings as a half-precision floating-point value.
Float Displays character strings as a single-precision floating-point value.
Double Displays character strings as a double-precision floating-point value.
Float Complex Displays character strings as a complex number of single-precision floating-point.
Double Complex Displays character strings as a complex number of double-precision floating-point.
Float Imaginary Displays character strings as an imaginary number of single-precision floating-point.
Double Imaginary Displays character strings as an imaginary number of double-precision floating-point.

View

The following cascade menus are displayed to specify the display format.

Settings Scroll
Range...

Opens the Scroll Range Settings dialog box to set the scroll range for this panel.

Column Number Set-
tings...

Opens the Column Number Settings dialog box to set the number of view columns in the
Memory value area.

Address Offset Value
Settings...

Opens the Address Offset Settings dialog box to set an offset value for addresses dis-
played in the Address area.

Highlight Accessed

Highlights memory values that have changed by execution of a program if this item is
checked (default).
This item is disabled during execution of a program.

Periodic Updating

The following cascade menus are displayed to set for the real-time display update function
(see "(b) Real-time display update function™).

Periodic Updating
Options

Opens the Property panel to set for the real-time display update function.
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Disassemble panel

This panel is used to display the results of disassembling the contents of the memory (disassembled text), and execute
line assembly (see "2.6.4 Perform line assembly").

Furthermore,

the instruction level debugging (see "2.7.3 Execute programs in steps") and the code coverage measure-

ment result display [[ECUBE][Simulator] (see "2.13 Measure Coverage [IECUBE][Simulator]") can be performed in this

panel.

Up to a maximum of four of these panels can be opened. Each panel is identified by the names "Disassemblel"”,
"Disassemble2", "Disassemble3" and "Disassemble4" on the titlebar.

The source text in the source file corresponding to the code data can also be displayed by setting to the Mixed display

mode (default).

This panel appears only when connected to the debug tool.

Caution
Remark 1.

Remark 2.

Remark 3.

Figure A.6

[Toolbar] {

A step execution is performed in instruction level units when the focus is in this panel (see "2.7.3 Exe-
cute programs in steps").

You can set the scroll range of the vertical scroll bar on this panel via the Scroll Range Settings dialog
box which is opened by clicking the button from [View] on the toolbar.

You can print the current screen image of this panel by selecting [Print...] from the [File] menu.

This panel can be zoomed in and out by |1 a0k -| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.

Disassemble Panel (When Mixed Display Mode Is Selected)
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Figure A.7 Disassemble Panel (When Disassemble Display Mode Is Selected)
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Figure A.8 Disassemble Panel (When Code Coverage Measurement Result Is Displayed)
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This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (Disassemble panel-dedicated items)]
- [[Edit] menu (Disassemble panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Disassemble] >> [Disassemblel - 4].

R20UT4857EJ0100 Rev.1.00 RENESAS Page 187 of 391
Nov 01, 2020



CS+Vv8.05.00

A. WINDOW REFERENCE

[Description of each area]

(1) Eventarea

The lines for which events can be set are shown with the background color in white (this mean that events cannot
be set for those lines whose background color in gray).

In addition, the Event mark corresponding to an event that has been currently set is displayed.

This area is provided with the following functions.

(a) Setting/deleting breakpoints
By clicking where you want to set a breakpoint with the mouse, the breakpoint can be set easily.

The breakpoint is set to the instruction at the start address of the clicked line.
Once the breakpoint is set, the Event mark is displayed at the line that is set. In addition, the detailed informa-
tion about the set breakpoint is reflected in the Events panel.
When this operation is performed at a place where any one of the event marks is already being displayed, that
event is deleted and the setting of breakpoints cannot be done.
Note that the setting of events can be done only for those lines where the background color is shown in white.
See "2.8.3 Stop the program at the arbitrary position (breakpoint)” for details on how to set the breakpoint.

(b) Changes event status

Event status can be changed from the following menu displayed by right-clicking the event mark.

Enable Event

Changes the selected event state to a Valid state.
Event occurs when the specified condition is met.

When the event mark ( hj‘ ) which indicates that multiple events have been set
is selected, all of the events that have been set are enabled.

Disable Event

Changes the selected event state to an Invalid state.
Event does not occur when the specified condition is met.

When the event mark ( hﬁ' ) which indicates that multiple events have been set
is selected, all of the events that have been set are disabled.

Delete Event

Deletes the selected event.

When the event mark ( ,hi,@' ) which indicates that multiple events have been set

is selected, all of the events that have been set are deleted.

View Event Detailed
Setup

Opens the Events panel to display the detailed information of the selected event.

(c) Pop-up display

By hovering the mouse cursor over the Event mark, the name of the event, the detailed information for the event
and the comments added to the event are pop-up displayed.
When multiple events have been set in the applicable place, information for each event, up to a maximum of
three events, is listed and displayed.

(2) Address area

The address per line to start disassembling is displayed (hexadecimal number notation fixing).

In addition, the current PC mark ( ) that corresponds to the current PC position (PC register value) is dis-

played.

The address width corresponds to the one in memory space of the specified microcontroller in the project.
For the source text line in the mixed display mode, line numbers (xxx:) in the source file correspond to the start

address are displayed.

This area is provided with the following functions.

(@) Pop-up display

By hovering the mouse cursor over a address or line number, the following information is pop-up displayed.

Address Format: <Label name> + <Offset value>
Examplel: main + 0x10
Example2: sub function + 0x20
Source line number Format:  <File name> # <Line number>
Examplel: main.c#40
Example2: main.c#100

(3) Disassemble area

The results of disassembling are displayed next to the corresponding source text as follows.
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Figure A.9 Display Contents of Disassemble Area (In Case of Mixed Display Mode)
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Offset value Code Instruction

Label line The label is displayed when a label is defined for the address, and its correspond-
ing line is shown highlighted in lightgreen.
PC line A line corresponding to an address of the current PC (PC register value) is shown

highlightedNot 1,

Breakpoint line

A line at which a breakpoint is set is shown highlightedNote .

Source text line

The source text corresponding to the code data is displayedN°t 2,

Disassem- | Offset value | The offset value from the nearest label is displayed when a label is defined for the
ble results addressNote 3,
Code The code that is the target of disassembly is displayed in hexadecimal number.
Instruction Instruction is displayed as the result of disassembling.
The mnemonics are shown highlighted in blue.
Note 1. The highlighting color depends on the configuration in the [General - Font and Color] category of
the Option dialog box.
Note 2. The source text can be set to non-display by clicking the button (toggle) on the toolbar or
removing the check for [Mixed Display] from the context menu (this option is checked by default).
Note 3. Offset values are not displayed by default. They can be displayed by clicking the button on the

toolbar or selecting [Show Offset] from the context menu.
This area is provided with the following functions.

(@) Line assembly

Instructions and code displayed in this panel can be edited (line assembly).

See "2.6.4 Perform line assembly” for details on how to operate it.

(b) Program execution by instruction level

Execution can be controlled at the instruction level unit by step executing a program in a state where there is a

focus on this panel.
See "2.7.3 Execute programs in steps" for details on how to operate it.

(c) Setting of various events

Various events can be set to the addresses/lines where the caret currently exists by selecting [Bread Settings],

[Trace Settings] or [Timer Settings] from the context menu.

The corresponding Event mark is displayed in the Event area when an event is set. In addition, the detailed

information about the set event is reflected in the Events panel.

+Note, however, that the setting of events can be done only for those lines where the background color is shown

in white in the event area.
See the following for details on how to set events.

- "2.8.5 Stop the program with the access to variables/SFRs"
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- "2.11.3 Collect execution history in a section"
- "2.11.4 Collect execution history only when the condition is met [IECUBE][Simulator]"
- "2.12.3 Measure execution time in a section [IECUBE][Simulator]"

Remark A breakpoint can be set or deleted easily in the Event area as well (see "(a) Setting/deleting
breakpoints").

(d) Registering watch-expression
Variable names of C language, CPU registers, SFR, and assembler symbols can be registered in the Watch
panel as watch-expressions.
See "2.9.6.1 Register a watch-expression” for details on how to operate it.

(e) Moving to symbol definition place
By clicking the button on the toolbar or selecting [Go to Symbol] from the context menu in a state where the
caret has been moved to a instruction that has referenced a symbol, the caret position is moved to the address
where the symbol at the caret position has been defined.
In addition, when following on this operation you click on the button on the toolbar or select [Back to
Address] from the context menu, the caret position is returned to the instruction that has referenced a symbol
before the caret was moved (the address value of the instruction that has referenced a symbol is displayed in
Address).

(f)  Jump to source line and memory
Selecting [Jump to Source] from the context menu will open the Editor panel with the caret moved to the source
line corresponding to the address at the current caret position (if the Editor panel is already open, the screen will
jump to the panel).
In addition, similarly, selecting [Jump to Memory] will open the Memory panel (Memoryl) with the caret moved
to the memory value corresponding to the address at the current caret position (if the Memory panel (Memory1)
is already open, the screen will jump to the panel).

(g) Code coverage measurement result display [IECUBE][Simulator]
When the coverage function is valid\°®, lines corresponding to the specified coverage measurement area are
shown highlighted based on the code coverage measurement result that is acquired by executing the program.
See "2.13 Measure Coverage [IECUBE][Simulator]" for details on the coverage measurement.
Note [IECUBE]

The coverage function is always valid.

(h) Saving the contents of disassembled data
The Data Save dialog box can be opened by selecting the [File] menu >> [Save Disassemble Data As...], and
the contents of this panel can be saved in a text file (*.txt) or CSV file (*.csv). See "2.6.2.5 Save the disassem-
bled text contents" for details on the method for saving the contents of disassembled data.

[Toolbar]

Acquires the latest data from the debug tool, and updates the contents of this panel.

Sets to the mixed display mode and displays the correspondence between the disas-
sembled data and the source text (default).

Specifies the caret position so that it follows the current PC value.

Moves the caret to the define position of the selected symbol.

o = ]

Moves the caret to the position (address) immediately before it is moved with the

button.
View The following buttons to set the display contents in the disassemble area are dis-
played.
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Show Offset Displays the offset value of the label. The offset value from the nearest label is dis-
played when a label is defined for the address.

Show Symbol Displays the address value in the format "symbol + offset value" (default).
Note that when a symbol has been defined as the address value, only the symbol is
displayed.

Show Function Name | Displays the name of the register by its function name (default).

Show Absolute Name | Displays the name of the register by its absolute name.

3 Opens the Scroll Range Settings dialog box to set the scroll range for this panel.

[[File] menu (Disassemble panel-dedicated items)]

The following items are exclusive for the [File] menu in the Disassemble panel (other items are common to all the pan-
els).
Note that all these items are disabled during execution of a program.

Save Disassemble Data Overwrites the contents of the disassembling to the previously saved text file (*.txt)/CSV
file (*.csv) (see "(h) Saving the contents of disassembled data").

Note that when the file has never been saved or the file is write disabled, the same
operation is applied as the selection in [Save Disassemble Data As...].

Save Disassemble Data Opens the Data Save dialog box to newly save the contents of the disassembling to the

As... specified text file (*.txt)/CSV file (*.csv) (see "(h) Saving the contents of disassembled
data").

Print... Opens the Print Address Range Settings dialog box for printing the contents of this
panel.

[[Edit] menu (Disassemble panel-dedicated items)]

The following items are exclusive for the [Edit] menu in the Disassemble panel (all other items are disabled).

Copy When a line is selected, copies the contents of the selected line to the clipboard as a
character string.
In the case of the edit mode, copies the selected character string to the clipboard.

Rename Changes to the edit mode to edit the instruction/code at the caret position (see "2.6.4
Perform line assembly").
This item is disabled during execution of a program.

Find... Opens the Find and Replace dialog box with selecting the [Find in Files] tab.
Replace... Opens the Find and Replace dialog box with selecting the [Replace in Files] tab.
Move... Opens the Go to the Location dialog box to move the caret to the specified address.

[Context menu]

[Disassemble area and Address area]

Register to Watchl Registers the selected character string or the word at the caret position to the Watch
panel (Watchl) as a watch-expression (the judgment of the word depends on current build
tool).

At this time, since it is registered as a variable name, the symbol name that is displayed
changes depending on the scope.

Register Action Event... Opens the Action Events dialog box to set an action event to the address at the caret
position.
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Go to Here

Executes the program from the address indicated by the current PC value to the address
corresponding to the line at the caret position.

This item is disabled during program execution/build (not including rapid build) execu-
tion.

Set PC to Here

Sets the address of the line at the current caret position to the current PC value.
This item is disabled during program execution/build (not including rapid build) execu-

tion.

Move... Opens the Go to the Location dialog box to move the caret to the specified address.

Go to Symbol Moves the caret to the define position of the selected symbol.

Back to Address Moves the caret to the position (address) immediately before it is moved by [Go to Sym-
lkzl(())lgé that this item is disabled when no symbol name is displayed in the address.

Break Settings The following cascade menus are displayed to set the break-related event.

Note that breakpoints can be set only for lines for which events can be set (see "(1)
Event area”).

Set Hardware Break

Sets a breakpoint (Hardware Break event to the address at the caret position (see "2.8.3
Stop the program at the arbitrary position (breakpoint)").

Set Software Break
(except [Simulator])

Sets a breakpoint (Software Break event) to the address at the caret position (see "2.8.3
Stop the program at the arbitrary position (breakpoint)").

Set Combination Break
[E1][E20]

Sets a break event (execution type) to the address at the caret position as one of the
condition for a combination break event (see "2.8.4.1 Set a break event (execution
type)")NOte 1.

Set Read Break to

Sets a break event with read access condition to a variable at the caret or a selected
variable (global variable/static variable inside functionsf/file-internal static variable)/SFR
(see "2.8.5.1 Set a break event (access type)").

Set Write Break to

Sets a break event with write access condition to a variable at the caret or a selected
variable (global variable/static variable inside functions/file-internal static variable)/SFR
(see "2.8.5.1 Set a break event (access type)").

Set R/W Break to

Sets a break event with read/write access condition to a variable at the caret or a
selected variable (global variable/static variable inside functions/file-internal static vari-
able)/SFR (see "2.8.5.1 Set a break event (access type)").

Set Read Combination
Break to
[E1][E20]

Sets a break event with read access condition to the line at the caret or the selected vari-
able (global variable, static variable inside functions, or file-internal static variable)/SFR
as one of the condition for a combination break event (see "2.8.5.1 Set a break event
(access type)")Note 1,

Set Write Combination
Break to
[E1][E20]

Sets a break event with write access condition to the line at the caret or the selected vari-
able (global variable, static variable inside functions, or file-internal static variable)/SFR
as one of the condition for a combination break event (see "2.8.5.1 Set a break event
(access type)")Note 1.

Set R/W Combination
Break to
[E1][E20]

Sets a break event with read/write access condition to the line at the caret or the
selected variable (global variable, static variable inside functions, file-internal static vari-
able)/SFR as one of the condition for a combination break event (see "2.8.5.1 Seta
break event (access type)")Note 1.

Break Option

Opens the Property panel to set the break function.

Trace Settings

The following cascade menus are displayed to set the trace-related eventNot 2,
Note that events can be set only for lines for which events can be set (see "(1) Event
area").
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Start Tracing Sets a trace start event to start collecting the trace data when an instruction of an
address at the caret position is executed (see "2.11.3.1 Set a Trace event").
[Simulator]
In addition, the selecting of the [Use trace function] property in the [Trace] category on
the Property panel is automatically set to [Yes].
Stop Tracing Sets a trace end event to stop collecting the trace data when an instruction of an address

at the caret position is executed (see "2.11.3.1 Set a Trace event").

[Simulator]
In addition, the selecting of the [Use trace function] property in the [Trace] category on
the Property panel is automatically set to [Yes].

Record Reading Value

Sets a Point Trace event to record the access value as the trace data when a variable at
the caret or the selected variable (global variable, static variable inside functions, file-
internal static variable) or SFR is read accessed (see "2.11.4.1 Set a Point Trace
event").

Record Writing Value

Sets a Point Trace event to record the access value as the trace data when a variable at
the caret or the selected variable (global variable, static variable inside functions, file-
internal static variable) or SFR is write accessed (see "2.11.4.1 Set a Point Trace
event").

Record R/W Value

Sets a Point Trace event to record the access value as the trace data when a variable at
the caret or a selected variable (global variable/static variable inside functions/file-inter-
nal static variable)/SFR is read/write accessed (see "2.11.4.1 Set a Point Trace event").

Record Start R/W
Value
[E1][E20][COM Port]

Sets a trace start event to start collecting the trace data when a variable at the caret or
the selected variable (global variable, static variable inside functions, file-internal static
variable) /SFR is read/ write accessed (see "2.11.3.1 Set a Trace event").

Record End R/W Value
[E1][E20][COM Port]

Sets a trace end event to stop collecting the trace data when a variable at the caret or
the selected variable (global variable, static variable inside functions, file-internal static
variable) /SFR is read/ write accessed (see "2.11.3.1 Set a Trace event").

Show Trace Result

Opens the Trace panel and displays the acquired trace data.

Trace Settings

Opens the Property panel to set the trace function.

Timer Settings
[IECUBE][Simulator]

The following cascade menus are displayed to set the timer-related event (see "2.12.3
Measure execution time in a section [IECUBE][Simulator]").

Note that events can be set only for lines for which events can be set (see "(1) Event
area").

Start timer

Sets a timer start event to start measuring the execution time of the program when an
instruction of an address at the caret position is executed.
[Simulator]
In addition, the selecting of the [Use timer function] property in the [Timer]
[[ECUBE][Simulator] category on the Property panel is automatically set to [Yes].

Stop timer

Sets a timer end event to stop measuring the execution time of the program when an
instruction of an address at the caret position is executed.
[Simulator]
In addition, the selecting of the [Use timer function] property in the [Timer]
[[ECUBE][Simulator] category on the Property panel is automatically set to [Yes].

View Result of Timer

Opens the Events panel and displays only timer-related events.

Clear Coverage Informa-
tion

Clears all the coverage measurement results currently being stored in the debug tool.
Note that this item appears only when the debug tool used supports the coverage func-
tion.

Edit Disassemble

Changes to the edit mode to edit the instruction of the line at the caret position (see
"2.6.4 Perform line assembly").
This item is disabled during execution of a program.
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Edit Code Changes to the edit mode to edit the code of the line at the caret position (see "2.6.4
Perform line assembly").
This item is disabled during execution of a program.
View The following cascade menus to set the display contents in the disassemble area are
displayed.
Show Offset Displays the offset value of the label. The offset value from the nearest label is displayed
when a label is defined for the address.
Show Symbol Displays the address value in the format "symbol + offset value" (default).

Note that when a symbol has been defined as the address value, only the symbol is dis-
played.

Show Function Name

Displays the name of the register by its function name (default).

Show Absolute Name

Displays the name of the register by its absolute name.

Settings Scroll Range...

Opens the Scroll Range Settings dialog box to set the scroll range for this panel.

Mixed Display

Sets to the mixed display mode and displays the correspondence between the disas-
sembled data and the source text (default).

Jump to Source

Opens the Editor panel and jumps to the source line corresponding to the address at the
caret position in this panel.

Jump to Memory

Opens the Memory panel (Memoryl) and jumps to the memory value corresponding to
the address at the caret position in this panel.

Note 1. [E1][E20]

This item is displayed only when the selected microcontroller supports combination break events.

Note 2. [E1][E20][EZ Emulator][COM Port]
This item is enabled only when the selected microcontroller incorporates the OCD trace function.

[Event area] (except [Simulator])

Hardware Break First

The type of break that can be set by a one click operation of the mouse is set as a hard-
ware breakpoint (this is reflected in the setting of the [First using type of breakpoint] prop-
erty in the [Break] category on the Property panel).

Software Break First

The type of break that can be set by a one click operation of the mouse is set as a software
breakpoint (this is reflected in the setting of the [First using type of breakpoint] property in
the [Break] category on the Property panel).

R20UT4857EJ0100 Rev.1.00 RENESAS Page 194 of 391

Nov 01, 2020



CS+Vv8.05.00 A. WINDOW REFERENCE

CPU Register panel

This panel is used to display the contents of the CPU register (general-purpose registers and control registers) and
change the CPU register values (see "2.9.2 Display/change the CPU register").
This panel appears only when connected to the debug tool.

Remark 1. This panel can be zoomed in and out by |1 a0x -| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.

Remark 2. When the separator line of each area in this panel is double-clicked, the width of the area changes to the
shortest possible size that can display the contents of the area.

Figure A.10 CPU Register Panel
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This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (CPU Register panel-dedicated items)]
- [[Edit] menu (CPU Register panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [CPU Register].

[Description of each area]

(1) [Register Name] area
The types of register are classified as categories (folders), and a list of the respective register names is displayed.
Note that neither category names nor register names can be edited and deleted.
The meanings of the icons are as follows:

L{ Indicates that the register name belonging to this category is displayed. When you double-click
on the icon, or click on the "-" mark, the category is closed and the register name is hidden.

& Indicates that the register name belonging to this category is hidden. When you double-click on
the icon, or click on the "+" mark, the category is opened and the register name is displayed.

J Indicates the name of the register. When you double-click on the icon, or click on the "+" or "-"
marks, the name of the register part is displayed or hidden.
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= Indicates the name of the register part.

Category names and register names displayed are as follows (number of "+" marks before register names indi-
cates the depth of the display level):

Table A.3 Category Names and Register Names in CPU Register Panel

Category Name Register Name (Alias) Bit Width Description
General-purpose + AX(RPO) 16 General-purpose register (current register
register ++ X(RO) g bank)

++ A(R1) 8
+ BC(RP1) 16
++ C(R2) 8
++ B(R3) 8
+ DE(RP2) 16
++ E(R4) 8
++ D(R5) 8
+ HL(RP3) 16
++ L(R6) 8
++ H(R7) 8
Control register +PC 20 Program counter
+ PSW 8 Program status word
++ |E 1 Interrupt enable flag
++Z 1 Zero flag
++ RBS1 1 Register bank selection flag
++ AC 1 Auxiliary carry flag
++ RBS0 1 Register bank selection flag
++ ISP1 1 In service priority flag
++ ISPO 1 In service priority flag
++ CY 1 Carry flag
+ SP 16 Stack pointer
+ES 8 ES register
+CS 8 CS register
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Category Name Register Name (Alias) Bit Width Description
General-purpose + AX(RPO): Register bankn | 16 General-purpose register (Register bank n)
register: Register )
bank nNote + X(RO): Register bank n | 8

++ A(R1): Register bank n | 8

+ BC(RP1): Register bankn | 16

++ C(R2): Register bank n | 8

++ B(R3): Register bank n | 8

+ DE(RP2): Register bank n | 16

++ E(R4): Register bank n | 8

++ D(R5): Register bank n | 8

+ HL(RP3): Register bank n | 16

++ L(R6): Register bankn | 8

++ H(R7): Register bankn | 8

Note "n" indicates the number of the register bank (n =0, 1, 2, 3).

This area is provided with the following functions.

(a) Registering watch-expression
CPU registers/categories can be registered in the Watch panel as watch-expressions.
See "2.9.6.1 Register a watch-expression” for details on how to operate it.

Remark 1. When you have registered a watch-expression with a category as the object, all of the CPU reg-
isters belonging to that category are registered as watch-expressions.

Remark 2. A scope specification is automatically added to a registered watch-expression.

(2) [Value] area
The values of each CPU register are displayed and changed.
The radix of a data value can be selected by the button on the toolbar or the context menu item. In addition, a dis-
play format adding the value in hexadecimal number constantly can also be selected as well.
The meanings of the colors of the CPU register values are as follows (character colors and background colors
depend on the configuration in the [General - Font and Color] category of the Option dialog box):

Display Example (Default) Description

00 Character color Blue The value of the CPU register that the user is changing
Press the [Enter] key to write to the target memory.

Background color | Standard color

00 Character color Brown The value of the CPU register that has been changed because
of the execution of a program.
Background color | Cream The highlighting is rest by executing again the program.

This area is provided with the following functions.

(@) Changing the CPU register value
To edit the CPU register value, select the value to edit, then change the value directly from the keyboard after
clicking again on it (press the [Esc] key to cancel the edit mode).
After you edit the value of the CPU register, it is written to the target memory of the debug tool by pressing the
[Enter] key or moving the focus to outside the edit region.

(b) Saving the contents of the CPU register
The Save As dialog box can be opened by selecting the [File] menu >> [Save CPU Register Data As...], and all
the contents of this panel can be saved in a text file (*.txt) or CSV file (*.csv).
See "2.9.2.4 Save the CPU register contents" for details on the method for saving the contents of the CPU reg-
ister.
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[Toolbar]
El| Acquires the latest data from the debug tool, and updates the contents of this panel.
This item is disabled during execution of a program.
Notation The following buttons to change the notation of a data value are displayed.
ﬁ AutoSelect Displays the value of the selected item (including sub-items) in the default notation
(default).
. Hexadecimal Displays the value of the selected item (including sub-items) in hexadecimal number.
Signed Decimal Displays the value of the selected item (including sub-items) in signed decimal number.

Unsigned Decimal | Displays the value of the selected item (including sub-items) in unsigned decimal number.

E Octal Displays the value of the selected item (including sub-items) in octal number.
Binary Displays the value of the selected item (including sub-items) in binary number.
ASCII Displays the character string of the selected item (including sub-items) in ASCII code. If

the character size is 2 bytes and above, it is displayed with the characters for each 1 byte
arranged side-by-side.

Float Displays the value of the selected item in Float.
Note that when the value is not 4-byte data, displays it in the default notation.

Double Displays the value of the selected item in Double.
Note that when the value is not 8-byte data, displays it in the default notation.

Adds the value in hexadecimal number enclosing with "()" at the end of the value.

[[File] menu (CPU Register panel-dedicated items)]

The following items are exclusive for the [File] menu in the CPU Register panel (other items are common to all the pan-
els).
Note that all these items are disabled during execution of a program.

Save CPU Register Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file (*.csv)
Data (see "(b) Saving the contents of the CPU register").

Note that when the file has never been saved or the file is write disabled, the same opera-
tion is applied as the selection in [Save CPU Register Data As...].

Save CPU Register Opens the Save As dialog box to newly save the contents of this panel to the specified text
Data As... file (*.txt)/CSV file (*.csv) (see "(b) Saving the contents of the CPU register"”).

[[Edit] menu (CPU Register panel-dedicated items)]

The following items are exclusive for [Edit] menu in the CPU Register panel (all other items are disabled).

Cut Deletes the selected character string and copies it to the clipboard.
This item becomes valid only when the character string is being edited.

Copy Copies the selected character string to the clipboard during editing.
If a line is selected, copies the register or the category to the clipboard.
The copied item can be pasted to the Watch panel.

Paste Pasts the character string copied in the clipboard to the caret position.
This item becomes valid only when the character string is being edited.

Select All Selects all the items of this panel.

Find... Opens the Find and Replace dialog box with selecting the [Find in Files] tab.

Replace... Opens the Find and Replace dialog box with selecting the [Replace in Files] tab.
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[Context menu]

Register to Watchl

Registers the selected register or category to the Watch panel (Watch1l).

Copy Copies the selected character string to the clipboard during editing.
If a line is selected, copies the register or the category to the clipboard.
The copied item can be pasted to the Watch panel.
Notation The following cascade menus to specify the notation of a data value are displayed.
AutoSelect Displays the value of the selected item (including sub-items) in the default notation
(default).
Hexadecimal Displays the value of the selected item (including sub-items) in hexadecimal number.

Signed Decimal

Displays the value of the selected item (including sub-items) in signed decimal number.

Unsigned Decimal

Displays the value of the selected item (including sub-items) in unsigned decimal number.

Octal Displays the value of the selected item (including sub-items) in octal number.

Binary Displays the value of the selected item (including sub-items) in binary number.

ASCII Displays the character string of the selected item (including sub-items) in ASCII code.
If the character size is 2 bytes and above, it is displayed with the characters for each 1
byte arranged side-by-side.

Float Displays the value of the selected item in Float.

Note that when the value is not 4-byte data, displays it in the default notation.

Double Displays the value of the selected item in Double.

Note that when the value is not 8-byte data, displays it in the default notation.

Include Hexadecimal
Value

Adds the value in hexadecimal number enclosing with "()" at the end of the value.
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SFR panel

This panel is used to display the contents of the SFR and change the SFR values (see "2.9.3 Display/change the
SFR").
This panel appears only when connected to the debug tool.

Caution The SFR that cause the microcontroller to operate when it is read is read-protected and therefore cannot
be read ("?" is displayed in the value).
To read the value of read-protected SFR, select [Force Read Value] from the context menu.

Remark 1. This panel can be zoomed in and out by |1 a0k -| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.

Remark 2. When the separator line of each area in this panel is double-clicked, the width of the area changes to the
shortest possible size that can display the contents of the area.

Figure A.11 SFR Panel
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This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (SFR panel-dedicated items)]
- [[Edit] menu (SFR panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [SFR].

[Description of each area]

(1) Search area
This area is used to search for the SFR name.

|= Specifies the character strings to search (case-insensitive).
You can either type character strings directly from the key board (up to 512 characters), or
select one from the input history via the drop-down list (up to 10 items).
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Searches up for the SFR name containing the string specified in the text box, and selects
the SFR that is found.

Searches down for the SFR name containing the string specified in the text box, and selects

the SFR that is found.

)

(@)

(b)

©)

Remark 1. A hidden SFR name being classified with a category can be searched (the category is opened and
the SFR is selected).

Remark 2. After typing character strings to search, to press the [Enter] key is the same function as clicking the
button, and to press the [Shift] + [Enter] key is the same function as clicking the button.

[SFR] area
The types of SFR are classified as categories (folders), and a list of the respective SFR name is displayed.
The meanings of the icons are as follows:

Indicates that the SFR name belonging to this category is displayed. When you double-click on
the icon, or click on the "-" mark, the category is closed and the SFR name is hidden.
Note that no categories exist by default. Perform Tree editing if you need a category.

Indicates that the SFR name belonging to this category is hidden. When you double-click on the
icon, or click on the "+" mark, the category is opened and the SFR name is displayed.
Note that no categories exist by default. Perform Tree editing if you need a category.

= Indicates the name of the SFR.

Remark The category names are sorted in character code order by clicking on the header part of this area
(the SFR names in the category are also similarly sorted).

This area is provided with the following functions.

Tree editing

The each SFR can be categorized (by folders) and displayed in the tree view.

To create a category, Click the button on the toolbar or select [Create Category] from the context menu after
moving the caret to a SFR name to create a category, and then input a desired name from the keyboard (up to

1024 characters).

To delete a category, select the category then click the button on the toolbar or select [Delete] from the con-
text menu. However, the categories that can be deleted are only the empty categories.

To rename the created category, select the category then do either one of the following.

- Click the name again, then directly rename the category name.
- Select the [Edit] menu >> [Rename], then directly rename the category name.
- Press the [F2] key, then directly rename the category name.

By directly dragging and dropping the SFR in the created category, each SFR is displayed in the categorized

tree view.
Also, the display order of the categories and the SFR names (upper or lower position) can be changed easily by

drag and drop operation.
Caution 1.  Categories cannot be created within categories.
Caution 2.  SFRs cannot be added or deleted.

Registering a watch-expression
Variable names of C language, CPU registers, SFR, and assembler symbols can be registered in the Watch

panel as watch-expressions.
See "2.9.6.1 Register a watch-expression” for details on how to operate it.

Remark 1. When you have registered a watch-expression with a category as the object, all of SFR belong-
ing to that category are registered as watch-expressions.

Remark 2. A scope specification is automatically added to a registered watch-expression.

[Value] area

The value of SFR is displayed and changed.

The radix of a data value can be selected by the button on the toolbar or the context menu item. In addition, a dis-
play format adding the value in hexadecimal number constantly can also be selected as well.
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The meanings of the marks and colors displayed as SFR values are as follows (character colors and background
colors depend on the configuration in the [General - Font and Color] category of the Option dialog box):

Display Example (Default) Description

00 Character color Blue The value of the SFR that the user is changing (press the
[Enter] key to write to the target memory).

Background color | Standard color

(WA Character color Brown The value of the SFR that has been changed because of the
execution of a program
Background color | Cream To reset the highlighting, select the button on the toolbar or

[Reset Color] from the context menu.

b Character color Gray The value of the SFR that is a read-protected objectNOte

Background color | Standard color

Note An SFR for which the microcontroller ends up being activated by a read operation is shown.
To read the value of read-protected SFR, select [Force Read Value] from the context menu.

Caution The timing for acquiring the values differs in the case of a 1 byte/2 bytes SFR and that of 1 bit SFRs
that have been allocated to a 1 byte/2 bytes SFR. Owing to this, there are also cases where the
values differ even if the value of the same SFR is displayed.

Remark The values are sorted in ascending order of the numerical values by clicking on the header part of
this area.

This area is provided with the following functions.

(@) Changing SFR values
To edit the SFR value, select the value to edit, then change the value directly from the keyboard after clicking
again on it (press the [Esc] key to cancel the edit mode).
After you edit the value of the SFR, it is written to the register of the debug tool by pressing the [Enter] key, or
moving the focus to outside the edit region.
See "2.9.3.4 Modify the SFR contents" for details on the method for changing the SFR value.

(b) Saving the contents of the SFR
The Save As dialog box can be opened by selecting the [File] menu >> [Save SFR Data As...], and all the con-
tents of the SFR can be saved in a text file (*.txt) or CSV file (*.csv).
See "2.9.3.6 Save the SFR contents" for details on the method for saving the contents of the SFR.

(4) [Type (Byte Size)] area
The type information of each SFR is displayed in the following formats.

- <Type of SFR> [<Access attribute> <All accessible sizes>](<Size>)

Access attribute One of the following is displayed as the access attribute.
R Read only
W Write only
R/W Read/Write
All accessible All accessible sizes are demarcated by a comma and listed in order of the smallest size in
sizes bit units.
Size The size of the SFR is displayed.
It is displayed by supplying the unit, in byte units in the event that it can be displayed in
byte units, and in bit units in the event that it can be displayed on in bit units.

Example 1. "The case of "SFR [R/W 1.8] (1 byte)"
An SFR that is readable/writable and 1 bit accessible/8 bit accessible, and whose size is 1 byte

Example 2.  "The case of "SFR [R/W 1] (1 bit)"
An SFR that is readable/writable and 1 bit accessible, and whose size is 1 byte

Remark The type information is sorted in the character code order by clicking on the header part of this
area.
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(5) [Address] area

The address that each SFR is mapped is displayed (hexadecimal number notation fixing).
However, in the case of the bit register, it is displayed by providing a bit offset value like the following examples.

Example 1.  The case of "OxFF40"
This is allocated to the address "OxFF40"

Example 2.  The case of "OxFF40.4"
This is allocated to bit 4 of the address "OxFF40.4" (bit register)

Remark The addresses are sorted in ascending order of numerical values by clicking on the header part of
this area.

[Toolbar]

El|

Acquires the latest data from the debug tool, and updates the contents of this panel.
Note that the values of read-protected SFR are not re-read.
This item is disabled during execution of a program.

Resets highlighting of the selected SFR whose value has been changed by executing a
program.
Note that this item is disabled during execution of a program.

Adds a new category (folder). Directly input the category name in the text box.

There are no restrictions on the number of categories that can be created anew (how-
ever, it is not possible to create a category inside a category).

Note that this item is disabled during execution of a program.

Deletes the selected character string(s).
If an empty category is in a select state, its category is deleted (it is not possible to delete
SFRs).

Notation

The following buttons to change the notation of a data value are displayed.

. Hexadecimal

Displays the value of the selected item in hexadecimal number (default).

Signed Decimal

Displays the value of the selected item in signed decimal number.

Unsigned Decimal

Displays the value of the selected item in unsigned decimal number.

H Octal

Displays the value of the selected item in octal number.

Binary

Displays the value of the selected item in binary number.

[s=] ASCII

Displays the value of the selected item in ASCII code.

Adds the value in hexadecimal number enclosing with "()" at the end of the value of the
selected item.

[[File] menu (SFR panel-dedicated items)]

The following items are exclusive for the [File] menu in the SFR panel (other items are common to all the panels).
Note that all these items are disabled during execution of a program.

Save SFR Data

Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file
(*.csv) (see "(b) Saving the contents of the SFR").

Note that when the file has never been saved or the file is write disabled, the same
operation is applied as the selection in [Save SFR Data As...].

Save SFR Data As...

Opens the Save As dialog box to newly save the contents of this panel to the speci-
fied text file (*.txt)/CSV file (*.csv) (see "(b) Saving the contents of the SFR").

[[Edit] menu (SFR panel-dedicated items)]

The following items are exclusive for [Edit] menu in the SFR panel (all other items are disabled).
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Cut Deletes the selected character string(s) and copies them to the clipboard (it is not
possible to cut SFRs/categories).

Copy Copies the contents of the selected range to the clipboard as character string(s).
If the SFR(s)/category(s) are selected, copies them to the clipboard.
The copied item can be pasted to the Watch panel.

Paste If texts are in editing, pastes the contents of the clipboard to the caret position (it is
not possible to paste SFRs/categories).

Delete Deletes the selected character string(s).
If an empty category is in a select state, its category is deleted (it is not possible to
delete SFRs).

Select All If texts are in editing, selects all the character strings.
If texts are not in editing, selects all the SFRs/categories.

Rename Edits the name of the selected category.

Find... Moves the focus to the text box in the Search area.

Move... Opens the Go to the Location dialog box to move the caret to the specified SFR.

[Context menu]

Register to Watchl

Registers the selected SFR or category to the Watch panel (Watch1l).

Refresh

Acquires the latest data from the debug tool, and updates the contents of this panel.
Note that the values of read-protected SFR are not re-read.
This item is disabled during execution of a program.

Force Read Value

Forcibly reads once the value of the read-protected SFR.

Move...

Opens the Go to the Location dialog box.

Create Category

Adds a new category (folder). Directly input the category name in the text box.
There are no restrictions on the number of categories that can be created anew
(however, it is not possible to create a category inside a category).

Note that this item is disabled during execution of a program.

Copy

Copies the contents of the selected range to the clipboard as character string(s).
If the SFR(s)/category(s) are selected, copies them to the clipboard.
The copied item can be pasted to the Watch panel.

Delete

Deletes the selected character string(s).
If an empty category is in a select state, its category is deleted (it is not possible to
delete SFRs).

Notation

The following cascade menus are displayed to specify the notation.

Hexadecimal number

Displays the value of the selected item in hexadecimal number (default).

Signed Decimal

Displays the value of the selected item in signed decimal number.

Unsigned decimal number

Displays the value of the selected item in unsigned decimal number.

Octal Displays the value of the selected item in octal number.
Binary Displays the value of the selected item in binary number.
ASCII Displays the value of the selected item in ASCII code.

Include Hexadecimal Value

Adds the value in hexadecimal number enclosing with "()" at the end of the value of
the selected item.
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Reset Color Resets highlighting of the selected SFR whose value has been changed by execut-
ing a program.
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Local Variables panel

This panel is used to display the contents of the local variable and change the local variable values (see "2.9.5 Display/
change local variables").
This panel appears only when connected to the debug tool.

Caution 1.  Nothing is displayed on this panel during execution of a program. When the execution of a program is
stopped, items in each area are displayed.

Caution 2.  Because of optimization by a compiler, for blocks where variables, or the subject to be operated on, are
not in use, there may be no variable data in the stack and registers. In this case, no variables are dis-
played that are the subject to be operated on.

Remark 1. This panel can be zoomed in and out by |1 a0x --| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.

Remark 2. When the separator line of each area in this panel is double-clicked, the width of the area changes to the
shortest possible size that can display the contents of the area.

Figure A.12 Local Variables Panel
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This section describes the following.
- [How to open]
- [Description of each area]
- [Toolbar]
- [[File] menu (Local Variables panel-dedicated items)]
- [[Edit] menu (Local Variables panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Local Variable].

[Description of each area]

(1) Scope area
Select the scope of the local variable to be displayed from the following drop-down list.

Item Operation

Current Displays local variables in the scope of the current PC value.

<Depth> <Function name() [file name#line | Displays local variables in the scope of the calling function.
number]>Note 12 After the program is executed, the scope that is selected is main-
tained as long as the selected scope exists.
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Note 1. The calling functions displayed on theCall Stack panel are displayed.
Note 2. When scope information that has lost its reliability, items in the list is shown in gray (the character

color/background color when showing "Invalid" depends on the configuration in the [General - Font
and Color] category of the Option dialog box).

[Name] area

The local variable name or function name is displayed.

The argument of the function is also displayed as the local variable.

In addition, the hierarchical structure is displayed in tree format for arrays, pointer variables, and structures or
unions.

This area cannot be edited.

The meanings of the icons are as follows:

. Indicates the variable. Auto, Internal Static, and Register variables are also displayedNOte.

In addition, the hierarchical structure is displayed in tree format for arrays, pointer variables, and struc-
tures or unions.

If "+" mark exist at the top of the name, the next structure is expanded by clicking it (the mark changes
to "-" after the expansion).

Array All elements in the array

Pointer variables | Variables that the pointer designates
If the pointer designates a pointer, add "+" mark and expand it by clicking the mark.
Note that if the pointer designates an unknown, "?" mark is displayed.

Structures/Unions | All the member of structures/unions

Indicates the argument.

Indicates the function.

Note When Auto variables are used to display local variables, accurate values cannot be displayed at a
prologue ("{") or epilogue ("}") of a function. The Auto variable addresses are the relative
addresses from the address pointed to by the stack pointer (SP), so their addresses are not deter-
mined until the SP value is determined in the function. The SP is manipulated via prologues or epi-
logues, so the accurate value cannot be displayed.

This area is provided with the following functions.

Registering watch-expression
Variable names of C language can be registered in the Watch panel as watch-expressions.
See "2.9.6.1 Register a watch-expression" for details on how to operate it.

Remark A scope specification is automatically added to a registered watch-expression.

Jump to memory

By selecting [Jump to Memory] from the context menu, the Memory panel (Memory1l) opens with moving the
caret to the source line corresponding to the address where the selected local variable is disposed (if the Mem-
ory panel (Memoryl) is already open, the screen will jump to the panel).

[Value] area

The value of the local variable is displayed and changed.

The notation of a data value can be selected by the button on the toolbar or the context menu item. In addition, a
display format adding the value in hexadecimal number constantly can also be selected as well.

The meanings of the marks and colors displayed as the values of the local variables are as follows (character col-
ors and background colors depend on the configuration in the [General - Font and Color] category of the Option
dialog box):

Display Example (Default) Description

00 | Character color Blue The value of the local variable that the user is changing
Press the [Enter] key to write to the target memory.

Background color | Standard color

0«0 | Character color Brown The value of the local variable that have been changed because
of the execution of a programNOte.
Background color | Cream The highlighting is rest by executing again the program.
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Display Example (Default) Description

b Character color Gray The value of the local variable that could not be acquired.

Background color | Standard color

Note Variables that the name stays same from the start point where the program started executing to the
breakpoint and their values are changed are the target.

This area is provided with the following functions.

(@) Changing the local variable/argument value
To edit the local variable value or the argument value, select the value to edit, then change the value directly
from the keyboard after clicking again on it (press the [Esc] key to cancel the edit mode).
After you edit the value of the local variable or the argument, it is written to the target memory of the debug tool
by pressing the [Enter] key or moving the focus to outside the edit region.
See "2.9.5.2 Modify the contents of local variables" for details on the method for changing the local variable/
argument value.

(b) Saving the contents of the local variable
The Save As dialog box can be opened by selecting the [File] menu >> [Save Local Variables Data As...], and all
the contents of this panel can be saved in a text file (*.txt) or CSV file (*.csv).
See "2.9.5.3 Save the contents of local variables" for details on the method for saving the contents of the local
variable.

(4) [Type (Byte Size)] area
The type name of the local variable is displayed. The notation accords with the description of C language.
For an array, an element number is displayed in "[]". For a function, its size (number of bytes) is displayed in "()".
This area cannot be edited.

(5) [Address] area
The address of the local variable is displayed. When a variable is assigned to the register, the name of the register
is displayed.
This area cannot be edited.

[Toolbar]

These buttons below are disabled during execution of a program.

Bl Acquires the latest data from the debug tool, and updates the con-
tents of this panel.

Notation The following buttons to specify the notation of values are displayed.
M AutoSelect Displays values on this panel in the default notation according to the
type of variable (default).
. Hexadecimal Displays values on this panel in hexadecimal number.
. Decimal Displays values on this panel in decimal number.
Octal Displays values on this panel in octal number.
Binary Displays values on this panel in binary number.
Decimal Notation for Array Index Displays array indexes on this panel in decimal number (default).

Hexadecimal Notation for Array Index | Displays array indexes on this panel in hexadecimal number.

ﬂ Float Displays values on this panel in Float.
Note that when the value is not 4-byte data, or has the type informa-
tion, displays it in the default notation.

. Double Displays values on this panel in Double.
Note that when the value is not 4-byte data, or has the type informa-
tion, displays it in the default notation.
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Adds the value in hexadecimal number enclosing with "()" at the end
of the value.
Encoding The following buttons to specify the encoding of character variables
are displayed.
Displays character variables in ASCII code (default).
Displays character variables in Shift_JIS code.
Displays character variables in EUC-JP code.
| Displays character variables in UTF-8 code.
[ Displays character variables in UTF-16 code.

[[File] menu (Local Variables panel-dedicated items)]

The following items are exclusive for the [File] menu in the Local Variables panel (other items are common to all the pan-
els).
Note that all these items are disabled during execution of a program.

Save Local Variables Data | Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file
(*.csv) (see "(b) Saving the contents of the local variable™).

Note that when the file has never been saved or the file is write disabled, the same
operation is applied as the selection in [Save Local Variables Data As...].

Save Local Variables Data | Opens the Save As dialog box to newly save the contents of this panel to the specified
As... text file (*.txt)/CSV file (*.csv) (see "(b) Saving the contents of the local variable™).

[[Edit] menu (Local Variables panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Local Variables panel (all other items are disabled).

Copy Copies the contents of the selected line or the character string to the clipboard.
Select All Selects all the items of this panel.
Rename Changes to the edit mode to edit the selected local variable value (see "2.9.5.2 Modify

the contents of local variables").
This item is disabled during execution of a program.

Find... Opens the Find and Replace dialog box with selecting the [Find in Files] tab.

Replace... Opens the Find and Replace dialog box with selecting the [Replace in Files] tab.

[Context menu]

Register to Watch1 Registers the selected local variable to the Watch panel (Watchl).

Copy Copies the contents of the selected line or the character string to the clipboard.

Notation The following cascade menus to specify the notation of values are displayed.
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AutoSelect Displays values on this panel in the default notation according to the type of variable
(default).

Hexadecimal Displays values on this panel in hexadecimal number.

Decimal Displays values on this panel in decimal number.

Octal Displays values on this panel in octal number.

Binary Displays values on this panel in binary number.

Decimal Notation for Displays array indexes on this panel in decimal number (default).

Array Index

Hexadecimal Notation Displays array indexes on this panel in hexadecimal number.
for Array Index

Float Displays values on this panel in Float.
Note that when the value is not 4-byte data, or has the type information, displays it in the
default notation.

Double Displays values on this panel in Double.
Note that when the value is not 4-byte data, or has the type information, displays it in the
default notation.

Include Hexadecimal Adds the value in hexadecimal number enclosing with "()" at the end of the value.
Value
Encoding The following cascade menus to specify the encoding of character variables are dis-
played.
ASCII Displays character variables in ASCII code (default).
Shift_JIS Displays character variables in Shift_JIS code.
EUC-JP Displays character variables in EUC-JP code.
UTF-8 Displays character variables in UTF-8 code.
UTF-16 Displays character variables in UTF-16 code.
Jump to Memory Opens the Memory panel (Memory1) and jumps to the memory value corresponding to

the address of the selected line in this panel.
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Watch panel

This panel is used to display the contents of the registered watch-expressions and change their values (see "2.9.6 Dis-
play/change watch-expressions").

Up to a maximum of four of these panels can be opened. Each panel is identified by the names "Watch1", "Watch2",
"Watch3", and "Watch4" on the titlebar, and the watch-expressions can be registered/deleted/moved individually.

Watch-expressions can be registered in this panel as well as in the Editor panel, Disassemble panel, Memory panel,
CPU Register panel, Local Variables panel or SFR panel.

When the panel is closed with registered watch-expressions, the panel closes but the information on the registered
watch-expressions is retained. Therefore, if the same panel is opened again, it is opened with the watch-expressions reg-
istered.

The display contents are automatically updated when the value of the watch-expression changes after a program is
executed (when the execution is done in steps, the display is updated after each step).

In addition, by enabling the Real-time display update function, it is also possible to update the display contents in real-
time even while a program is being executed.

This panel appears only when connected to the debug tool.

Caution 1.  Itis not possible to display or change the CPU register contents during program execution.

Caution 2.  In a block where a variable that is the subject of operation is not used, variable data may not always exist
in the stack or register, due to optimization by a compiler. In this case, even when a variable that is the
subject of operation is registered as a watch-expression, the displayed value remains marked with "?."

Remark 1. This panel can be zoomed in and out by |1 a0x -| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.

Remark 2. When the separator line of each area in this panel is double-clicked, the width of the area changes to the
shortest possible size that can display the contents of the area.

Figure A.13 Watch Panel
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This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (Watch panel-dedicated items)]
- [[Edit] menu (Watch panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Watch] >> [Watchl - 4].
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[Description of each area]

(1) [Watch] area
All the registered watch-expressions are displayed in a list.
Clicking the title of the list in this area sorts the watch-expressions in the list in alphabetical order.
Categories (folders) can be created to categorize the watch-expressions and display them in the tree view (see
"(a) Tree editing").
The meanings of the icons are as follows:

Indicates that the watch-expression belonging to this category is displayed. When you double-
click on the icon, or click on the "-" mark, the category is closed and the watch-expression is
hidden.

Indicates that the watch-expression belonging to this category is hidden. When you double-
click on the icon, or click on the "+" mark, the category is opened and the watch-expression is
displayed.

Indicates that the watch-expression is a variable.
At the top of the watch-expression represents arrays, pointer type variables, and structures/
unions, "+"/"-" mark is displayed. Click the mark to Expand/shrink display.

Indicates that the watch-expression is a function.

EE Indicates that the watch-expression is an immediate value.
fied Indicates that the watch-expression is an expression.

5 Indicates that the watch-expression is SFR.

J Indicates that the watch-expression is CPU register.

At the top of the watch-expression that has the lower level register (part of the register), "+"/"-"
mark is displayed. Click the mark to Expand/shrink display.

This area is provided with the following functions.

(a) Tree editing
Watch-expressions can be categorized (by folders) and displayed in the tree view.
To create a category, click the button on the toolbar or select [Create Category] from the context menu after
moving the caret to the position to create a category, and then input a desired name from the keyboard.
To delete a category, select the category then click the button on the toolbar or select [Delete] from the con-

text menu.
To rename the created category, select the category then do either one of the following.

- Click the name again, then directly rename the category name.
- Select the [Edit] menu >> [Rename], then directly rename the category name.

- Press the [F2] key, then directly rename the category name.

By directly dragging and dropping the registered watch-expression in the created category, each category is dis-

played in the categorized tree view.
Also, the display order of the categories and the watch-expressions (upper or lower position) can be changed

easily by drag and drop operation.

Caution 1.  Categories cannot be created within categories.

Caution 2.  Up to 1500 categories can be created in one watch panel (if this restriction is violated, a message
appears).

Remark Drag and drop the watch-expressions/categories in other watch panel (Watchl1 to Watch4) to
copy them.

(b) Expand/shrink display
At the top of the watch-expression represents arrays, pointer type variables, structures/unions, and registers
(with the name of the part), "+"/"-" mark is displayed. Click the mark to expand the contents ("+" mark is

changed to "-" after the expansion).
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Watch-Expression

Contents When Expanded

Array

All elements in the array

Select [Encoding] >> [ASCII] from the context menu to display the value as a string
(up to 256 characters). Note, however, that any characters that cannot be dis-
played in the encoding will be shown as periods "." or "?".

Pointer type variable

Variables that the pointer designates

Structure/Union

All the member of structure/union

Register

Name of the bit/bit string that constructs register

Example) AX register
A register
X register

(©

Registering new watch-expression
There are three ways as follows to register new watch-expressions.

Caution Up to 128 watch-expressions can be registered in one watch panel (if this restriction is violated, a

message appears).

<1> Register from other panels
Do either one of the following to register watch-expressions in other panels.

- Drag and drop the target character string onto this area in the desired watch panel (Watchl to Watch4).

- Select [Register to Watch1] from the context menu after selecting the target character string or place the
caret on either of the target character string (the target is automatically determined).

- Select the [Edit] menu >> [Paste] in this area in the desired watch panel (Watchl to Watch4) after selecting
the [Edit] menu >> [Copy] for the target character string.

The relationship between panels that can use this operation and targets that can be registered as watch-
expressions is as follows:

Table A.4 Relationship between Panels and Targets That Can be Registered as Watch-Expressions
Panel Name Targets That can be Registered as Watch-Expressions
Editor panel Variable names of C IanguageNOte 1 cpu registers, SFR, and assembler symbols

Disassemble panel

Variable names of C IanguageNOte 1 cpu registers, SFR, and assembler symbols

CPU Register panel

CPU registersNote 2

Local Variables panel

Variable names of C languageN°® ! (local variables)

SFR panel SFRNote 2
Note 1. It represents C language (C89/C99) variables.
Note 2. The scope-specification is automatically added to the registered watch-expression.

<2> Directly register in the Watch panel

Click the E button on the toolbar or select [Add New Watch] from the context menu in the desired watch
panel (Watchl to Watch4) to display an entry box for a new watch-expression in the bottom of this area.
Directly input a watch-expression from the keyboard in the [Watch] area in the entry box then press the [Enter]
key.

For details on the input formats of watch-expressions, see "(b) Watch-expression and operator”.

Watch-expressions can be registered with specifying the scope. The scope specifications with watch-expres-
sion registration are as follows:

Caution If a load module name or file name contains a space or one of the following symbols, enclose
the name in double-quotes (" ").
$,# ()L &N~ %+ -5 157, \, <, >,

Example: "c:\folder\prog.abs" $file.c#func
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Table A.5 Handling of a C Language Function When Registered in Watch by Specifying Scope
Scope Specification | Load Module File Name | Source File Name | Function Name Variable Name
prog$file#func prog file func Static functions
prog$func prog Global func Global functions
file#func Current file func Static functions
func Current Current func AllNote
Note A search is made for static functions and global functions from the scope of the current PC
value in that order. Static functions out of scope are not searched for.
Also, if functions with the same name exist, write the type of parameter expressly. (Example:
func(int, int))
Table A.6 Handling of a C Language Variable When Registered in Watch by Specifying Scope
Scope Specification | Load Module Source Function Variable Subject to be searched
File Name File Name Name Name
prog$file#func#tvar prog file func var Static variables inside a
static functionNote 1
prog$file#var prog file Global var Static variables inside a file
prog$var prog Global Global var Global variables
file#func#var Current file func var Static variables inside a
static functionNote 1
file#var Current file Global var Static variables inside a file
var Current Current Current var AlNote 2
Note 1. If the current PC value exists in a specified function, the local variables that are not declared as
static also comprise the subject to be searched.
Note 2. A search is made for local variables, static variables inside a file and global variables from the
scope of the current PC value in that order. The local variables and the static variables inside
a file that are out of scope are not searched for.
Table A.7 Handling of a CPU Register When Registered in Watch by Specifying Scope

Scope Specification

Register Bank Name of CPU Register

AX:RBO Register bank 0 AX

AX:REG Current register bank AX
Table A.8 Handling of a SFR when Registered in Watch by Specifying Scope

Scope Specification Name of SFR

PO:SFR PO

PO PO
Remark 1. A symbol name at the current caret position can be complemented by pressing the [Ctrl] +

[Space] key in this area (see "2.19.2 Symbol name completion function™).

Remark 2. Immediates are handled as a numeric value. Also, operators can be used for immediates.
Remark 3. Arithmetic expressions using a symbol can be specified as watch-expressions.
Remark 4. If the same name exists either in C language variables, CPU registers or SFRs, and it is regis-

tered without specifying scopes, then its value will be displayed after the symbol is determined
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in the following order.
Variable of C language > CPU registers > SFR

Remark 5. If a local variable and a global variable exist with the same name, and its symbol name is reg-
istered without specifying scopes, then its value will be displayed after the symbol is deter-
mined based on the scope of the current PC value.

Remark 6. If the letter "I" alone is specified as a watch-expression, it is interpreted as an imaginary key-
word. To acquire the value of a register "I," add ":REG" after the register.

<3> Register from other application
Select a character string of a variable of C language, CPU register, SFR or assembler symbol from a external
editor then do either one of the following.

- Drag and drop the target character string in this area in the desired watch panel (Watchl to Watch4).

- Select the [Edit] menu >> [Paste] in this area in the desired watch panel (Watchl to Watch4) after copying
the target character string.

Remark 1. Each watch-expression registered in each watch panel (Watchl to Watch4) is managed in
each panel and saved as the user information of the project.

Remark 2. More than one watch-expression with the same name can be registered.

Remark 3. You can export registered watch-expressions to a file and import it so that the watch-expres-
sions can be re-registered (see "2.9.6.8 Export/import watch-expressions").

(d) Editing watch-expression
To edit the registered watch-expression, double-click the watch-expression to be edited to change the watch-
expression to edit mode then directly edit from the keyboard (press the [Esc] key to cancel the edit mode).
After editing the watch-expression, press the [Enter] key to complete the editing.

(e) Deleting watch-expression
To delete the registered watch-expression, select the watch-expression(s) to be deleted then click the but-
ton on the toolbar or select [Delete] from the context menu.

()  Setting of various events
Various events can be set to the selected watch-expression by selecting [Access Break] or [Trace Output] from
the context menu.
If an access event is set, the mark of the watch-expression is changed (the event mark of a break event is dis-
played under the icon of the watch-expression in layers).
When an event is set, the detailed information about the set event is reflected in the Events panel.
Note that events are only set to the watch-expressions that are global variables, static variables inside functions,
or file-internal static variables.
See the following for details on how to set events.

- "2.8.5 Stop the program with the access to variables/SFRs"
- "2.11.4 Collect execution history only when the condition is met [IECUBE][Simulator]"

(@) Jump to the address with memory definition
By selecting [Jump to Memory] from the context menu, the Memory panel (Memory1) opens with moving the
caret to the address in which the selected watch-expression is defined (if the Memory panel (Memory1) is
already open, the screen will jump to the panel).
Note that this operation is disabled when more than one watch-expression is selected at the same time or the
CPU register/SFR is selected.

(2) [Value] area
The value of the registered watch-expression is displayed and changed (if the watch-expression is a function
pointer, the function name is displayed in this area).
Notations and encodes can be selected by the button on the toolbar or the context menu item. In addition, a dis-
play format adding the value in hexadecimal number constantly can also be selected as well.
The default display format of the values is automatically decided depending on the type of the watch-expression.

Table A.9 Display Format of Watch-Expressions (Default)

Type of Watch-Expression Display Format
char, signed char, unsigned char ASCII code with hexadecimal number
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Type of Watch-Expression

Display Format

short, signed short, short int, signed short int, int,
signed, signed int, long, signed long, long int, signed
long int

Hexadecimal value added in "())" following signed
decimal value

unsigned short, unsigned short int, unsigned, unsigned
int, unsigned long, unsigned long int

Hexadecimal value added in "()" following unsigned
decimal value

float, float _Complex, float _Imaginary

Float (when the size is 4-byte) with hexadecimal
number Note

double, long double, double _Complex, long double
_Complex, double _Imaginary, long double _Imaginary

Double (when the size is 8-byte) with hexadecimal
number Note

Pointers to char, signed char, unsigned char

Characters
Encoding: ASCII

Pointers to other than char, signed char, unsigned char

Hexadecimal number

Arrays of char, signed char, unsigned char types

Characters
Encoding: ASCII

Bool

Hexadecimal value added in "()" following unsigned
decimal value

Enumeration type

Hexadecimal value added in "())" following enumer-
ated constant

Label, address of immediate value, EQU symbol

Hexadecimal value added in "())" following signed
decimal value

bit symbol Hexadecimal value added in "())" following unsigned
decimal value
Others Hexadecimal number
Note The values of floating and complex types are rounded to an approximate value (nearest whole

value) before being displayed.

The meanings of the marks and colors displayed as the values of watch-expressions are as follows (character col-
ors and background colors depend on the configuration in the [General - Font and Color] category of the Option

dialog box):
Display Example (Default) Description
0x0 | Character color Blue The value of the watch-expression that the user is changing
Press the [Enter] key to write to the target memory.
Background color | Standard color
=0 Character color Pink The value of the watch-expression that is displayed with the
Real-time display update function
Background color | Standard color
0=0 | Character color Brown The value of the watch-expression that has been changed
because of the execution of a program
Background color | Cream To reset the highlighting, select the button on the toolbar or
[Reset Color] from the context menu.
b ] Character color Gray Variable that does not exist is registered as a watch-expression
i or the value of the watch-expression cannot be retrieved (vari-
Background color | Standard color | gpje s out of the scope)
Remark 1. The SFR that cause the microcontroller to operate when it is read is read-protected and therefore

cannot be read. To read the value of read-protected SFR, select [Force Read Value] from the con-

text menu.
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Remark 2. Each watch-expression acquires the value in the order it was registered.
As the timing to acquire a value is different, the values displayed may be different if the same SFR
is registered more than once.

This area is provided with the following functions.

(@) Real-time display update function
Using the real-time display update function allows you to display/modify the value of the watch-expression not
only while the program is stopped, but also in execution.
See "2.9.1.4 Display/modify the memory contents during program execution" for details on the real-time display
update function.

(b) Changing values of watch-expressions
To edit the value of the watch-expression, change the value directly from the keyboard after double-clicking on
the value to be edited (press the [Esc] key to cancel the edit mode).
After you edit the value of the watch-expression, it is written to the target memory of the debug tool by pressing
the [Enter] key, or moving the focus to outside the edit region.
See "2.9.6.6 Modify the contents of watch-expressions” for detail on how to change values of watch-expres-
sions.

(c) Saving the contents of watch-expressions
By selecting the [File] menu >> [Save Watch Data As...], the Save As dialog box can be opened, and all the con-
tents of this panel can be saved in a text file (*.txt) or CSV file (*.csv).
By selecting [Save Expanded Watch Data...] from the context menu, the Save As dialog box can be opened,
and the selected contents of watch-expressions can be saved in a text file (*.txt) or CSV file (*.csv).
See "2.9.6.9 Save the contents of watch-expressions" for details on the method for saving the contents of
watch-expressions.

(3) [Type (Byte Size)] area
The type information of watch-expressions with the following format is displayed.

Watch-Expression Display Format

Single CPU register | <Types of CPU register> (<SizeN°® 1)

Single SFR <SFR type> (<Access attribute> <Access type><SizeNot 1>)
Access attribute R: Read only
W: Write only
R/W: Read/Write only
Access type 1: Bit accessible
8: Byte accessible
16: Word accessible
Unknown ?
Others <Watch-expression type that follow the C compiler's determination™°®€ 2> (<SjzeNote 1)
Note 1. The size of the watch-expression is displayed in bytes.

However, for bit SFR or C language bit field, the size is displayed in bits and "bits" is added to the
end of the number.

Note 2. Watch-expressions are handled as having the type indicated here when they are compiled.
In the case of double/long double type, type name is output in accordance with [Process double
type / long double type as float type] property in the [Output Code] category on the [Compile
Options] tab in the build tool's Property panel.

(4) [Address] area
The address that each watch-expression is mapped is displayed (hexadecimal number notation fixing).
If the watch-expression is single CPU register or is unknown, "-" or "?" is displayed instead.

Remark When the watch-expression is the bit SFR, the bit-offset value is also displayed.

Example When the bit register is allocated to bit 4 of the address "0xFF40"
Display example:0xFF40.4

(5) [Memo] area
The user can write comments for the watch-expressions/categories.
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Each comment for a watch-expression/category written in this area is saved individually as the user information of
the project. Therefore, when any of the watch-expression/category is deleted, the comment corresponding to it is
also deleted.

Note that when arrays or register are displayed expanded, the comment cannot be input for each element.

To edit the comment, input the character strings directly from the keyboard after double-clicking on the item to be
edited (press the [Esc] key to cancel the edit mode).

Up to 256 character strings can be input (line feed code is ignored).

After editing the character strings, complete the editing by pressing the [Enter] key or moving the focus to outside
the edit region.

[Toolbar]

Reacquires all the values of the registered watch-expression and updates the display.
Note that read-protected SFR values are not re-read.

Resets highlighting of the selected watch-expression whose value has been changed by
executing a program.
This item is disabled during execution of a program.

]

Registers a new watch-expression.
Directly input the watch-expression in the text box (see "(c) Registering new watch-
expression”)

Adds a new category (folder).

Directly input the category name in the text box.

Note that up to 64 categories can be created in one watch panel (categories cannot be
created in categories).

Deletes the selected character string(s).
If the watch-expression(s)/category(s) are selected, deletes them (except when the
expanded item of the watch-expression is selected).

[X]

Notation The following buttons to change the notation of a data value are displayed.
M AutoSelect Displays the value of the selected watch-expression in the default notation (see "Table
A.9 Display Format of Watch-Expressions (Default)") according to the type of variable
(default).
. Hexadecimal Displays the value of the selected item in hexadecimal number.

Signed Decimal Displays the value of the selected item in signed decimal number.

Unsigned Decimal | Displays the value of the selected item in unsigned decimal number.

E Octal Displays the value of the selected item in octal number.

Binary Displays the value of the selected item in binary number.

ASCII Displays the value of the selected item in ASCII code.

H Float Displays the value of the selected item in Float.
Note that this item becomes valid only when the selected watch-expression value is 4-
byte data.

. Double Displays the value of the selected item in Double.
Note that this item becomes valid only when the selected watch-expression value is 8-
byte data.

Adds the value in hexadecimal number enclosing with "()" at the end of the value of the

selected item (except the item displayed in hexadecimal number).

[[File] menu (Watch panel-dedicated items)]

The following items are exclusive for the [File] menu in the Watch panel (other items are common to all the panels).
Note that all these items are disabled during execution of a program.
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Save Watch Data

Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file (*.csv)
(see "(c) Saving the contents of watch-expressions").

Note that when the file has never been saved or the file is write disabled, the same opera-
tion is applied as the selection in [Save Watch Data As...].

Save Watch Data As...

Opens the Save As dialog box to newly save the contents of this panel to the specified text
file (*.txt)/CSV file (*.csv) (see "(c) Saving the contents of watch-expressions").

[[Edit] menu (Watch panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Watch panel (all other items are disabled).

Cut Deletes the selected character string(s) and copies them to the clipboard.
If the watch-expression(s)/category(s) are selected, deletes them (except when the
expanded item of the watch-expression is selected).

Copy Copies the contents of the selected range to the clipboard as character string(s).
If the watch-expression(s)/category(s) are selected, copies them to the clipboard (except
when the expanded item of the watch-expression is selected).

Paste If texts are in editing, pastes the contents of the clipboard to the caret position.
If texts are not in editing and the watch-expression(s) are copied in the clipboard, registers
them to the caret position.

Delete Deletes the selected character string(s).
If the watch-expression(s)/category(s) are selected, deletes them (except when the
expanded item of the watch-expression is selected).

Select All If texts are in editing, selects all the character strings.
If texts are not in editing, selects all the watch-expressions/categories.

Rename Renames the selected watch-expression/category.

Find... Opens the Find and Replace dialog box with selecting the [Find in Files] tab.

Replace... Opens the Find and Replace dialog box with selecting the [Replace in Files] tab.

[Context menu]

Access Break

This item becomes valid only when the selected watch-expression is the global variable,
the static variable inside functions, the file-internal static variable, or SFR.

The following cascade menus are displayed to set the access break event (see "2.8.5.1
Set a break event (access type)").

Set Read Break to

Sets a break event with read access condition to the selected watch-expression.

Set Write Break to

Sets a break event with write access condition to the selected watch-expression.

Set R/W Break to

Sets a break event with read/write access condition to the selected watch-expression.

Set Read Combina-
tion Break to
[E1][E20]

Sets a break event with read access condition to the selected Watch-expressionNme.

Set Write Combina-
tion Break to

Sets a break event with write access condition to the selected Watch-expressionNme.

[E1][E20]
Set R/W Combination | Sets a break event with read/write access condition to the selected watch-expressionNOte.
Break to
[E1][E20]
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Trace Output
[IECUBE][Simulator]

This item becomes valid only when the selected watch-expression is a global variable,
static variable inside functions, file-internal static variable, or SFR.

The following cascade menus are displayed to set the trace-related event (see "2.11.4.1
Set a Point Trace event" or "2.11.3.1 Set a Trace event").

Record Reading
Value

Sets a Point Trace event to record the values in the trace memory when the selected
watch-expression is accessed for read.

Record Writing Value

Sets a Point Trace event to record the values in the trace memory when the selected
watch-expression is accessed for write.

Record R/W Value

Sets a Point Trace event to record the values in the trace memory when the selected
watch-expression is accessed for read/write.

Record Start R/'W
Value
[E1][E20][COM Port]

Sets a trace start event to start collecting the trace data when the selected watch-expres-
sion is accessed for read/write.

Record End R/W
Value
[E1][E20][COM Port]

Sets a trace end event to stop collecting the trace data when the selected watch-expres-
sion is accessed for read/write.

Trace

Opens the Trace panel and displays the acquired trace data.

Periodic Updating

The following cascade menus are displayed to set for the real-time display update function
(see "(a) Real-time display update function™).

Periodic Updating
Options

Opens the Property panel to set for the real-time display update function.

Refresh

Reacquires all the values of the registered watch-expression and updates the display.
Note that the values of read-protected SFR are not re-read.

Force Read Value

Forcibly reads once the values of the read-protected SFR.
This item is disabled during execution of a program.

Add New Watch

Registers a new watch-expression. Directly input the watch-expression in the text box (see
"(c) Registering new watch-expression")

Create Category

Adds a new category (folder). Directly input the category name in the text box.
Note that up to 64 categories can be created in one watch panel (categories cannot be
created in categories).

Delete

Deletes the selected character string(s).
If the watch-expression(s)/category(s) are selected, deletes them (except when the
expanded item of the watch-expression is selected).

Cut

Deletes the selected character string(s) and copies them to the clipboard.
If the watch-expression(s)/category(s) are selected, deletes them (except when the
expanded item of the watch-expression is selected).

Copy

Copies the contents of the selected range to the clipboard as character string(s).
If the watch-expression(s)/category(s) are selected, copies them to the clipboard (except
when the expanded item of the watch-expression is selected).

Paste

If texts are in editing, pastes the contents of the clipboard to the caret position.
If texts are not in editing and the watch-expression(s) are copied in the clipboard, registers
them to the caret position.

Rename

Renames the selected watch-expression/category.

Import Watch Expres-
sion...

Opens the Open Watch Expression Data File dialog box to import watch-expressions (see
"2.9.6.8 Export/import watch-expressions").

Notation

The following cascade menus are displayed to specify the notation.
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AutoSelect

Displays the value of the selected watch-expression in the default notation (see "Table A.9
Display Format of Watch-Expressions (Default)") according to the type of variable
(default).

Hexadecimal number

Displays the value of the selected item in hexadecimal number.

Signed Decimal

Displays the value of the selected item in signed decimal number.

Unsigned decimal
number

Displays the value of the selected item in unsigned decimal number.

Octal Displays the value of the selected item in octal number.
Binary Displays the value of the selected item in binary number.
ASCII Displays the value of the selected item in ASCII code.

Include Hexadecimal
Value

Adds the value in hexadecimal number enclosing with "()" at the end of the value of the
selected item (except the item displayed in hexadecimal number).

Float Displays the value of the selected item in Float.
Note that when the selected watch-expression value is not 4-byte data, or has the type
information, displays it in the default notation (see "Table A.9 Display Format of Watch-
Expressions (Default)").

Double Displays the value of the selected item in Double.

Note that when the selected watch-expression value is not 8-byte data, or has the type
information, displays it in the default notation (see "Table A.9 Display Format of Watch-
Expressions (Default)").

Decimal Notation for
Array Index

Displays array indexes on this panel in decimal number (default).

Hexadecimal Nota-
tion for Array Index

Displays array indexes on this panel in hexadecimal number.

Encoding The following cascade menus are displayed to specify the character code.
ASCII Displays the value of the selected item in ASCII code (default).
Shift_JIS Displays the value of the selected item in Shift_JIS code.
EUC-JP Displays the value of the selected item in EUC-JP code.
UTF-8 Displays the value of the selected item in UTF-8 code.
UTF-16 Displays the value of the selected item in UTF-16 code.

Size Notation

The following cascade menus are displayed to specify the size notation.

1 Bytes Displays the value of the selected item as 8-bit data.

2 Bytes Displays the value of the selected item as 16-bit data.
4 Bytes Displays the value of the selected item as 32-bit data.
8 Bytes Displays the value of the selected item as 64-bit data.

Jump to Memory

Opens the Memory panel (Memoryl) and jumps to the address which the selected watch-
expression is defined (see "(g) Jump to the address with memory definition").

Reset Color

Resets highlighting of the selected watch-expression whose value has been changed by
executing a program.
This item is disabled during execution of a program.

Save Expanded Watch
Data...

Opens the Save As dialog box to newly save the selected contents of watch-expressions
to the specified text file (*.txt)/CSV file (*.csv) (see "(c) Saving the contents of watch-
expressions").
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Note [E1][E20]
This item is displayed only when the selected microcontroller supports combination break events.
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Call Stack panel

This panel is used to display the call stack information for the function call (see "2.10.1 Display call stack information").
This panel appears only when connected to the debug tool.

Caution 1.  Nothing is displayed on this panel during execution of a program.
When the program is stopped, items in each area are displayed.

Caution 2.  Except for [Simulator]
If step execution is performed in source level, CS+ determines whether an interrupt is being processed
via the NP, EP, and ID flags in the PSW register. For this reason, if the above register or flags are
changed (e.g. when using multiple interrupts), then call stack information may be incorrect.

Remark This panel can be zoomed in and out by |1 a0x --| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.

Figure A.14 Call Stack Panel
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This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (Call Stack panel-dedicated items)]
- [[Edit] menu (Call Stack panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Call Stack].

[Description of each area]

(1) [Depth] area
The depth of the call is displayed.
The line at the current PC position becomes 0 and incremented numbers from 1 is added to the calling function in
the order.

(2) [Call Stack] area
The current source position and the call stack information pushed on the stack (position of the calling function and
arguments of a each function, etc.) are displayed.

The display format in this area differs depending on the selection condition of the -

- . button on the toolbar,
or of [Show Parameter]/[Show Module File Name] from the context menu.
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Condition Display Format

Display arguments <Function>(<Argument>=<Argument ValugNotes, ...)[<Module file
name>$<File name>#<Line number>] (default)

Display module file name

- Display arguments <Function>(<Argument>=<Argument valueNoes, ...)[<File Name>#<Line
. ) >
- Do not display module file number>]
name
- Do not display arguments <Function>()[<Module file name>$<File name>#<Line number>]

Display module file name

Do not display arguments <Function>()[<File name>#<Line number>]

Do not display module file
name

Note When the argument value is character string, up to 20 characters can be displayed.

Remark Array arguments are passed as pointers rather than arrays (C language specification). For this rea-
son, if the argument is an array, it is displayed as a pointer.

This area is provided with the following functions.

(@) Jump to the source line/disassemble line
By selecting [Jump to Source] from the context menu, the Editor panel is opened with moving the caret to the
source line corresponding to the calling function at the current caret position (if the Editor panel is already open,
the screen will jump to the panel).
In addition, similarly by selecting [Jump to Disassemble], the Disassemble panel (Disasemmblel) is opened
with moving the caret to the address corresponding to the calling function at the current caret position (if the Dis-
assemble panel is already open, the screen will jump to the panel (Disassemblel)).

Remark It is possible to jump to the target source line by double-clicking on that line as well.

(b) Display of local variables
By selecting [Jump to Local Variable at This Time] from the context menu, the Local Variables panel is opened
to display the local variables indicated by the currently selected line.

(c) Saving the contents of call stack information
By selecting the [File] menu >> [Save Call Stack Data As...], the Save As dialog box can be opened, and all the
contents of this panel can be saved in a text file (*.txt) or CSV file (*.csv).
See "2.10.1.4 Save the contents of call stack information" for details on the method for saving the contents of
call stack information.

[Toolbar]
The buttons below are disabled during execution of a program.
El| Acquires the latest data from the debug tool, and updates the contents of this panel.
Notation The following buttons to specify the notation of values are displayed.

M AutoSelect Displays values on this panel in the default notation according to the type of variable (default).

. Hexadecimal | Displays values on this panel in hexadecimal number.

Decimal Displays values on this panel in decimal number.
Octal Displays values on this panel in octal number.
Binary Displays values on this panel in binary number.
Encoding The following buttons to specify the encoding of character variables are displayed.
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ASCII Displays character variables in ASCII code (default).
Shift_JIS Displays character variables in Shift_JIS code.
. EUC-JP Displays character variables in EUC-JP code.
N UTF-8 Displays character variables in UTF-8 code.
UTF-16 Displays character variables in UTF-16 code.
Displays the call stack information with the module file name (default).
Displays the call stack information with the parameters (arguments) of the function call
(default).

[[File] menu (Call Stack panel-dedicated items)]

The following items are exclusive for the [File] menu in the Call Stack panel (other items are common to all the panels).
Note that all these items are disabled during execution of a program.

Save Call Stack Data Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file
(*.csv) (see "(c) Saving the contents of call stack information™).

Note that when the file has never been saved or the file is write disabled, the same
operation is applied as the selection in [Save Call Stack Data As...].

Save Call Stack Data As... | Opens the Save As dialog box to newly save the contents of this panel to the specified
text file (*.txt)/CSV file (*.csv) (see "(c) Saving the contents of call stack information").

[[Edit] menu (Call Stack panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Call Stack panel (all other items are disabled).

Copy Copies the contents of the selected line to the clipboard.

Select All Selects all the items of this panel.

Find... Opens the Find and Replace dialog box with selecting the [Find in Files] tab.
Replace... Opens the Find and Replace dialog box with selecting the [Replace in Files] tab.

[Context menu]

Copy Copies the contents of the selected line to the clipboard.
Show Module File Name Displays the call stack information with the module file name (default).
Show Parameter Displays the call stack information with the parameters (arguments) of the function call
(default).
Notation The following cascade menus to specify the notation of values are displayed.
AutoSelect Displays values on this panel in the default notation according to the type of variable
(default).
Hexadecimal Displays values on this panel in hexadecimal number.
Decimal Displays values on this panel in decimal number.
Octal Displays values on this panel in octal number.
Binary Displays values on this panel in binary number.
Encoding The following cascade menus to specify the encoding of character variables are dis-
played.
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ASCII Displays character variables in ASCII code (default).
Shift_JIS Displays character variables in Shift_JIS code.
EUC-JP Displays character variables in EUC-JP code.
UTF-8 Displays character variables in UTF-8 code.
UTF-16 Displays character variables in UTF-16 code.
Jump to Disassemble Opens the Disassemble panel (Disassemblel) and jumps to the address corresponding

to the calling function of the selected line in this panel.

Jump to Source Opens the Editor panel and jumps to the source line corresponding to the calling func-
tion of the selected line in this panel.

Jump to Local Variable at | Opens the Local Variables panel to display the local variable corresponding to the
This Time selected line.
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Trace panel

This panel is used to display trace data recording the execution history of the program (see "2.11 Collect Execution His-
tory of Programs").

The trace data displays by mixing the disassembled text and source text by default, but it is also possible to display
either one of these by selecting the Display mode.

After the execution of the program is stopped, the display position is automatically updated such that the latest trace
data is displayed.

This panel appears only when connected to the debug tool.

Caution 1.  [E1][E20][EZ Emulator][COM Port]
The trace function is supported only when the selected microcontroller incorporates the OCD trace func-
tion. For details on the OCD trace function, see "Table 2.11 Operation Specifications of OCD Trace
Function®.

Caution 2. [Simulator]
4 bytes of the final address of the code flash area (when a code flash area is 0x0 - Ox1FFFF, Ox1FFFC -
1FFFFF corresponds to it) and the RAM area which can be fetched cannot be fetched (a message of
"Stopped by accessing to no map area." will appear).

Remark 1. When the separator line of each area in this panel is double-clicked, the width of the area changes to the
shortest possible size that can display the contents of the area.

Remark 2. This panel can be zoomed in and out by |1 a0k -| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.

Figure A.15 Trace Panel
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This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (Trace panel-dedicated items)]
- [[Edit] menu (Trace panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Trace].

- On the Editor panel/Disassemble panel, select [Trace Settings] >> [Show Trace Result] from the context menu.
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[Description of each area]

(1) [Number] area
The trace number corresponding to the trace frame is displayed.

(2) [Time (h:min:s,ms,us,ns)] area [IECUBE][Simulator]
This area displays the time required from the execution start of the program to the execution start of an instruction
of each frame or generation of memory access cause.
The time is displayed in units of "hours, minutes, seconds, milliseconds, microseconds and nanoseconds".
If overflow occurs, this area is displayed in invalid color (gray).

Remark 1. [IECUBE]
The precision of the time depends on the setting of the [Rate of frequency division of trace time tag]
property on the [Trace] category on the [Debug Tool Settings] tab of the Property panel.

Remark 2. [Simulator]
The question of whether to set the time display as an integrated value or differential value depends
on the setting of the [Accumulate trace time] property on the [Trace] category on the [Debug Tool
Settings] tab of the Property panel.

(3) [Line/Address] area
The address of the assemble code or the line number of a source file is displayed.
The notation of a data value can be selected by the button on the toolbar or the context menu item.
The display formats are as follows:

Type of Display Line Display Format

Instruction (disassemble results) <Address>

Source text <File name>#<Line number>

Other than above -

Remark Since the following execution histories are not displayed, the line numbers displayed are not con-
secutive numbers.

- CPU register access
- Operand access
- Invalid fetch

(4) [Source/Disassemble] area
The collected trace data is displayed as follows.
The items displayed in this area differ depending on the selection of the display mode (see "(a) Display mode").

Figure A.16 Display Contents of [Source/Disassemble] Area (Default)
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Label The label is displayed when a label is defined for the address.

Offset value The offset value from the nearest label is displayed when a label is defined for
the address.
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Source text The corresponding source text is displayed when the Mixed display mode or
Source display mode is selected.

However, when a place where no debugging information is present is exe-
cuted, "<No Debug Information>" is displayed.

[I[ECUBE][Simulator]

When the value of a variable or an SFR that is accessed during execu-
tion of a source line can be analyzed, that value is displayed in the following
format at the end of the source line.

Note 1

- <<<Variable name = Variable value>>>

- <<<SFR name = SFR value>>>
Example: a=b; <<<a=5>>>
The results of the Point Trace are displayed as same as format above.

Instruction (disassemble The corresponding instructions are displayed as the result of disassembling
results) when the Mixed display mode or Disassemble display mode is selectedN°® 2,
The mnemonics are shown highlighted.

Break cause The reason why the program has broken down is displayed.
[IECUBE][Simulator]

Reset cause The reason why CPU reset has occurred is displayed.
[IECUBE]
Note 1. [I[ECUBE][Simulator]

When there is a memory access, a symbol will be interpreted as a variable and displayed only if a
symbol is assigned to the accessed address. Note, however, that only variables of up to 2 bytes
are supported. If multiplication or other code is processed by the standard libraries, the label of the
SADDR area used by the standard library may be shown.

Note 2. At a frame for which not all the trace data was fetched, "(LOST)" is displayed. In this case, the cor-
responding line is shown in error color (the error color depends on the configuration in the [General
- Font and Color] category of the Option dialog box).

This area is provided with the following functions.

(@) Display mode
It is possible to select the following three display modes by selection of a button on the toolbar or the context

menu.
Display Mode Displayed Content
Mixed display mode Displays the instruction (disassemble results), labels, source text (correspond-
ing source line), point trace results, reset causes [IECUBE], and break causes
(default).

Disassemble display mode | Displays the instruction (disassemble results), labels, point trace results, reset
causes [IECUBE], and break causes.

Source display mode Displays the source text (corresponding source line) reset causes [IECUBE],
and break causes.

However, when a place where no debugging information is present is exe-
cuted, "<No Debug Information>" is displayed.

(b) Jumping to source line or disassemble
By selecting [Jump to Source] from the context menu, the Editor panel opens with moving the caret to the
source line corresponding to the line at the current caret position (if the Editor panel is already open, the screen
will jump to the panel).
In addition, similarly by selecting [Jump to Disassemble], the Disassemble panel (Disasemmblel) is opened
with moving the caret to the address corresponding to the fetch address of the line at the current caret position
(if the Disassemble panel is already open, the screen will jump to the panel (Disassemblel)).

(c) Linking with other panels
By clicking the E / button on the toolbar, or selecting [Window Connecting] >> [Connect Source Window]/
[Connect Disassemble Window] from the context menu, it is possible to link and display the corresponding
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places on the Editor panel/Disassemble panel, with the address of the caret position on this panel used as the

pointer (no movement of the focus is done).

(d) Pop-up display

By hovering the mouse cursor over a line, all the area (item) data corresponding to that line is pop-up displayed

in tandem shape.

(e) Saving trace data

The Data Save dialog box can be opened by selecting the [File] menu >> [Save Trace Data As...], and the con-
tents of this panel can be saved in a text file (*.txt) or CSV file (*.csv).
See "2.11.9 Save the contents of execution history" for details on the method for saving trace data.

(5) [Address] area [IECUBE][Simulator]
The target address of memory access is displayed.

However, in the event of access to SFR, the SFR name is displayed instead of the address (when a plurality is

accessed these are displayed in the following lines).

The radix of a data value can be selected by the button on the toolbar or the context menu item.

(6) [Data] area [IECUBE][Simulator]

The accessed data value and the access type at that time are displayed.

However, CPU register access is not displayed.

The notation of a data value can be selected by the button on the toolbar or the context menu item.
The display format of the data value and the access type are as follows (character colors and background colors
depend on the configuration in the [General - Font and Color] category of the Option dialog box):

Display Example (Default)

Memory Access Type

R Data value Character color Standard color

Background color | Palegreen

Read access

W Data value Character color Standard color

Background color | Orange

Write access

RW Data value Character color Standard color

Background color | Paleturquoise

Read and write access

VECT Data Character color Standard color

Background color | Palegreen

Vector read access

[Toolbar]
E]| Acquires the latest data from the debug tool, and updates the contents of this panel.
This item is disabled while the tracer is running.
Clears the trace memory and the display of this panel (initialized).
This item is disabled while the tracer is running.
Starts the tracer operation.

[IECUBE][Simulator] | The content currently being displayed in this panel is cleared.
This item is disabled while the tracer is running.

Stops the tracer operation.

[IECUBE][Simulator] | The contents of trace data newly acquired are displayed.
This item is disabled while the tracer is sto